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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) or MG3710A/MG3710E 
Vector Signal Generator / MG3740A Analog Signal 
Generator Operation Manual. Please also refer to them 
before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 
the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 
This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 
 
 
MG3700A/MG3710A/MG3710E Vector Signal Generator 
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Operation Manual (IQproducerTM) 
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30 September 2020 (19th Edition) 
  
Copyright © 2004-2020 ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The operational instructions of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for damage or financial loss of 
the customer due to the use of or a failure to use this equipment, unless the 
damage or loss is caused due to Anritsu Corporation’s intentional or gross 
negligence. 
 
 

Anritsu Corporation Contact 
In the event of this equipment malfunctions, please contact an Anritsu 
Service and Sales office. Contact information can be found on the last page 
of the printed version of this manual, and is available in a separate file on the 
PDF version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 

 
 

Trademark and Registered Trademark 
IQproducerTM is a registered trademark of Anritsu Corporation. 
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Software End-User License Agreement (EULA) 
Please carefully read and accept this Software End-User License Agreement (hereafter this EULA) 
before using (includes executing, copying, installing, registering, etc.) this Software (includes programs, 
databases, scenarios, etc., used to operate, set, etc., Anritsu electronic equipment, etc.). By using this 
Software, you shall be deemed to have agreed to be bound by the terms of this EULA, and Anritsu 
Corporation (hereafter Anritsu) hereby grants you the right to use this Software with the Anritsu 
specified equipment (hereafter Equipment) for the purposes set out in this EULA. 
 
Article 1. Grant of License and Limitations 

1. You may not to sell, transfer, rent, lease, 
lend, disclose, sublicense, or otherwise 
distribute this Software to third parties, 
whether or not paid therefor. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer, 
disassemble, decompile, modify or create 
derivative works of this Software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

Article 2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for direct, or 
any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, and damages claimed by 
third parties, arising out of or related to your 
use or inability to use this Software, unless 
the damages are caused due to Anritsu’s 
intentional or gross negligence. 

Article 3. Limitation of Liability 
1. If a fault (bug) is discovered in this Software,  

failing this Software to operate as described 
in the operation manual or specifications 
even though you have used this Software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or replace the 
software, or suggest a workaround, 
free-of-charge, provided, however, that the 
faults caused by the following items and any 

of your lost or damaged data whatsoever 
shall be excluded from repair and the 
warranty. 

i) If this Software is deemed to be used 
for purposes not described in the 
operation manual or specifications. 

ii) If this Software has been used in 
conjunction with other 
non-Anritsu-approved software. 

iii) If this Software or the Equipment has 
been modified, repaired, or otherwise 
altered without Anritsu's prior 
approval. 

iv) For any other reasons out of Anritsu's 
direct control and responsibility, such 
as but not limited to, natural disasters, 
software virus infections, or any 
devices other than this Equipment, etc. 

2. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs or 
replacement by Anritsu engineers 
necessitated by the above faults shall be 
borne by you. 

3. The warranty period for faults listed in 
Section 1 of this Article shall be either 6 
months from the date of purchase of this 
Software or 30 days after the date of repair 
or replacement, whichever is longer. 
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Article 4. Export Restrictions 
 You shall not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by the laws and 
regulations of Japan and the United States, 
etc. In particular, this Software shall not be 
exported or re-exported (a) into any Japan or 
US embargoed countries or (b) to anyone 
restricted by the Japanese export control 
regulations, or the US Treasury 
Department's list of Specially Designated 
Nationals or the US Department of 
Commerce Denied Persons List or Entity 
List. In using this Software, you warrant 
that you are not located in any such 
embargoed countries or on any such lists. 
You also agree that you will not use or 
otherwise export or re-export this Software 
for any purposes prohibited by the Japanese 
and US laws and regulations, including, 
without limitation, the development, design 
and manufacture or production of missiles or 
nuclear, chemical or biological weapons of 
mass destruction, and conventional 
weapons. 

Article 5. Change of Terms 
 Anritsu may change without your approval 

the terms of this EULA if the changes are for 
the benefit of general customers, or are 
reasonable in light of the purpose of this 
EULA and circumstances of the changes. At 
the time of change, Anritsu will inform you 
of those changes and its effective date, as a 
general rule 45 days, in advance on its 
website, or in writing or by e-mail. 

Article 6. Termination 
1. Anritsu may terminate this EULA 

immediately if you violate any conditions 
described herein. This EULA shall also be 
terminated immediately by Anritsu if there 
is any good reason that it is deemed difficult 
to continue this EULA, such as your 
violation of Anritsu copyrights, patents, etc. 
or any laws and ordinances, or if it turns out 

that you belong to an antisocial organization 
or has a socially inappropriate relationship 
with members of such organization. 

2. You and Anritsu may terminate this EULA 
by a written notice to the other party 30 
days in advance. 

Article 7. Damages 
 If Anritsu suffers any damages or loss, 

financial or otherwise, due to your violation 
of the terms of this EULA, Anritsu shall 
have the right to seek proportional damages 
from you. 

Article 8. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with Article 6, you shall cease all 
uses of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

Article 9. Negotiation for Dispute 
Resolution 

 If matters of interpretational dispute or 
items not covered under this EULA arise, 
they shall be resolved by negotiations in 
good faith between you and Anritsu. 

Article 10. Governing Law and Court of 
Jurisdiction 

 This EULA shall be governed by and 
interpreted in accordance with the laws of 
Japan without regard to the principles of the 
conflict of laws thereof, and any disputes 
arising from or in relation to this EULA that 
cannot be resolved by negotiation described 
in Article 9 shall be subject to and be settled 
by the exclusive agreed jurisdiction of the 
Tokyo District Court of Japan. 

 
Revision History: 

February 29th, 2020 
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Protection Against Computer Virus Infections 
Prior to the software installation 
 Before installing this software or any other software recommended or 

approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB flash drive and CF memory card) you 
want to connect to your computer. 

 
When using this software and connecting with the measuring instrument 
● Copying files and data 

On your computer, do not save any copies other than the following: 
- Files and data provided by Anritsu 
- Files created by this software 
- Files specified in this document 
Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB flash drive and CF memory card). 

● Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

● Protection against malware (malicious software such as viruses). 
To connect your computer to network, the following is advised.  
- Activate Firewall. 
- Install important updates of Windows.  
- Use antivirus software. 

 
 

Cautions on Proper Operation of Software 
This software may not operate normally if any of the following operations 
are performed on your computer: 
Simultaneously running any software other than that recommended or 
approved by Anritsu 
Closing the lid (Laptop computer) 
Turning on the screen saver function 
Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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About This Manual 
 Composition of Operation Manuals 

The operation manuals for the MG3700A Vector Signal Generator, the 
MG3710A/MG3710E Vector Signal Generator and the MG3740A Analog 
Signal Generator are comprised as shown in the figure below. 
Details on the mainframe and the standard waveform pattern are 
provided in each operation manual separately.  Read them when needed 
in addition to this manual. 

 

 

MG3700A/MG3710A/MG3710E Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducerTM) 

IQproducerTM Operation Manuals  
for each communication system 

MG3710A/MG3710E Vector Signal Generator  
MG3740A Analog Signal Generator  
Operation Manual (Main frame) 

MG3710A/MG3710E Vector Signal Generator Operation Manual  
(Standard Waveform Pattern) 

Waveform Pattern Operation Manuals 
for each communication system 

 

 Scope of This Manual 

This manual mainly describes installation and operation methods of the 
MG3700A/MG3710A/MG3710E/MG3740A IQproducerTM, which is 
Windows application software for the MG3700A/MG3710A/MG3710E 
Vector Signal Generator and the MG3740A Analog Signal Generator. 
The installation method of this software is described in Chapter 2 
“Installation,” and the basic functions and the outline of operation are 
described in Chapter 4 “Operations for Each Function.” 

MG3710A/MG3710E Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual is hereinafter referred to as 
MG3710A/MG3710E/MG3740A Operation Manual (Mainframe).  
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Name Used in IQproducerTM Operation 
Manuals and Waveform Pattern Operation 
Manuals for Each Communication System 

In IQproducerTM operation manuals and Waveform Pattern operation 
manuals for each communication system, it is assumed that you use 
MG3710A unless otherwise noted. If you use MG3710E, read MG3710A 
as MG3710E. 
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This chapter provides an outline of the IQproducerTM. 
 

1.1 Outline of Product ...................................................... 1-2 
1.2 Outline of Functions ................................................... 1-3 

1.2.1 Signal generation application  
corresponding to communications system .... 1-3 

1.2.2 CCDF graph display function ........................ 1-3 
1.2.3 FFT graph display function ............................ 1-3 
1.2.4 File conversion function ................................. 1-3 
1.2.5 Transfer & Setting function ............................ 1-4 
1.2.6 Combination file edit function ........................ 1-4 
1.2.7 AWGN waveform pattern generation  

function .......................................................... 1-4 
1.2.8 Time domain graph display function .............. 1-4 
1.2.9 Clipping function ............................................ 1-4 
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1.1 Outline of Product 
The IQproducerTM (hereafter referred to as “IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A”) is Windows application 
software used to generate a modulated waveform pattern to be used in 
the Vector Signal Generator MG3700A/MG3710A/MG3710E or the 
Analog Signal Generator MG3740A, which integrates an arbitrary 
waveform generator. The IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A also transfers the generated 
data to the MG3700A/MG3710A/MG3710E/MG3740A via LAN. 

Note that it is required to purchase a license key corresponding to the 
serial number of your MG3700A/MG3710A/MG3710E/MG3740A when 
actually using a waveform file generated by the modulated waveform 
pattern generator IQproducerTM (hereafter, referred to as “signal 
generation application”) corresponding to each communications system 
with the MG3700A/MG3710A/MG3710E/MG3740A. 

The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A also 
enables to display the Complimentary Cumulative Distribution Function 
(CCDF) results and Fast Fourier Transform (FFT) results of a generated 
modulated waveform pattern in graph. In addition, it can convert an 
ASCII-format waveform pattern generated by your signal generation 
application tool to a binary-format waveform pattern that can be used in 
the MG3700A/MG3710A/MG3710E/MG3740A. 

This operation manual describes the functions of the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A, except for the signal 
generation application. 

Anritsu
MG3700A

LAN

 

Figure 1.1-1  System configuration diagram 
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1.2 Outline of Functions 
1.2.1 Signal generation application corresponding to communications 

system 
Signal generation applications that generate modulation waveform 
patterns are provided for each communications system. For detailed 
information on the operations and functions of these applications, refer to 
the operation manual of each signal generation application. 

1.2.2 CCDF graph display function 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A can read 
a modulation waveform pattern generated by each signal generation 
application and display it in the CCDF graph with up to eight traces. 

The CCDF graph displayed on the screen can be printed out and saved 
into a CSV-format file. 

1.2.3 FFT graph display function 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A can read 
a modulation waveform pattern generated by each signal generation 
application and display it in the FFT graph with up to four traces. 

The FFT graph displayed on the screen can be printed out and saved into 
a CSV-format file. 

1.2.4 File conversion function 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A can 
convert an ASCII-format waveform pattern generated by simulation 
software or other external software to a binary-format modulation 
waveform pattern file that can be used in the 
MG3700A/MG3710A/MG3710E/MG3740A. 
It can convert a digitized file that is created by the MS2690A 
/MS2691A/MS2692A, MS2830A or MS2840A Signal Analyzer using the 
digitize function, and convert a waveform pattern for the MS269x, 
MS2830A or MS2840A into a binary-format modulation waveform 
pattern that can be used in the 
MG3700A/MG3710A/MG3710E/MG3740A. Conversely, a waveform 
pattern for the MG3700A/MG3710A/MG3710E/MG3740A can also be 
converted into a file that can be used in the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A Signal Analyzer. 
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1.2.5 Transfer & Setting function 
This is an application used to transfer waveform pattern files, screen 
copy images, log files, updating programs, etc., to the 
MG3700A/MG3710A/MG3710E/MG3740A via Ethernet. 

The FTP function used to transfer files to the 
MG3700A/MG3710A/MG3710E/MG3740A and the 
MG3700A/MG3710A/MG3710E/MG3740A authentication function are 
included. It is also possible to load a waveform pattern saved in the 
MG3700A/MG3710A/MG3710E/MG3740A’s hard disk to its waveform 
memory. 

In addition, the usage condition of the 
MG3700A/MG3710A/MG3710E/MG3740A’s waveform memory can be 
checked and defragmentation can be executed if necessary with this 
function. 

1.2.6 Combination file edit function 
This is a file creation function to define combinations of multiple 
waveform patterns to be allocated in the arbitrary waveform memory on 
the MG3700A/MG3710A/MG3710E/MG3740A.  

This function enables definition of additional combinations of two 
waveform patterns as well as time-series switching among multiple 
waveform patterns while keeping signal synchronization.  

1.2.7 AWGN waveform pattern generation function 
This function enables generation of AWGN waveform patterns with any 
bandwidth.  
By setting the sampling rate or bandwidth, this function generates 
AWGN waveform patterns that can be used in combination with existing 
waveform patterns. 

1.2.8 Time domain graph display function 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A can read 
a modulation waveform pattern generated by each signal generation 
application and display it in the time domain graph, with up to four 
traces. 

1.2.9 Clipping function 
This function performs clipping processing for a waveform pattern 
generated by each signal generation application. 
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This chapter describes how to install/uninstall the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A in a PC. 
 

2.1 Operating Environment .............................................. 2-2 
2.2 Installation and Uninstallation Procedure .................. 2-3 

2.2.1 Installation procedure .................................... 2-5 
2.2.2 Upgrade procedure ........................................ 2-7 
2.2.3 Uninstallation procedure ................................ 2-8 
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2.1 Operating Environment 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A requires 
the following environment. 

Table 2.1-1  Operating environment 

PC 
OS IQproducerTM Version 16.01 or earlier 

Windows XP /Windows Vista/Windows7 
IQproducerTM Version 17.00 or later 
Windows7/Windows10 

CPU PentiumIII 1 GHz equivalent or faster 
Memory 512 MB or more 
Hard disk free space 5 GB or more free space on the drive where 

the IQproducerTM is to be installed.  
Peripheral device 

Display Displays with a resolution of 1024 × 768 
pixels are best viewed using a small font 
setting. 
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2.2 Installation and Uninstallation Procedure 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A can be 
installed interactively by activating the setup program. 

If resident virus check programs are running on your PC, exit them 
before activating the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A setup program, as well as 
other Windows applications in progress. 

Note: 
IF you upgrade the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A after the version 3.00 
(hereafter referred to as “new software”) in PC in which the 
IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A before 
version 2.01 (hereafter referred to as “old software”) is installed, 
please execute the setup file of the old software and uninstall it 
before executing the setup file of new software. However, if the 
short file name support was disabled on your Windows, old 
software cannot be uninstalled. In this case, instead of uninstalling 
the old software, execute the setup file of the new software and 
specify the installation folder of the old software for the 
Destination Folder, thereby installing the new software, while 
overwriting the old one. 

 
Note: 

Versions 12.00 and later of this software are installed in a different 
default destination folder than earlier versions. To install this 
software in the same folder as versions prior to 12.00, set the 
correct installation destination folder and then run the installer.  

However, operation of this software is not assured if it is installed 
in the path C:\Program Files when using Windows Vista or 
Windows 7. When using Windows Vista or Windows 7, we 
recommend keeping Destination Folder as the default install 
destination. 

 
Note: 

This software of version 13.00 or later requires you to have 
installed Microsoft Visual C++ 2010 Redistributable Package (x86). 
In addition, this software of version 13.00 or later does not work on 
Windows2000. 
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Note: 
When you run the setup program for IQproducerTM version 14.02 
or later (hereafter referred to as “new software”) on the PC to 
which IQproducerTM version 14.01 or earlier (hereafter referred to 
as “old software”) has been installed, the automatic uninstallation 
of the old software starts.  
When the old software has been successfully uninstalled, the 
installation of the new software starts. 

 
Note: 

To downgrade from IQproducerTM version 14.02 or later (hereafter 
referred to as “new software”) to IQproducerTM version 14.01 or 
earlier (hereafter referred to as “old software”), uninstall the new 
software before installing the old software. 
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2.2.1 Installation procedure 
Install the IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A 
into your PC’s hard disk with the following procedure. 

Installation Procedure: 
1) Double-click the SETUP.EXE file in the folder where the files of the 

IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A are 
stored. 
When installing the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A using the setup disk, 
double-click the SETUP.EXE file in the \IQproducer directory of the 
setup disk. 

2) If Microsoft Visual C++ 2010 Redistributable Package (x86) is not 
installed to your PC, start the installation of the package. 

Figure 2.2.1-1  Installation of the Microsoft Visual C++2010 
Redistributable Package 

 

3) When Microsoft Visual C++ 2010 Redistributable Package (x86) 
version 10.0.30319 or later has been already installed, the following 
confirmation message may appear. If you see the confirmation 
message, continue the installation. 

 

Figure 2.2.1-2  Confirmation Message That Appears When the New Version of 
Microsoft Visual C++2010 Redistributable Package Is Installed 
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 To check the version information of Microsoft Visual C++ 2010 
Redistributable Package (x86), click Control Panel, and then click 
Uninstall a program. 

4) The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A 
setup program starts. When “Welcome to the InstallShield Wizard 
for IQproducer” is displayed on the screen, click the Next> button. 

5) The License Agreement screen is displayed. Read the license 
agreement terms, and click the Yes button if you agree with the 
contents. 
Note that the installation procedure will not continue unless you 
agree with the license agreement terms. 

6) The directory path in which the software will be installed is 
displayed in the Destination Folder field. 
When changing the installation folder, click the Browse… button to 
open the directory change dialog box, and specify the desired folder. 
In this event, be sure to confirm that there is enough free space in 
the drive where the target folder belongs to. For free space, refer to 
Section 2.1 “Operating Environment.” 
The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A 
generates temporary data under the installation folder. 

7) After specifying the installation folder, click the Next> button to 
display the folder for storing the program icon in the program folder 
selection window. It is also possible to change from this window the 
folder for storing the program icon. Click the Next> button to start 
installation. 

8) When “InstallShield Wizard Complete” is displayed, click the Finish 
button. 
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2.2.2 Upgrade procedure 
Follow the procedure below to upgrade the IQproducerTM. 

The upgrade process is run by double-clicking the SETUP.EXE file for 
the later version than the version currently installed on your PC. 

<Procedure> 
1. Double-click the SETUP.EXE file in the folder where the 

IQproducerTM is stored. To install using the setup disk for the 
IQproducerTM, double-click the SETUP.EXE file stored in the 
\IQproducer folder on the setup disk. 

2. The installation of Microsoft Visual C++ 2010 Redistributable 
Package (x86) begins in the same way as described in step 2 of 2.2.1 
“Installation procedure”. Follow step 2 of 2.2.1 “Installation 
procedure”. 

3. Follow step 3 of 2.2.1 “Installation procedure”. 

4. When you see the following message after the IQproducerTM setup 
program starts, click the Yes button: 
“The setup will perform an upgrade of ‘IQproducer’. Do you want to 
continue?” 

5. When you see the following message, click the Next button to start 
upgrade: 
“Resuming the InstallShield Wizard for IQproducer” 

6. When you see the following message, click the Finish button: 
“Update Complete” 

Note: 
If you double-click the SETUP.EXE file for the older version than 
the version currently installed on your PC, the setup process is 
cancelled and you will see the following message: 
“A later version of ‘IQproducer’ is already installed on this machine. 
The setup cannot continue.” 
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2.2.3 Uninstallation procedure 
Uninstall the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A from your PC’s hard disk with 
the following procedure. 

Uninstallation Procedure: 
1. Click the Start button on the Windows task bar, point Setting, and 

click Control Panel. 

2. Double-click the Add or Remove Programs icon. 

3. On the Change or Remove Programs tab, click the IQproducer item 
in the Currently Installed Programs list to display it highlighted. 

4. Click the Change/Remove button. 

5. When the uninstall program starts, read the message, and click the 
OK button. 

6. A confirmation message may be displayed during uninstallation, 
asking whether to remove a shared file. Select NO unless it is not 
certain whether the indicated file is shared by any other programs. 
Some programs may not function correctly if a necessary shared file 
is removed inadvertently. 

7. When “Uninstallation Complete” is displayed, click the Finish 
button. 

Note: 
If a shared file is removed, there is a possibility that other 
application programs may not function. Do not remove the shared 
file unless it is not certain whether the indicated file is shared or 
not. 
Even if a shared file is removed inadvertently, it may be restored 
by installing the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A again. 
If the short file name support was disabled on your Windows, 
IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A before 
version 1.02 cannot be uninstalled. 
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This chapter describes the operations specifically important for operating 
the IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A on 
Windows. 
 

3.1 Operations for Menu ..................................................... 3-2 
3.1.1 Operations using mouse................................... 3-2 
3.1.2 Operations using keyboard .............................. 3-2 
3.1.3 Operations using up and down cursor keys ..... 3-3 

3.2 Operations for Dialog Box ............................................. 3-4 
3.2.1 File Open/Save as… ........................................ 3-4 
3.2.2 Entering numeric value and character string .... 3-6 

3.3 Using Touch Panel ....................................................... 3-7 
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3.1 Operations for Menu 
3.1.1 Operations using mouse 

Description for mouse operation 
•Point: To move a mouse and place the mouse pointer 

onto the operation target object. 
•Click: To press a mouse button and release it 

immediately. The button indicates a left button 
unless otherwise specified. 

•Double click: To click a mouse button twice quickly. The 
button indicates a left button unless otherwise 
specified. 

•Drag: To press a mouse button and then move the 
mouse while holding down the button. The 
button indicates a left button unless otherwise 
specified. 

 

 

Figure 3.1.1-1  Screen explanation 
 

1. Click a menu on the menu bar (File, Edit, etc.) to display the 
pull-down menu. 

2. Select an item to be executed from the displayed pull-down menu, 
and click it. 
 

3.1.2 Operations using keyboard 
1. Press Alt . 

2. Select a menu on the menu bar using the right and left cursor keys 
(←/→), and press Enter  or the down cursor key (↓) to display the 
pull-down menu. 
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3.1.3 Operations using up and down cursor keys 
1. Select an item to be executed using the up and down cursor keys 

(↑/↓) and press Enter . 
An item can also be selected by pressing the underscored character 
in that item on the menu bar and pull-down menus. Such a key is 
referred to as “accelerator key.” For example, the accelerator key for 
the Recall Parameter file item is R , and for Exit, E . When 
selecting an item on the menu bar, however, it is necessary to 
activate the menu bar (an item is highlighted when the menu bar is 
activated) by pressing Alt . 
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3.2 Operations for Dialog Box 
3.2.1 File Open/Save as… 

 

Figure 3.2.1-1  Dialog box 
 

<Procedure> 
1. Select a drive or folder from the Look in box (for opening a file) or 

the Save in box (for saving a file). 
For the mouse operation, click the Look in or Save in box to open the 
list of drives and folders. Select the target drive or folder from the 
list and click it to switch the display (the contents of the selected 
drive/folder are displayed). 
For the keyboard operation, press Tab  several times to highlight 
the Look in or Save in box, then press the up or down cursor key 
(↑/↓) to open the pull-down list of drives and folders. Use the cursor 
keys (↑/↓/←/→) to select the target drive or folder from the list and 
then press Enter . 

2. Select a file type from the Files of type text box. 
For the mouse operation, click the Files of type text box to open the 
list of file types. Select the target file type from the list and click it. 
For the keyboard operation, press Tab  several times to highlight 
the Files of type text box, then press the up or down cursor key (↑/↓) 
to open the pull-down list of file types. Use the cursor keys 
(↑/↓/←/→) to select the target file type from the list and then press 
Enter . 
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3. Enter into the File name box the name of a file to be opened or 
saved. 

4. When opening a file by the mouse operation, click the file to be 
opened from the displayed files. The name of the selected file is 
displayed in the File name text box. Click the Open button to open 
the selected file.  
The contents of a folder can also be displayed in a similar manner. 
Click a folder and then click the Open button to open the contents of 
the selected folder. 
When opening a file or folder by the keyboard operation, press 

Tab  several times to move the cursor to the folder/file display 
field (highlighted when selected), and use the cursor keys (↑/↓/←/→) 
to select the file or folder to be opened. Then press Enter  to open 
the selected file/folder. 

5. When saving a file with a specified name, highlight the File name 
text box by clicking it (mouse operation) or pressing Tab  several 
times (keyboard operation). 
Next, type the desired file name in the text box. 
Then click the Save button (mouse operation) or press Enter  
(keyboard operation) to save the file with the specified name. 

6. The “Open” and “Save As” operations can be cancelled halfway. For 
the mouse operation, click the Cancel button. For the keyboard 
operation, press Tab  several times to move the cursor to the 
Cancel button and press Enter . 
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3.2.2 Entering numeric value and character string 
1. When entering a numeric value, click the desired numeric value 

entry text box using the mouse or move the cursor to the desired 
numeric value entry text box by pressing Tab  several times. 
Enter a numeric value from the keyboard or numeric keypad. Then 
click the OK button using the mouse or press Enter  to input 
(finalize) the entered value. 

2. When entering a character string, click the desired character string 
entry text box using the mouse or move the cursor to the desired 
character string entry text box by pressing Tab  several times. 
Enter a character string from the keyboard. Then click the OK 
button using the mouse or press Enter  to input (finalize) the 
entered character string. 

3. The numeric value/character string entry operation can be cancelled 
halfway. For the mouse operation, click the Cancel button. For the 
keyboard operation, move the cursor to the Cancel button by 
pressing Tab  several times and press Enter . 
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3.3 Using Touch Panel 
Touch panel function comes exclusively for 
MG3710A/MG3710E/MG3740A.  

Touch panel screen provides the same operation as a click of a mouse.  

Button 
Same operation as a click of a mouse 

Numeric input 
If numeric input box is touched while running on 
MG3710A/MG3710E/MG3740A, a numeric keypad will display.  
Note that there is a numeric input text box without numeric keypad.  

 

Figure 3.3-1  Numeric Input Using Touch Panel 
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Character input 
If text input box is touched while running on 
MG3710A/MG3710E/MG3740A, a screen keyboard will display.  

Note that there is a text input box without screen keyboard.  

Once  and  is touched, it is locked and grayed out as: 
 . Touching again will release the lock.  
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This chapter describes the items that the users should understand when 
actually operating the IQproducerTM, including the names of parts in 
each screen, operations in the CCDF/FFT/time domain graph screens, file 
conversion settings in the Convert screen, and functions in the Transfer 
& Setting (data transfer) screens. 
 

4.1 Starting/Exiting IQproducerTM ....................................... 4-5 
4.1.1 Starting Software: When installed on PC ......... 4-5 
4.1.2 Starting Software: When installed on 

MS2690A/MS2691A/MS2692A,  
MS2830A or MS2840A ..................................... 4-7 

4.1.3 Starting Software: When installed on 
MG3710A/MG3710E/MG3740A ....................... 4-8 

4.1.4 Exiting Software ................................................ 4-9 
4.2 Common Platform Screen .......................................... 4-10 
4.3 CCDF Graph Display .................................................. 4-14 

4.3.1 Activation ........................................................ 4-14 
4.3.2 CCDF graph display screen ........................... 4-14 
4.3.3 CCDF graph display ....................................... 4-16 
4.3.4 Deleting CCDF graph ..................................... 4-19 
4.3.5 Displaying Gaussian trace .............................. 4-20 
4.3.6 Interaction with signal generation application  

(Quick Add Mode) ........................................... 4-20 
4.3.7 Mouse interaction selection in the CCDF  

graph display area (Mouse Interaction) .......... 4-22 
4.3.8 Moving graph cursor ....................................... 4-23 
4.3.9 Changing graph scale..................................... 4-25 
4.3.10 Printing/saving graph data .............................. 4-27 

4.4 FFT Graph Display ..................................................... 4-28 
4.4.1 Activation ........................................................ 4-28 
4.4.2 FFT graph display screen ............................... 4-28 
4.4.3 FFT graph display ........................................... 4-30 
4.4.4 Deleting FFT graph ......................................... 4-33 
4.4.5 Changing graph display area and  

axis plot interval .............................................. 4-34 
4.4.6 Interaction with signal generation application  

(Quick Add Mode) ........................................... 4-35 
4.4.7 Mouse interaction selection in the CCDF  

graph display area (Mouse Interaction) .......... 4-36 
4.4.8 Moving graph cursor ....................................... 4-37 
4.4.9 Changing graph scale..................................... 4-38 
4.4.10 Printing/saving graph data .............................. 4-40 
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4.5 File Conversion on Convert Screen ............................ 4-41 
4.5.1 Activation ........................................................ 4-44 
4.5.2 Convert screen ............................................... 4-44 
4.5.3 Input file selection ........................................... 4-47 
4.5.4 Editing data in Convert screen ....................... 4-50 
4.5.5 Executing conversion ..................................... 4-60 
4.5.6 Input file format ............................................... 4-63 
4.5.7 Setting the RMS-value calculation range ....... 4-70 

4.6 File Transfer and Loading to Memory in  
Transfer & Setting Panel Screen ................................ 4-71 
4.6.1 Activation ........................................................ 4-71 
4.6.2 Transfer & Setting Panel screen .................... 4-75 
4.6.3 Operation from menu and tool bar ................. 4-77 
4.6.4 Selecting folder ............................................... 4-84 
4.6.5 Selecting transfer file type .............................. 4-85 
4.6.6 SG-side file display area................................. 4-86 
4.6.7 Selection in SG-side file display area ............. 4-91 
4.6.8 PC-side file display area ................................. 4-92 
4.6.9 Selection in PC-side file display area ............. 4-95 
4.6.10 Status display ................................................. 4-95 
4.6.11 Disconnection screen ..................................... 4-96 
4.6.12 Rename screen (for changing file name) ....... 4-97 
4.6.13 Create new folder screen  
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4.7 File Transfer and Loading to  

Memory Using Transfer & Setting Wizard .................. 4-99 
4.7.1 Activation ........................................................ 4-99 
4.7.2 Transfer & Setting Wizard (Step 1/2)  

(Connection screen) ....................................... 4-99 
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4.8 Combining Waveform Patterns by  
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4.1 Starting/Exiting IQproducerTM 
4.1.1 Starting Software: When installed on PC 

Start the IQproducerTM by following the procedures below.  

<Procedure> 

1. Click the Start button on the Windows task bar, and select Programs. 
Then select Anritsu Corporation from the displayed program group 
and click IQproducer.  

 

Figure 4.1.1-1  Program Selection Screen 
 

2. When the IQproducerTM is started, the Select instrument window is 
displayed.  

From the Select instrument options, select the main unit model that 
will use the waveform patterns created by IQproducerTM.  
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Notes: 
• MG3740A requires the digital modulation option (020/120) to 

start IQproducer™. 

• If you don’t want to see the Select instrument window again, 
select the Don’t show this window next time check box, and 
IQproducerTM will start for the selected model from the next 
startup without displaying the Select instrument window. 

3. The common platform screen is displayed after starting up the 
IQproducer™.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 4.1.1-2  Common Platform Screen 
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4.1.2 Starting Software: When installed on 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 

Start the IQproducerTM by following the procedures below.  

<Procedure> 

1. Click Start, and point to All Programs. Point to Anritsu Corporation 
from the program group and click IQproducer.  

 

Figure 4.1.2-1  Program Selection Screen 
 

2. The further procedure is as same as that of 4.1.1 “Starting Software: 
When installed on PC”.  
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4.1.3 Starting Software: When installed on 
MG3710A/MG3710E/MG3740A 

Start the IQproducerTM by following the procedures below.  

<Procedure> 
1. Press  on the MG3710A/MG3710E/MG3740A front panel. 
Note: 

IQproducer™ starts only when the digital modulation option 
(020/120) is installed to MG3740A. 

2. The common platform screen is displayed after starting up the 
IQproducer™.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 4.1.3-1  Common Platform Screen 
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4.1.4 Exiting Software 
To exit IQproducer™ that are running, select Exit on the Common 
Platform Screen. In this case, a dialog is displayed to confirm stopping of 
each running tool.  

 

Figure 4.1.4-1  Exiting IQproducer™ 
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4.2 Common Platform Screen 
The common platform screen shown in Figure 4.2-1 below is displayed 
first after starting up the IQproducerTM.  

The common platform screen is a screen used to select each function of 
the IQproducerTM. Only the menu bar for selecting a function is displayed 
in this screen.  

 

Figure 4.2.1 Common Platform Screen 
 

■Description of items 
(1) System (Cellular) tab 

Cellular system applications are displayed on the tabbed page. For 
detailed information about the signal generation applications, refer 
to the operation manual for each application.  

The System(Cellular) tab does not appear when MG3740A is clicked 
in the Select Instrument window or the IQproducer™ is started on 
MG3740A. 

 
(2) System (Non-Cellular) tab 
 Non-cellular system applications are displayed on the tabbed page. 

For detailed information about the signal generation applications, 
refer to the operation manual for each application.  

The System(Non-Cellular) tab does not appear when MG3740A is 
clicked in the Select Instrument window or the IQproducer™ is 
started on MG3740A. 
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(3) General Purpose tab 
 General purpose applications are displayed on the tabbed page. For 

detailed information about the signal generation applications, refer 
to the operation manual for each application.  

 

Figure 4.2-2  General Purpose Tab 
 

1 TDMA 

TDMA applications are displayed.  
Waveform patterns corresponding to TDMA system 
specifications are created in this application.  

2 Multi-Carrier 

Multi-Carrier applications are displayed.  
Modulated waveform patterns corresponding to Multi-Carrier 
system specifications are created in this application.  

This is not displayed when MG3740A is clicked in the Select 
Instrument window or the IQproducer™ is started on 
MG3740A. 

3 Fading 

Fading applications are displayed.  
The fading operation is applied onto input waveforms to output 
the results.  

4 Convert 

The Convert screen is displayed.  
In the Convert screen, ASCII-format waveform patterns 
generated by simulation software, digitized files created by the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A using the 
digitize function, and waveform patterns formatted for the 
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MS269x, MS2830A or MS2840A can be converted into a file so 
as to be used in the mainframe. Conversely, a waveform pattern 
for the MG3700A/MG3710A/MG3710E/MG3740A can also be 
converted into a file that can be used in the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A.  

5 AWGN 

The AWGN generation screen is displayed.  
AWGN can be generated by setting the bandwidth and other 
parameters on the AWGN generation screen.  

This is not displayed when MG3740A is clicked in the Select 
Instrument window or the IQproducer™ is started on 
MG3740A. 

6 Clipping 

The Clipping setting screen is displayed.  
Clipping processing can be performed in the Clipping setting 
screen, for a waveform pattern generated by each signal 
generation application.  

 
 (4) Simulation & Utility tab 

Application menus of simulations and utilities are displayed on this 
tabbed page.  

 

Figure 4.2-3  Simulation & Utility Tab 
 

1 CCDF 

The CCDF Graph Monitor screen is displayed.  
The CCDF of a generated waveform pattern is displayed in a 
graph.  
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2 FFT 

The FFT Graph Monitor screen is displayed.  
The spectrum where FFT processing is performed for a 
generated waveform pattern is displayed in a graph.  

3 Time Domain 

The time domain graph display screen is displayed.  
The time domain waveform of a created waveform pattern can 
be displayed in a graph.  

4 Transfer & Setting Panel 

The Transfer & Setting Panel screen is displayed.  
File transfer between the mainframe and the PC connected via 
Ethernet can be performed in this screen. This screen is used 
when installing key files or transferring waveform patterns.  

5 Transfer & Setting Wizard 

The Transfer & Setting Wizard screen is displayed.  
Connection between a PC and the mainframe, transfer of 
waveform patterns to the mainframe, and loading of waveform 
patterns to an arbitrary waveform memory of the mainframe 
can be performed on this screen.  

(5) Change Instrument button 

Provided to display the Select instrument window at the next 
startup. A message is displayed indicating that the IQproducerTM 
must be restarted to change the target model.  

(6) HELP button 

The version information of the IQproducerTM is displayed.  

(7) Exit button 

Exits from this software. This menu also closes all the other screens 
for IQproducerTM functions if displayed.  
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4.3 CCDF Graph Display 
The Complementary Cumulative Distribution Function (CCDF) of a 
waveform pattern generated by a signal generation application can be 
displayed.  

In a CCDF graph, the signal peak power / average power is displayed on 
the X axis, and on the Y axis, the cumulative probability that the peak 
power / average power of the signal is equal to or less than the value on 
the X axis is displayed. Distribution of peak powers of various 
modulation signals can be displayed in a screen. This screen is useful, for 
example, for estimating the output waveform distortion characteristics 
when a generated signal is input from the 
MG3700A/MG3710A/MG3710E/MG3740A to a power amplifier or other 
devices.  
 

4.3.1 Activation 
Select CCDF from the Simulation & Utility tab on the common platform 
screen.  
The CCDF graph display screen is displayed separately.  

 

4.3.2 CCDF graph display screen 
 

 

Figure 4.3.2-1  CCDF Graph Display Screen 
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■Description of items 
(1) Menu bar 

Trace addition, graph print out, screen copy, graph data saving into 
a CSV format file, and CCDF graph display close can be executed.  

(2) Legend 

File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed.  

(3) CCDF graph display area 

The graphic display area for CCDF Graph cursor move and graph 
zoom-in display can be executed.  

(4) Crest Factor 

The ratio between the peak value and RMS value of the selected 
trace is displayed.  

(5) Add/Delete (trace addition/deletion) 

A trace can be added/deleted. 

(6) Sampling Points 

The number of samples calculated by reading the selected trace is 
displayed. Different sampling points can be set by changing the 
value in this text box.  

(7) Sampling information display 

The sampling range for the selected trace is displayed. A different 
sampling range can be set by changing the value in this text box.  

(8) Cursor Position 

The current graph cursor position is displayed. The graph cursor 
position in the CCDF graph display area can be specified by entering 
a value in either PAR or Probability text box.  

(9) Quick Add Mode (interaction with signal generation application) 

Settings for addition of a waveform pattern generated by a signal 
generation application to the CCDF graph display in conjunction 
with the signal generation application can be configured.  

(10) Scale setting 

The scale of the X and Y axes in the CCDF graph display area can be 
changed.  

(11) Mouse Interaction 

The mouse operation in the CCDF graph display area can be set to 
either the graph cursor move function or the zoom-in function.  
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4.3.3 CCDF graph display 
A waveform pattern generated by a signal generation application of the 
IQproducerTM can be read and displayed in a CCDF graph.  

■CCDF graph display procedure 
<Procedure> 
1. Click one of the option buttons in the Legend dialog box to select the 

trace color of the wave form pattern in the CCDF graphical area.  

 

Figure 4.3.3-1  Legend Dialog Box 
 

2. Click the Add button to display the Add Trace dialog box.  

The Add button is disabled when any waveform pattern is already 
specified on the selected option button. In such case, delete the 
waveform pattern by clicking the Delete button, or select one of 
other option button.  

 

Figure 4.3.3-2  Add Button 
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Otherwise, select Add Trace from the File menu.  

 

Figure 4.3.3-3  Add Trace Button on the File Menu 
 

3. Click the  button in the Add Trace screen, and select a 
waveform pattern for which a CCDF graph is displayed. Enter the 
Sampling Points and Sampling Range for the waveform to be shown 
on the CCDF graphic area. If the target area includes the RF Gate 
OFF area (RF output is set to off) at this time, the RF Gate OFF 
interval can be excluded from the CCDF graph display target by 
selecting the Exclude RF Output Off Sample check box.  

 

Figure 4.3.3-4  Add Trace Dialog Box 
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4. Click the OK button on the Add Trace screen to read the waveform 
pattern.  
A graph calculation progress screen as shown below is displayed 
while reading the waveform pattern.  

 

Figure 4.3.3-5  Graph Calculation Progress Screen 
 

 If the Cancel button is clicked during the graph calculation, the 
calculation is interrupted and waveform pattern reading is stopped. 
After the completion of the reading and calculations of the 
waveforms, the Graph calculation progress screen will be closed to 
display the CCDF graphic window. The trace in the selected color in 
the Legend dialog box will be indicated on the CCDF graphic 
window.  
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4.3.4 Deleting CCDF graph 
The CCDF graph displayed in the screen can be deleted.  

■CCDF graph display deleting procedure 
<Procedure> 
1. Click the option button in the Legend dialog box to select the trace to 

be deleted.  

 

Exclusively 
selectable 

 

Figure 4.3.4-1  Legend Dialog Box 
 

2. Click the Delete button.  

 

Figure 4.3.4-2  Delete Button 
 

 Otherwise, select Delete Trace from the File menu.  

 

Figure 4.3.4-3  Delete Trace Button on the File Menu 
 

The trace selected in Legend is deleted. After deleting a trace, 
another waveform pattern can be selected for that item.  
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4.3.5 Displaying Gaussian trace 
A Gaussian distribution trace can be displayed in the graph when the 
Gaussian Trace check box is checked. This is useful when comparing the 
Peak Power / Average Power distribution of the waveform pattern used 
with the Gaussian distribution.  

 

Figure 4.3.5-1  Gaussian Trace Check Box 
 

4.3.6 Interaction with signal generation application (Quick Add Mode) 
The method for adding a trace to the CCDF graph in conjunction with a 
signal generation application can be set and changed. This function is 
enabled only when the CCDF graph display function is activated. Click 
the Quick Add Mode button to display the Quick Add Mode dialog box.  

 

Figure 4.3.6-1  Quick Add Mode Dialog Box 
 

■When Add is selected: 
A trace is added to the CCDF graph when CCDF is selected from the 
Simulation menu or the CCDF tool button is clicked after data 
generation by the signal generation application. Note that the FFT graph 
display will not be updated when the eight traces are all used.  
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■When Clear is selected: 
A trace is deleted from the CCDF graph and the distribution of the 
generated waveform pattern is displayed when CCDF is selected from 
the Simulation menu or the CCDF tool button is clicked after data 
generation by the signal generation application.  

■When Off is selected: 
The CCDF graph display will not be updated even when CCDF is 
selected from the Simulation menu or the CCDF tool button is clicked 
after data generation by the signal generation application.  
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4.3.7 Mouse interaction selection in the CCDF graph display area 
(Mouse Interaction) 

Graph cursor move or graph zoom-in is selected for a mouse dragging 
operation in the CCDF graph display area. Click the Mouse Interaction 
button to display the Mouse Interaction dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom  The mouse is used to set the zooming area.  

 

Figure 4.3.7-1  Mouse Interaction Dialog Box 
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4.3.8 Moving graph cursor 
The graph cursor displayed in the CCDF graph display area can be 
moved.  

■Moving graph cursor using mouse 
When the Cursor radio button is selected in Mouse Interaction, the 
black-line graph cursor is moved by dragging the mouse on the graph 
cursor in the CCDF graph display area.  

 

Figure 4.3.8-1  CCDF Graph Display Area 
 

The contents displayed in Cursor Position in the CCDF graph display 
screen are updated as the graph cursor is moved.  
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■Moving graph cursor changing Cursor value 
The black-line graph cursor is moved by changing the value of Cursor 
Position in the CCDF graph display screen.  

 

 

Figure 4.3.8-2  Cursor Position Dialog Box 
 

<Procedure> 
1. When setting the graph cursor position by a Peak Power / Average 

Power value, click the PAR text box and enter a value.  

2. When setting the graph cursor position by a cumulative possibility, 
click the Probability text box and enter a value.  

When the focus is moved to another control after changing the value in 
the PAR or Probability text box as shown in Step 1 or 2 above, the 
black-line graph cursor in the CCDF graph display area is moved.  
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4.3.9 Changing graph scale 
The scale of the graph currently displayed can be changed. 

■Changing graph display area scale 
The display ranges for the X and Y axes in the CCDF graph display area 
are updated by changing the value(s) in the Scale field on the CCDF 
graph display screen.  

 

 

Figure 4.3.9-1  Scale Dialog Box 
 

<Procedure> 
1. When changing the display range for the X axis, click the PAR text 

box and enter a value.  

2. When changing the display range for the Y axis, click the Probability 
text box and enter a value.  

3. When the Full Scale button is clicked, the scales for both axes are 
adjusted so that the entire CCDF curve is displayed.  
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When the focus is moved to another control after changing the value in 
the PAR text box as shown in Step 1 above, the scale for the X axis in the 
CCDF graph display area is updated.  

Similarly, when the focus is moved after changing the value in the 
Probability text box as shown in Step 2 above, the scale for the Y axis in 
the CCDF graph display area is updated.  

 

Figure 4.3.9-2  CCDF Graph Display Area 
 

■Specifying display area by mouse operation 
When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the graph enlarges the selected area (within the dotted 
rectangle).  
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4.3.10 Printing/saving graph data 
■Printing out graph display screen 
Select Print Window Image from the File menu to display the print 
screen.  
Set the printer, printing range, number of copies, etc., in this screen, and 
print out the CCDF screen (entire of the window) from the printer.  

 

Figure 4.3.10-1  Print Window Image Button on the File Menu 
 

■Outputting graph data to file 
Select Export Data from the File menu to display the file save screen.  
Set the saving destination, etc., in this screen, and click the Save button.  
Lists of Peak per Average (dB) and Probability (%) are saved to a file in 
the CSV format (a text file format in which values are delimited by a 
comma).  

 

Figure 4.3.10-2  Export Data Button on the File Menu 
 

■Copying graph image on screen 
Select Copy Graph Image from the Edit menu to copy the current graph 
image on the screen to the clipboard.  

 

Figure 4.3.10-3  Copy Graph Image Button on the Edit Menu 
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4.4 FFT Graph Display 
The Fast Fourier Transform (FFT) calculation results for a waveform 
pattern can be displayed in a graph. The Blackman-Harris window 
function is used.  
 

4.4.1 Activation 
Select FFT from the Simulation & Utility tab on the common platform 
screen.  
The FFT graph display screen is displayed separately.  

 

4.4.2 FFT graph display screen  
 

 

Figure 4.4.2-1  FFT Graph Display Screen 
 

■Description of items 
(1) Menu bar 

Trace addition, graph print out, screen copy, graph data saving into 
a CSV format file, and FFT graph display close can be executed.  

(2) Legend 

File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed.  
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(3) Graph display area 

The graphic display area for FFT Graph cursor move and graph 
zoom-in display can be executed.  

(4) Add/Delete (trace addition/deletion) 

A trace can be added/deleted. 

(5) FFT Points 

The number of points of the X axis in the FFT graph display area 
can be specified. 

(6) Cursor Position 

The graph cursor position in the FFT graph display area can be 
specified by entering a value in the Frequency text box.  

(7) Quick Add Mode (interaction with signal generation application) 

Settings for addition of a waveform pattern generated by a signal 
generation application to the FFT graph display in conjunction with 
the signal generation application can be configured.  

(8) Scale setting 

The scale of the X and Y axes in the FFT graph display area can be 
changed.  

(9) Mouse Interaction 

The mouse operation in the FFT graph display area can be set to 
either the graph cursor move function or the zoom-in function.  
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4.4.3 FFT graph display 
A waveform pattern generated by a signal generation application of the 
IQproducerTM can be read and displayed in an FFT graph.  

■FFT graph display procedure 
<Procedure> 
1. Click one of the option buttons in the Legend dialog box to select the 

trace color of the wave form pattern in the FFT graphical area.  

  

Figure 4.4.3-1  Legend Dialog Box 
 

2. Click the FFT Points button to display the FFT Points dialog box. 
Then, Select the number of points for FFT operation. Be sure to 
select a value smaller than the number of sample points of the 
selected waveform pattern.  

 

Figure 4.4.3-2  FFT Points Dialog Box 
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3. Click the Add button to display the Add Trace dialog box.  

The Add button is disabled when any waveform pattern is already 
specified on the selected option button. In such a case, delete the 
waveform pattern by clicking the Delete button, or select one of 
other option buttons.  

 

Figure 4.4.3-3  Add Button 
 

 Otherwise, select Add Trace from the File menu.  

 

Figure 4.4.3-4  Add Trace Button on the File Menu 
 

4. Click the  button in the Add Trace screen, and select a 
waveform pattern for which a FFT graph is displayed. 

 

Figure 4.4.3-5  Add Trace Dialog Box 
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5. Click the OK button on the Add Trace screen to read the waveform 
pattern.  
When the graph calculation has completed, the FFT graph display 
screen is displayed again with a trace in the color selected in Legend. 
If a waveform pattern having a different sampling rate with that of 
the currently displayed waveform pattern is added, the current 
waveform pattern display disappears.  
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4.4.4 Deleting FFT graph 
The FFT graph displayed in the screen can be deleted.  

■Deleting FFT graph 
<Procedure> 
1. Click the option button in the Legend dialog box to select the trace to 

be deleted.  

  
Figure 4.4.4-1  Legend Dialog Box 

 

2. Click the Delete button.  

 

Figure 4.4.4-2  Delete Button 
 

 Otherwise, select Delete Trace from the File menu.  

 

Figure 4.4.4-3  Delete Trace Button on the File Menu 
 

The trace selected in Legend is deleted. After deleting a trace, 
another waveform pattern can be selected for that item.  
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4.4.5 Changing graph display area and axis plot interval 
The plot interval of the X axis (frequency) on the FFT graph and the data 
range for FFT analysis can be changed.  

 

 

Figure 4.4.5-1  Parameter Entry Dialog Box 
 

<Procedure> 
1. Click the FFT Points button to display the FFT Points dialog box. 

Then, select the number of points for the FFT operation.  
When the focus is moved to another control after selecting the FFT 
Points value, the plot interval of the X axis in the graph display area 
is changed.  

2. Click the Sampling Range text box and enter the Sampling Range 
value.  
When the focus is moved to another control after changing the 
Sampling Range value, the data range of the waveform pattern for 
FFT analysis is changed.  

When the FFT Points value is changed, the new FFT Points value is 
applied to all the waveform patterns currently read. If the Sampling 
Range value has been set before changing the FFT Points value, it is 
cleared to “0” – “FFT Points – 1” after FFT Points value change.  
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4.4.6 Interaction with signal generation application (Quick Add Mode) 
The method for updating the FFT graph display in conjunction with 
waveform pattern generation by a signal generation application can be 
set and changed. This function is enabled only when the FFT graph 
display function is activated. Click the Quick Add Mode button to display 
the Quick Add Mode dialog box.  

 

Figure 4.4.6-1  Quick Add Mode Dialog Box 
 

■When Add is selected: 
A trace is added to the FFT graph when FFT is selected from the 
Simulation menu or the FFT tool button is clicked after data generation 
by the signal generation application. Note that the FFT graph display 
will not be updated when the four traces are all used.  

■When Clear is selected: 
A trace is deleted from the FFT graph and the FFT analysis result of the 
generated data is displayed when FFT is selected from the Simulation 
menu or the FFT tool button is clicked after data generation by the 
signal generation application.  

■When Off is selected: 
The time domain graph display will not be updated even when Time 
Domain is selected from the Simulation menu or the Time Domain tool 
button is clicked after data generation by the signal generation 
application.  
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4.4.7 Mouse interaction selection in the CCDF graph display area 
(Mouse Interaction) 

Graph cursor move or graph zoom-in is selected for a mouse dragging 
operation in the FFT graph display area. Click the Mouse Interaction 
button to display the Mouse Interaction dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom  The mouse is used to set the zooming area.  

 

Figure 4.4.7-1  Mouse Interaction Dialog Box 
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4.4.8 Moving graph cursor 
The graph cursor displayed in the FFT graph display area can be moved.  

■Moving graph cursor using mouse 
When the Cursor radio button is selected in Mouse Interaction, the 
black-line graph cursor is moved by dragging the mouse on the graph 
cursor in the FFT graph display area.  

 

 

Figure 4.4.8-1  FFT Graph Display Area 
 

The contents displayed in Cursor in the FFT graph display screen are 
updated as the graph cursor is moved.  

■Moving graph cursor changing Cursor value 
The black-line graph cursor is moved by changing the value of Cursor in 
the FFT graph display screen.  

 

Figure 4.4.8-2  Cursor Dialog Box 
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Click the Frequency text box and enter the Frequency value.  

When the focus is moved to another control after changing the Frequency 
value, the black-line graph cursor in the FFT graph display area is 
moved.  
 

4.4.9 Changing graph scale 
The scale of the graph currently displayed can be changed.  

■Changing graph display area scale 
The scales for the X and Y axes in the FFT graph display area are 
updated by changing the value(s) in the Scale field on the FFT graph 
display screen.  

 

Figure 4.4.9-1  Scale Dialog Box 
 

<Procedure> 
1. Click the Frequency text box and enter the Frequency value from 

the keyboard.  

2. Click the Amplitude text box and enter the Amplitude value.  

3. When the Full Scale button is clicked, the scales for both axes are 
adjusted so that the entire FFT graph is displayed.  

When the focus is moved to another control after changing the value in 
the PAR text box as shown in Step 1 above, the scale for the X axis in the 
CCDF graph display area is updated.  

Similarly, when the focus is moved after changing the value in the 
Probability text box as shown in Step 2 above, the scale for the Y axis in 
the CCDF graph display area is updated.  
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Figure 4.4.9-2  FFT Graph Display Area 
 

■Specifying display area by mouse operation 
When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the graph enlarges the selected area (within the dotted 
rectangle).  
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4.4.10 Printing/saving graph data 
■Printing out graph display screen 
Select Print Window Image from the File menu to display the print 
screen.  
Set the printer, printing range, number of copies, etc., in this screen, and 
print out the FFT screen (entire of the window) from the printer.  

 

Figure 4.4.10-1  Print Window Image Button on the File Menu 
 

■Outputting graph data to file 
Select Export Data from the File menu to display the file save screen.  
Set the saving destination, etc., in this screen, and click the Save button.  
Lists of Peak per Average (dB) and Probability (%) are saved to a file in 
the CSV format (a text file format in which values are delimited by a 
comma).  

 

Figure 4.4.10-2  Export Data Button on the File Menu 
 

■Copying graph image on screen 
Select Copy Graph Image from the Edit menu to copy the current graph 
image on the screen to the clipboard.  

 

Figure 4.4.10-3  Copy Graph Image Button on the Edit Menu 
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4.5 File Conversion on Convert Screen 
ASCII-format waveform patterns generated by simulator software, 
digitized files created by the MS2690A/MS2691A/MS2692A, MS2830A or 
MS2840A Signal Analyzer using the digitize function, and waveform 
patterns formatted for the MS269x, MS2830A or MS2840A can be 
converted into a file so as to be used in the 
MG3700A/MG3710A/MG3710E/MG3740A. Conversely, a waveform 
pattern for the MG3700A/MG3710A/MG3710E/MG3740A can also be 
converted into a file that can be used in the 
MS2690A/MS2691A/MS2692A MS2830A or MS2840A Signal Analyzer. 
The output file consists of a waveform information file (text format file 
with the extension “.wvi”) that stores the information related to the 
waveform pattern and a waveform data file (binary format file with the 
extension “.wvd”).  

When activated in MG3700 mode: 

Select whether to enable/disable the ARB memory expansion option 
512Msamples for the MG3700A. When With Option21 (Memory 512M 
samples) is selected, the maximum size of the waveform pattern is 
expanded. A waveform pattern exceeding 256 Msamples cannot be used 
when the ARB memory expansion option 512Msamples is not installed. 
Select either With Option21 or Without Option21 according to whether 
the ARB memory expansion option 512Msamples is installed in the 
MG3700A to be used or not.  

 

Figure 4.5-1  Memory Option Dialog Box 
 

When activated in MG3710 mode: 

The following functions are supported.  
Whether the memory option is used can be selected.  
The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. Selecting the 
ARB Memory Expansion (option) and the Baseband Signal Combination 
Function (option) generates a bigger waveform pattern, while selecting 
the Baseband Signal Combination Function (option) generates a 
waveform pattern. If an uninstalled option is selected, sometimes the 
created waveform pattern may not be usable. Set this parameter 
according to the available options for MG3710A/MG3710E shown in the 
following table.  
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Table 4.5-1  The Maximum Data Points Corresponding to Each Memory 
Option (MG3710A/MG3710E) 

Memory Option Menu Maximum data points 
Memory 64M samples 64M samples 
Memory 64M samples × 2 (With Option 48, 78) 128M samples 
Memory 256M samples 256M samples 
Memory 256M samples × 2 (With Option 48, 
78) 

512M samples 

Memory 1024M samples 1024M samples 

Memory 1024M samples × 2 (With Option 48, 78) 1024M samples 
 
No manual setting is available when this software is hosted by the 
MG3710A/MG3710E, since it is set automatically.  

When activated in MG3740 mode: 

The following functions are supported.  
Whether the memory option is used can be selected.  
The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. Selecting the 
ARB Memory Expansion (option) and the Baseband Signal Combination 
Function (option) generates a bigger waveform pattern, while selecting 
the Baseband Signal Combination Function (option) generates a 
waveform pattern. If an uninstalled option is selected, sometimes the 
created waveform pattern may not be usable. Set this parameter 
according to the available options for MG3740A shown in the following 
table.  

Table 4.5-2  The Maximum Data Points Corresponding to Each 
Memory Option (MG3740A) 

Memory Option Menu Maximum data points 
Memory 64M samples 64M samples 
Memory 64M samples × 2 (With Option 48, 
78) 

128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With Option 48, 
78) 

512M samples 

 
No manual setting is available when this software is hosted by the 
MG3740A, since it is set automatically.  
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When activated in MG3710 or MG3740 mode: 

The waveform pattern bit width can be selected as 14, 15, or 16 bits.  
Changing the bit width can improve the dynamic range. In addition, the 
specifiable RMS value range and usable marker signals differ for each bit 
width as follows.  

Table 4.5-3  Restrictions per Each Bit Width 

Bit 
Width 

Specifiable RMS 
Value Range Usable Marker Signals 

14 bit 1 to 8191 Marker 1 to 3, RF Gate 
15 bit 1 to 16383 Marker 1, RF Gate 
16 bit 1 to 32767 None 

 
The specifiable bit widths differ for each conversion file format as follows.  
 
Table 4.5-4  Available Bit Width per Each Input File Format 

Input File Format Selectable Bit Width 

ASCII1 14/15/16 bit 
ASCII2 15/16 bit 
ASCII3 14/15 bit 
MS269x/MS2830/MS2840 Digitizer 14/15/16 bit 
MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700) 14 bit 
MG3700/MS269x/MS2830/MS2840 (to MG3710) 14 bit 
MG3700/MS269x/MS2830/MS2840 (to MG3740) 14 bit 
MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x) 14 bit 
MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840) 14 bit 
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4.5.1 Activation 
Click the Convert button on the General Purpose tabbed box in the 
Common Platform Screen.  
The Convert screen is displayed separately.  

4.5.2 Convert screen 
 

 

 

Figure 4.5.2-1  Convert Dialog Box for the MG3700A 
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Figure 4.5.2-2  Convert Dialog Box for the 
MG3710A/MG3710E/MG3740A 

 

■Description of items 
(1) Input file selection 

Click the Reference button and select a file to be input. Two or more 
files can be selected. The selected files are displayed in the left field. 
The number of files to be selected varies depending on the file 
format setting.  

(2) File data setting 
Set the data to be written in the waveform information file (.wvi 
format) of the waveform pattern to be generated.  

(3) File format 
The format of the file to be converted 

ASCII1, ASCII2, ASCII3, 
MS269x/MS2830/MS2840 Digitizer,  
MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700), 
MG3700/MS269x/MS2830/MS2840 (to MG3710), 
MG3700/MS269x/MS2830/MS2840 (to MG3740), 
MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x),  
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MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840) are 
selectable.  

(4) Comment entry 

Enter the comment. 

(5) Burst data setting 

Set the Burst data. The Burst data includes Gap Length and Frame 
Length, and they should be set respectively. For a non-Burst 
continuous wave, set the number of samples per frame of the used 
communication system or “1” for Frame Length, and set “0” for Gap 
Length. When an external trigger is used, the waveform pattern 
output timing is determined based on this setting. For details on 
external trigger, refer to 3.5.4 “Outputting signal in sync with 
external trigger signal” in MG3700A Vector Signal Generator 
Operation Manual (Mainframe), or 7.4.1 “Route Input Connectors” 
in MG3710A/MG3710E/MG3740A Operation Manual (Mainframe).  

(6) RF Gate setting 

Configures the RF gate settings. These parameters are enabled only 
when the file format is set to ASCII1, ASCII2, ASCII3, or MS269x/ 
MS2830A/MS2840A Digitizer. When the RF Gate checkbox is 
selected, RF Gate processing is performed during waveform pattern 
conversion for samples in which the I and Q values ( jQI + ) of the 
input ASCII file or digitized file data are continuously at or below 
the threshold level. The threshold level can be set by entering the 
ratio to the waveform pattern peak value in the RF On/Off 
Threshold text box. The RF Gate is executed only for the samples in 
which the I and Q values less than the threshold level continue for 
longer than the value set in the Minimum RF Gate Length text box. 
Since the samples for which the RF Gate is executed are excluded 
for rms calculation during waveform pattern conversion, it is 
therefore possible to prevent underestimation of the rms value of the 
burst signal waveform pattern (accordingly, the output level in a 
burst-on interval can be kept under the specified RF output level)  

(7) Data conversion 

Starts file conversion. 

(8) Exit 

Ends the conversion process. 
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4.5.3 Input file selection 
Select a file to be converted.  

<Procedure> 
1. Click the  button in the File format box to open a pull-down 

menu, and select the format of the file to be input.  

2. Click the Reference button to open the file dialog box, and select a 
file to be converted (conversion source file). The file selection dialog 
is displayed when selecting several files having the same file format. 
Select a data file displayed in the file type.  

 

Figure 4.5.3-1  The File to be Converted Dialog Box 
 

 The number of files to be selected and the file type differ depending 
on the file format as follow:  

ASCII1: One file that contains I-phase data, Q-phase data, and 
marker data. 

ASCII2: Two files of I-phase data file and Q-phase data file. 

ASCII3: Three files of I-phase data file, Q-phase data file, and 
marker data file.  

MS269x/MS2830/MS2840 Digitizer: 

xml file, which is a digitized file created by the MS2690A/ 
MS2691A/MS2692A, MS2830A or MS2840A Signal 
Analyzer using the digitize function.  

MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700): 

Of the wvi and wvd files, which are waveform patterns for 
the MG3710A, MG3710E, MG3740A, MS269xA or 
MS2830A/MS2840A, respectively, select the wvi file.  

MG3700/MS269x/MS2830 (to MG3710): 

Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MS269xA or MS2830A/MS2840A, 
respectively, select the wvi file. 

MG3700/MS269x/MS2830 (to MG3740): 

Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MS269xA or MS2830AMS2840A, 
respectively, select the wvi file. 

MG3700/MG3710/MG3740/MS2830 (to MS269x): 

Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MG3710A, MG3710E, MG3740A or 
MS2830A/MS2840A, respectively, select the wvi file.  
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MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840): 

Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MG3710A, MG3710E, MG3740A or 
MS269xA, respectively, select the wvi file.  

 Click the OK button to finalize the input file selection.  
Click the Cancel button to cancel the input file selection. 

 If the file format is changed in the File format box after selecting the 
input files, the current settings are cleared.  

3 In the MG3710/MG3740 mode, the dialog box below for selecting the 
bit width appears after selecting the input file. Specify 14, 15, or 16 
bits. However, the bit widths that can be specified depend on the 
selected file format as shown in Table 4.5-4.  

 

Figure 4.5.3-2  Output IQ Data Width Dialog Box 

  

4 When the input files are selected, they are read and a dialog box 
appears displaying the maximum value, minimum value, RMS value 
and the number of data. In this dialog box, the edit boxes for setting 
the first and last samples are displayed only when 
MS269x/MS2830A/MS2840A Digitizer is selected for the file format. 
Use the edit boxes for setting the reading range.  
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Figure 4.5.3-3  Input File Information Dialog Box 
 

 Click the OK button to finalize the input file selection.  
Click the Cancel button to cancel the input file selection. 

 If the file format is changed in the File format box after selecting the 
input files, the current settings are cleared.  
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4.5.4 Editing data in Convert screen 
The data to be written in the waveform information file of the waveform 
pattern to be generated can be edited by setting the parameters in the 
Waveform Pattern parameters field. Note that some parameters cannot 
be set depending on the file format.  

■Setting sampling rate 
<Procedure> 
1. Click the Sampling Rate box and enter a sampling rate value to be 

set to the MG3700A/MG3710A/MG3710E/MG3740A. After the 
waveform pattern is selected by the 
MG3700A/MG3710A/MG3710E/MG3740A, the sampling rate can be 
changed to any value within the setting range when the selected 
waveform pattern is actually used. The sampling rate can be set 
from 20 kHz to 160 MHz.  

Note:  
When the IQproducerTM operates in the MG3740 mode, the setting 
range for the sampling rate is 20 kHz to 8 MHz. 

2. Click the  button on the right of the Sampling Rate box to open a 
pull-down menu, and select the unit of the sampling rate.  
The unit can be set from Hz, kHz, and MHz.  

 

Figure 4.5.4-1  Sampling Rate Dialog Box 
 

■Setting Low pass filter (Effective only for MG3700A)  
Click the  button on the Low pass filter pull-down combo box to select 
an analog low pass filter to be placed on the front end of the D/A 
converter output circuit. The analog low pass filter can be selected among 
the following variation.  

The analog low pass filter can be selected among the following variation.  
100 kHz, 300 kHz, 1 MHz, 3 MHz, 10 MHz, 30 MHz, 70 MHz, Through 
and Auto (The automatically optimized setting for the modulated 
bandwidth flatness and the image reduction ratio)  
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Figure 4.5.4-2  Low Pass Filter Dialog Box 
 

■Setting Normalizing 
To apply the RMS (Route Mean Square) value of the standard waveform 
pattern used by the MG3700A/MG3710A/MG3710E/MG3740A to the 
amplitude of the waveform pattern to be converted, click the Normalizing 
check box of the conversion source file to leave a checkmark ( ).  

 

Figure 4.5.4-3  Normalizing Check Box 
 

The RMS value of the standard waveform pattern used by the 
MG3700A/MG3710A/MG3710E/MG3740A Indicates the following RMSI 
and RMSQ:  
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Where Σ is the sum of target waveform patterns except the 
samples of which RF output is set to OFF by RF Gate. 

 
 

RMSI indicates the RMS value for I phase, and RMSQ indicates that for 
Q phase. 
RMSIQ indicates the RMS value of the I/Q vector when RMSI and RMSQ 
are as described above.  
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When this software is hosted by the MG3700A:  

When Normalization is applied, the crest factor (Peak Power / RMS 
Power) becomes 14 dB if the signal output of the MG3700A is set within 
the level assurance range.  

When this software is hosted by the MG3710A/MG3710E/MG3740A;  

Table 4.5.4-1  The RMS Values of Typical Waveform Pattern per Each 
Bit Width  

Bit 
Width RMSI RMSQ RMSIQ 

14 bit 1157 1157 1636 
15 bit 2314 2314 3272 
16 bit 4628 4628 6545 

 

RMSI indicates the RMS value for I phase, and RMSQ indicates that for 
Q phase. 
RMSIQ indicates the RMS value of the I/Q vector when RMSI and RMSQ 
are as described above.  

When Normalization is selected, a crest factor (Peak Power/RMS Power) 
of 17 dB can be obtained if the signal output is set within the level 
assurance range.  

■Setting RMS and Peak values 
When reading a waveform pattern, the data is read from the conversion 
source file and the RMS and Peak values are calculated and displayed. 
Click the RMS Value box and enter an RMS value of the waveform after 
conversion to be actually used. The Peak value changes in conjunction 
with the RMS value. On the other hand, when the Peak value is set in 
the Peak Value box, the RMS value changes in conjunction with the RMS 
value.  

Though the setting of Normalizing above is usually sufficient, this 
setting (adjustment) is also essential in the following purpose; 
To output a large crest factor waveform, 
To optimize the distortion, floor noise or carrier leak of modulated output 
signal.  
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The relationship between the characteristics of the 
MG3700A/MG3710A/MG3710E/MG3740A and the RMS value is shown 
in Table 4.5.4-2 below:  

Table 4.5.4-2  The Relation between the Major Waveform Factors and 
RMS Values 

Items RMS value (Larger) RMS value (Smaller) 
Signal distortion Worse Better 

Floor noise Better Worse 
Carrier leakage Better Worse 

 

 

Figure 4.5.4-4  RMS Value Dialog Box 
 

When this software is activated in the MG3700 mode; 
The output-level performance-guaranteed upper limit value for the RMS 
value range and the upper limit setting level for RF output signal 
stable-distortion characteristics are shown in the Tables 4.5.4-3 and 
4.5.4-4 below.  

Table 4.5.4-3  The Maximum Guaranteed Output Level 

Frequency For standard 
composition 

When a mechanical 
attenuator option is 

installed. 
50 MHz ≤ f ≤ 3 GHz +2 + χ dBm +7 + χ dBm 
3 GHz < f ≤ 6 GHz (if 
Upper limit frequency 6 
GHz option is installed) 

–1 + χ dBm +4 + χ dBm 

χ: RMS value (dB) = 20*log (RMS value/1634)  RMS value = 1157 to 1634 
 

Table 4.5.4-4  Normalized Distortion Free Level of RF Output Signal 

For standard composition 
When a mechanical 
attenuator option is 

installed. 
χ dBm +3 + χ dBm 
χ: RMS value (dB) = 20*log (RMS value/1634)  
RMS value = 1157 to 1634 
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When this software is activated in the MG3710/MG3740 mode; 
When reading a waveform pattern, the data is read from the conversion 
source file and the RMS and Peak values are calculated and displayed. 
Click the RMS Value text box, and then enter the RMS value of the 
post-conversion waveform that is actually used for this option. The Peak 
value changes in conjunction with the RMS value. On the other hand, if 
you click the Peak Value button to set the peak value, the RMS value is 
also correspondingly changed.  

 

Figure 4.5.4-5  RMS Value Dialog Box 
 

Normally, the Normalizing checkbox is selected and the RMS and Peak 
values are automatically specified, but the values can be manually 
specified to adjust the characteristics for signals that have a crest factor 
larger than 17 dB.  

Note that the RF output level reliability for the MS2830A is specified 
assuming the following RMS values.  

Table 4.5.4-5  RMS Setting Range of Guaranteed Output Level 

Bit Width RMS-value setting range 
14 bit 819 to 1634 
15 bit 1638 to 3269 
16 bit 3276 to 6537 

 

■Setting unit (available for ASCII1, ASCII2, ASCII3, and 
MS269x/MS2830A/MS2840A Digitizer) 

Click  in the Unit symbol list box, and then select the unit.  
sample, symbol, chip, or none can be selected as the unit.  
This setting is applied to the screen display unit when the waveform 
pattern is used.  

 

Figure 4.5.4-6  Unit Symbol Dialog Box 
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■Setting memory size 
When this software is activated in the MG3700 mode; 
Select whether to enable/disable the ARB memory expansion option 
512Msamples for the MG3700A. When With Option21 (Memory 512M 
samples) is selected, the maximum size of the waveform pattern is 
expanded. A waveform pattern exceeding 256 Msamples cannot be used 
when the ARB memory expansion option 512Msamples is not installed. 
Select either With Option21 or Without Option21 according to whether 
the ARB memory expansion option 512Msamples is installed in the 
MG3700A to be used or not.  

 

Figure 4.5.4-7  Memory Option Dialog Box 
 

When this software is hosted by other than the MG3710A/MG3710E and 
activated in the MG3710 mode; 
The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. Selecting the 
ARB Memory Expansion (option) and the Baseband Signal Combination 
Function (option) generates a bigger waveform pattern, while selecting 
the Baseband Signal Combination Function (option) generates a 
waveform pattern. If an uninstalled option is selected, sometimes the 
created waveform pattern may not be usable. Set this parameter 
according to the available options for MG3710A/MG3710E shown in the 
following table.  

Table 4.5.4-6  Memory Option Menu and Maximum Data Points 
(MG3710A/MG3710E) 

Memory Option Menu Maximum data 
points 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With Option48, 78) 128M samples 
Memory 256M samples 256M samples 
Memory 256M samples × 2 (With Option 48, 78) 512M samples 
Memory 1024M samples 1024M samples 
Memory 1024M samples × 2 (With Option 48, 
78) 

1024M samples 

 
No manual setting is available when this software is hosted by the 
MG3710A/MG3710E, since it is set automatically.  
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When this software is hosted by other than the MG3740A and activated in 
the MG3740 mode; 
The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. Selecting the 
ARB Memory Expansion (option) and the Baseband Signal Combination 
Function (option) generates a bigger waveform pattern, while selecting 
the Baseband Signal Combination Function (option) generates a 
waveform pattern. If an uninstalled option is selected, sometimes the 
created waveform pattern may not be usable. Set this parameter 
according to the available options for MG3740A shown in the following 
table.  

Table 4.5.4-7  Memory Option Menu and Maximum Data Points 
(MG3740A) 

Memory Option Menu Maximum data 
points 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With Option48, 78) 128M samples 
Memory 256M samples 256M samples 
Memory 256M samples × 2 (With Option 48, 78) 512M samples 

 
No manual setting is available when this software is hosted by the 
MG3740A, since it is set automatically.  

■Setting package name 
Enter the name of the package that is used to store the generated 
waveform patterns when transferring them to the MG3710A/MG3710E.  
Up to 31 characters can be used for a package name. 
Alphanumeric characters and the following symbols may be used: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 

Figure 4.5.4-8  Package Dialog Box 
 

■Setting Bandwidth (For MG3710/MG3740) 
Set the bandwidth of waveform pattern. Enter the value in the 
Bandwidth dialog box. Then click the  button in the Bandwidth 
dialog box to select the unit among Hz, kHz and MHz.  
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Figure 4.5.4-9  Bandwidth Dialog Box 

■Selecting spectrum (available for ASCII1, ASCII2, ASCII3, and Digitizer) 
Click the  button on the right of the Spectrum box to open a 
pull-down menu, and select the spectrum from Normal and Reverse. 
When Reverse is selected, the phase of the RF modulated signal output is 
reversed.  

 

Figure 4.5.4-10  Spectrum Dialog Box 
 

■Setting over sampling rate (available for ASCII1, ASCII2, ASCII3, and 
Digitizer when in MG3710/MG3740 mode) 
Set the over sampling rate for the waveform pattern to be input to 
Convert. Click the Over Sampling box and enter a numeric value. For 
example, to specify a sampling rate of 4 MHz for signals that have a 
1-MHz symbol rate, enter “4”.  

 

Figure 4.5.4-11  Over Sampling Dialog Box 
 

■Setting Data Points (available for ASCII1, ASCII2, and ASCII3) 
The number of sample points of the read waveform pattern is displayed 
in the Data Points box. Usually, this setting is not required to be changed. 
In case of change, enter the value into the Data Points dialog box.  

 

Figure 4.5.4-12  Data Points Dialog Box 
 

When the number of sample points of the read waveform is less than 
1000 points, the output pattern is repeated so that the number of output 
patterns becomes 1000 points or more. When the number of sample 
points of the read waveform is 99 points, for example, the output pattern 
is repeated 11 times and a waveform pattern with 1089 points is output.  
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■Entering comments 
Click the Comment Line 1 box and enter a comment. The text entered 
here is displayed on the screen when the 
MG3700A/MG3710A/MG3710E/MG3740A selects the corresponding 
waveform. Leave this text box blank if unnecessary. The Comment Line 2 
box is disabled until any comment is entered in the Comment Line 1 box. 
Similarly, the Comment Line 3 box is disabled until any comment is 
entered in the Comment Line 2 box.  

 

Figure 4.5.4-13  Comment Line Dialog Box 
 

■Specifying the detail file (In the MG3700 mode) 
To specify a detail file, click the Detail File check box to leave a 
checkmark ( ). Then the input area and the Reference button become 
enabled. Click the input area and enter the directory of the target detail 
file directly, or click the Reference button to display the file dialog box 
and locate the target detail file.  

The contents of the detail file selected here can be displayed on the 
screen when the MG3700A selects the corresponding waveform pattern.  

 

Figure 4.5.4-14  Detail File Dialog Box 
 

■Setting marker names 
To set a marker name, click the Marker Name check box to leave a 
checkmark ( ).  
Then the Marker 1 Name, Marker 2 Name, and Marker 3 Name boxes 
become enabled. Click an input area and enter a marker name. Note that 
these settings do not enable/disable the marker output. The contents of 
these settings are displayed on the screen.  

 

Figure 4.5.4-15  Marker Name Dialog Box 
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■Setting Burst information 
To set the Burst information, click the Burst Setting check box to leave a 
checkmark ( ). Then the Frame Length and Gap Length boxes become 
enabled. Click an input area and enter a numeric value to set Frame 
Length and/or Gap Length. Refer to Section 5.4 “Generating Waveform 
Pattern” for details.  

 

Figure 4.5.4-16  Burst Setting Dialog Box 
 

■Configuring RF Gate settings (for digitized and ASCII file and file 
conversion) 
To configure the RF Gate settings, click the RF Gate check box to leave a 
checkmark ( ). The RF On/Off Threshold and Minimum RF Gate Length 
boxes will then become enabled. Click an input area and enter a numeric 
value to set the RF On/Off threshold and minimum RF gate length.  

 

Figure 4.5.4-17  RF Gate Dialog Box 
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4.5.5 Executing conversion 
Set a file before conversion (conversion source file) and a file after 
conversion (conversion destination file) before executing conversion.  

<Procedure> 
1. Click the Convert button to display the Export File screen shown in 

Figure 4.5.5-2 below.  

 

Figure 4.5.5-1  Convert Execution Button 
 

 

Figure 4.5.5-2  Export File Dialog Box (In MG3700 mode) 
 

 

Figure 4.5.5-3  Export File Dialog Box (In MG3710/MG3740 mode) 
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2. Click  to open the folder selection screen and locate the 
output destination folder.  

 

Figure 4.5.5-4  Program Selection Screen 
 

The output destination of the waveform pattern is specified in Table 
4.5.5-1 below.  

Table 4.5.5-1  Waveform Pattern Output Destination 

Host equipment 
of this software Output destination 

MG3710A 
MG3710E 
MG3740A 

C:\Anritsu\MG3710A\User 
Data\Waveform\”Package name” 
An output destination file other than the above can 
be assigned.  

Hosted by PC in 
MG3710/MG3740 
mode 

Corresponding to the Export Path setting in the 
Export File dialog box  

Other than the 
above 

Corresponding to the Export Path setting in the  
Export File dialog box  

 
3. Click the Export File Name box and enter the name of the file to be 

output.  

4. Check one of the Transfer, Load or Play check box in Export File 
dialog box.  
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Table 4.5.5-2  Transfer, Load and Play Operations 

Check box Descriptions Remarks 

Transfer Starts Transfer & Setting Wizard after 
waveform conversion 
Confirmation dialog after the 
waveform generation will not appear.  

Available when executing in 
MG3700, MG3710 or MG3740 
mode.  

Load Loads the waveform pattern, created 
as the result of waveform generation 
application, to the memory  

Available when executing in 
MG3710A/MG3710E/MG3740A. 

Play Selects after loading the waveform 
pattern, created as the result of 
waveform generation application, to 
the memory  

Available when executing in 
MG3710A/MG3710E/ MG3740A. 

 

4. Click the OK button to start conversion. After this, if a clipping 
occurs during the conversion, the warning message “The waveform 
pattern to be generated will be above 8191 and be clipped.” is 
displayed. If the OK button on the warning message dialog box is 
clicked at this time to continue the conversion as is, a waveform 
pattern for which clipping has been processed is generated.  

 

Figure 4.5.5-5  Convert Progress Screen 
 

 The Conversion executing screen is displayed from the start to the 
end of conversion.  

5. When conversion is completed, click the OK button to return to the 
Convert screen.  

 Two files of a file with the extension “.wvi” and a file with the 
extension “.wvd” are output and created in the file specified by the 
Export Path box after conversion.  
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4.5.6 Input file format 
There are the following eight types of acceptable file for the Convert 
operation.  

• ASCII1 format file  
• ASCII2 format file  
• ASCII3 format file  
• The digitized file generated by the MS269x Digitizer (The digitizing 

capability of MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 
signal analyzer)  

• The waveform pattern formatted for MG3710A, MG3710E, MG3740A, 
MS269xA, MS2830A or MS2840A 
(MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700)) 

• The waveform pattern formatted for MG3700A, MS269xA MS2830A 
or MS2840A (MG3700/MS269x/MS2830/MS2840 (to MG3710)) 

• The waveform pattern formatted for MG3700A, MS269xA or 
MS2830A (MG3700/MS269x/MS2830/MS2840 (to MG3740)) 

• The waveform pattern formatted for MG3700A, MG3710A, MG3710E, 
MG3740A, MS2830A or MS2840A 
(MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x)) 

• The waveform pattern formatted for MG3700A, MG3710A, MG3710E, 
MG3740A, or MS269x  
(MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840)) 

• This section describes the ASCII-format files.  
• The following data are included in each of ASCII format files.  
 
■I-phase data 
This is in-phase component data of the waveform pattern 

■Q-phase data 
This is quadrature-phase component data of the waveform pattern 

■Marker data 
For MG3700A: 
This data is used to output marker signals from the AUX Input/ Output 
connectors. There are three types of signal outputs: Marker 1, Marker 2, 
and Marker 3.  
Each signal of this data outputs either of the following TTL value:  

0 = LO level 
1 = HI level 
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Figure 4.5.6-1  MG3700A AUX Input/Output 

 

For MG3710A/MG3710E/MG3740A: 
This data is used to output marker signals from the Marker 1 and AUX 
connectors on the back panel. There are three types of signal outputs: 
Marker 1, Marker 2, and Marker 3.  
Each signal of this data outputs either of the following TTL value:  

0 = LO level 
1 = HI level 

 

Figure 4.5.6-2  MG3710A/MG3710E/MG3740A Marker1, AUX 
 

The output signal is specified depending on the 
MG3710A/MG3710E/MG3740A settings as shown.  
 

Table 4.5.6-1  MG3710A/MG3710E/MG3740A Marker Signal 

Generating 
SG 

Waveform 
memory Signal name 

SG1 Memory A SG1 Marker1 A/ SG1 Marker2 A/ SG1 
Marker3 A 

SG1 Memory B SG1 Marker1 B/ SG1 Marker2 B/ SG1 
Marker3 B 

SG2 Memory A SG2 Marker1 A/ SG2 Marker2 A/ SG2 
Marker3 A 

SG2 Memory B SG2 Marker1 B/ SG2 Marker2 B/ SG2 
Marker3 B 

 
For how to configure marker signal and connector setting, refer to 
7.4.2 “Route Output Connectors” in MG3710A/MG3710E/MG3740A 
Operation Manual (Mainframe).  
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When the MG3700A/MG3710A/MG3710E/MG3740A uses waveform 
patterns, the difference between the marker data output timing and the 
timing the MG3700A/MG3710A/MG3710E/MG3740A outputs the 
modulation data corresponding to the output marker data from the RF 
Output connector is adjusted to be within approx. ±1 sample.  

 

 Marker Data Data2 Data1 

RF Output 

Data3 Data4 

I/Q1 I/Q2 I/Q3 I/Q4 

±1 sample  

Figure 4.5.6-3  Marker Data and RF Output Timing 

 
■RF Gate 
This data is used to execute pulse modulation for the RF output when 
using a Burst wave such as TDMA.  
Each signal of this data indicates as follows: 

1= RF signal output On 
0= RF signal output Off 

The RF Gate data is adjusted by the internal delay circuit of the 
MG3700A/MG3710A/MG3710E/MG3740A so as to be input to the 
internal pulse modulator of the 
MG3700A/MG3710A/MG3710E/MG3740A at almost the same time when 
the IQ-phase data corresponding to the RF Gate data is input to the 
pulse modulator. The pulse modulation timing for the RF output can be 
adjusted, therefore, by applying RF Gate = 0 at the same position with 
the IQ-phase data where the RF signal is required to be Off.  

When the data for both the I and Q phases are set to 0000h and the RF 
output is set to Off instead of using this bit (i.e., RF Gate data = 1), the 
On/Off power ratio of the RF output signal becomes smaller than that in 
the case using the RF Gate data. Therefore, when a larger On/Off power 
ratio is required, set the data for both the I and Q phases to 0 and then 
set the RF output to Off using the RF Gate data. Note that the sample 
for which RF output is set to Off using the RF Gate data is excluded from 
RMS value calculation/adjustment when reading input file or generating 
waveform pattern file. Refer to Section 4.5.4 “Editing data in Convert 
screen” for details.  



 

Chapter 4  Operations for Each Function 

4-66 

 

 
Waveform 
memory 

 
DA converter 

14 

14 

 
Vector  

modulator 

 
Pulse 

modulator 

3 

Markers 1, 2, 3 

RF Gate 
 

Delay 
3 

Waveform data Sample 2 Sample 1 

RF Gate 
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Figure 4.5.6-4  Waveform Pattern Generator Block Diagram and Output Signal Timing Chart of 
Mainframe 
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The following show the formats of ASCII1, ASCII2, and ASCII3 that can 
be input to Convert:  

■ASCII 1 
Waveform patterns before conversion are configured in one file. One line 
indicates one data. The data is delimited by a comma, in the order of 
I-phase data, Q-phase data, Marker 1, Marker 2, Marker 3, and RF Gate. 
Set ‘0’ or ‘1’ for Markers 1 through 3 and RF Gate. Markers 1 through 3 
and RF Gate can also be omitted. If omitted, ‘0 (LO level)’ is applied to 
Markers 1 through 3 and ‘1 (RF Output On)’ to RF Gate. A line starts 
with a character other than numeric, ‘+’, or ‘–’ is regarded as a comment 
line, and is ignored. In addition to displaying I-phase data and Q-phase 
data using decimal values, such data can be displayed using e or E and 
exponential notation (such as “2.0E+3”).  

// IQ Data 
Comment Line 
–0.214178, –0.984242 
–0.187286, –1.245890 
–0.073896, –1.368888 
0.091758, –1.316199 
–0.073896, –1.368888, 1 # Marker1 = 1 is output. 
0.091758, –1.316199, 0, 1 # Marker2 = 1 is output. 
0.248275, –1.089333, 0, 0, 1 # Marker3 = 1 is output. 
0.331432, –0.729580, 0, 0, 0, 0 # RF output becomes Off. 
0.331432, –0.729580, , 0, 0, 1 # Marker1 = 0 is output and RF output 
becomes On.  
… 

■ASCII 2 
Waveform patterns before conversion are configured in two files: I-phase 
data file and Q-phase data file. The file configuration is the same with 
that for ASCII3 except for the marker data file. In the ASCII2 format, 
Markers 1 through 3 are set to 0, RF Gate is set to 0, and all the marker 
outputs are ‘0.’ And the RF outputs for all the samples of the waveform 
pattern are set to On, since the pulse modulation is disabled. In addition 
to displaying I-phase data and Q-phase data using decimal values, such 
data can be displayed using e or E and exponential notation (such as 
“2.0E+3”).  
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■ASCII 3 
Waveform patterns before conversion are configured in three files. The 
patterns are divided such that I-phase data is stored in the first file, 
Q-phase data in the second, and Marker 1 to 3 and RF Gate data in the 
third. Set ‘0’ or ‘1’ for Markers 1 through 3 and RF Gate. Markers 1 
through 3 and RF Gate can also be omitted. If omitted, ‘0 (LO level)’ is 
applied to Markers 1 through 3 and ‘1 (RF Output On)’ to RF Gate.  

In each file, the I-phase data, Q-phase data, and Markers 1 through 3 
and RF Gate data are combined and described in one line delimited by 
<cr><lf> with the same line number. Therefore, when a comment line is 
added to the start of one of these files, it is necessary to adjust the 
number of lines among the files by adding a comment line or <cr><lf> to 
other files. An error occurs if the number of lines differs between the 
I-phase data and Q-phase data. If Markers 1 through 3 and RF Gate data 
exists in a line where I-phase and Q-phase data do not exist, it is 
regarded that line has no data. If the data line of a different file is 
described in a comment line in a certain file, that data line is ignored. A 
line starts with a character other than numeric, ‘+’, or ‘–’ is regarded as a 
comment line, and is ignored. In addition to displaying I-phase data and 
Q-phase data using decimal values, such data can be displayed using e or 
E and exponential notation (such as “2.0E+3”).  

File 1 (I-phase data) 

// I Data 
Comment Line 
–0.214178 
–0.187286 
–0.073896 
0.091758 
0.248275 
0.331432 
… 
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File 2 (Q-phase data) 

// Q Data # Adjusting the line number since two comment lines are 
added in the I-phase data. 
<cr><lf>  
–0.984242 
–1.245890 
–1.368888 
–1.316199 
–1.089333 
–0.729580 
… 

File 3 (Marker data) 

<cr><lf> 
<cr><lf> 
<cr><lf> # Markers 1 through 3 = 0 and RF Gate = 1 for the third 
and fourth lines. 
<cr><lf> 
1  # Corresponds to the fifth line data in the I-phase and 
Q-phase data.  
0,1 
0,0,1 
1,0,0,1 
… 
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4.5.7 Setting the RMS-value calculation range 
By displaying the Time Domain screen from the Convert screen, the 
pre-conversion waveform pattern can be checked, the RMS-value 
calculation range can be set, and the RMS value of the read waveform 
can be recalculated.  
However, the Time Domain screen can only be displayed if the file format 
is set to ASCII1, ASCII2, ASCII3, or MS269x/MS2830A/MS2840A 
Digitizer.  

To display the Time Domain screen, click the Time Domain button.  

 

Figure 4.5.7-1  Time Domain Display Button 

 

For details about using the Time Domain screen to specify the 
RMS-value calculation range, see Section 4.13.13 “Displaying the Time 
Domain screen from the Convert screen”.  

When the RMS-value calculation range is set, the RMS value for the 
waveform pattern is recalculated, and the value in the Peak Value text 
box is updated.  
Using the above function makes it possible to prevent the ratio between 
the Peak value of a wave for which RF Gate is not set and the RMS value 
from being reduced as well as the resulting clipping.  

 

Range before the 
Time Domain 
setting 

RMS in the range 
set in Time Domain 

Range set in Time Domain 

Power 

time 

RMS in the range 
before the Time 
Domain setting 

 

Figure 4.5.7-2  RMS Value Calculation Range
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4.6 File Transfer and Loading to Memory in Transfer & 
Setting Panel Screen 

This function enables file transfer of waveform patterns to the 
MG3700A/MG3710A/MG3710E/MG3740A. The remote function is also 
provided, which loads and deletes the waveform pattern transferred to 
the MG3700A/MG3710A/MG3710E/MG3740A to/from the 
MG3700A/MG3710A/MG3710E/MG3740A memory.  
 

4.6.1 Activation 
Select Transfer & Setting Panel from the Simulation & Utility tab on the 
common platform screen. 

When starting up Transfer & Setting, the Connection to Instrument 
screen is displayed. Selects the instrument type to be connected to the 
host in the Target Instrument dialog box and，also enter the host name or 
IP address for the Ethernet connection. Then click the Connect button to 
establish the connection.  

Note: 
If the MG3700A firmware version is 1.xx, the warning message 
“The MG3700A firmware version is 1.xx. Your version of 
IQproducer cannot connect with the version 1.xx of MG3700A 
normally. Please check Anritsu Download Support Site to upgrade 
MG3700A firmware.” will be displayed. In this event, this software 
cannot be connected normally to the MG3700A. Upgrade the 
MG3700A firmware before starting connection (the latest firmware 
can be obtained from the download page linked to the MG3700A 
page on the Anritsu Web site).  

For how to connect this equipment to network, refer to 4.2.3 “Connecting 
devices via Ethernet” in MG3700A Operation Manual (Mainframe), or 
E.3.2 “Ethernet interface settings” in MG3710A/MG3710E/MG3740A 
Operation Manual (Mainframe).  
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Figure 4.6.1-1  Connection to Instrument Dialog Box 
 

When changing the network setting of the 
MG3700A/MG3710A/MG3710E/MG3740A to DHCP Off and connecting 
the MG3700A/MG3710A/MG3710E/MG3740A and PC using a LAN cross 
cable, restart the MG3700A/MG3710A/MG3710E/MG3740A after 
network setting change before connecting a LAN cross cable.  
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When the communication has been shut down 15 minutes or more while 
connecting to the MG3700A/MG3710A/MG3710E/MG3740A using the 
Transfer & Setting function, the IQproducerTM automatically disconnects 
the FTP port connection. However, if disconnection is processed due to 
the conditions shown above while waveform patterns are transferred, the 
waveform transfer is processed continuously and completed without 
interruption.  

When the Advanced button is clicked, the Advanced screen is displayed 
where the following items can be set.  

 

Figure 4.6.1-2  Advanced Dialog Box 
 

(1) Host name or IP address 

 Enter the host name or IP address of the mainframe to be connected. 

(2) FTP user ID 

 Enter the user name used in FTP login. 

(3) FTP password 

 Enter the password used in FTP login. 

(4) FTP port 

 Enter the port number used by FTP. 

(5) Remote port 

 Enter the port number of the remote used for authentication and 
memory loading.  

(6) Remote wait 

 Set the period between commands. 
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(7) Default 

Restores all the parameter settings to the default values when clicked.  
The default values for each parameter are as follows: 

Table 4.6.1-1  Default Values 

Settings MG3700A MG3710A/MG3710E/MG3740A 
User ID MG3700 ANRITSU 
password password anritsu 
FTP port 21 21 
Remote port 49153 49158 
Remote wait 10 msec 10 msec 

 
(8) OK 

 Finalizes the settings and closes the screen when clicked.  

(9) Cancel 

 Cancels the settings and closes the screen when clicked. 

 

Note: 
Connection with the MG3700A/MG3710A/MG3710E/MG3740A is 
possible when the parameters are set to the default values. Do not 
change the parameters in the Advanced screen unless otherwise 
required.  
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4.6.2 Transfer & Setting Panel screen 

 

Figure 4.6.2-1  Transfer & Setting Screen 
 

The Transfer & Setting Panel main screen consists of menu, tool bar, 
transfer file type selection box, folder selection box, PC-side file display 
area, SG-side file display area, logs, and status bar.  

Right-clicking in the PC-/SG-side file display area opens a pop-up menu.  

■Description of items 
(1) Menu bar 

 Connection/disconnection to the network, termination of Transfer & 
Setting, deletion of files/folders in the PC side, creation of new 
folders, updating of file information, file transfer, and loading to 
memory can be executed. 

(2) Tool bar 

 Equivalent function with (1) Menu above. 
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(3) Selecting folder 

 Select a transfer source/destination folder in the PC. 

(4) PC-side file display area 

 Displays the information of the folders and files in the PC. 

(5) SG-side file display area 

 Displays the information of the folders and files stored in the 
internal hard disk of the MG3700A/MG3710A/MG3710E/MG3740A.  

(6) Transfer file type selection box 

 The type of the file to be transferred via FTP can be selected. 

(7) Status bar 

 Displays the free space and total space of the internal hard disk and 
waveform memories A and B of the current mainframe. Nothing is 
displayed when several mainframe units are selected.  
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4.6.3 Operation from menu and tool bar 
The menu and tool bar on the Transfer & Setting Panel screen contain 
the following items. 

(1) Connection 

 

Figure 4.6.3-1  Connection Tabbed Dialog Box 
 

 <1> Connect 

  Connects with the mainframe. The Connection dialog 
box is displayed when this item is selected. The 
contents of the connected 
MG3700A/MG3710A/MG3710E/MG3740A are 
displayed in the SG-side file display area.  

 <2> Disconnect 

  Disconnects the connection with the 
MG3700A/MG3710A/MG3710E/MG3740A currently 
connected. The Disconnection dialog box is displayed 
when this item is selected.  

 <3> Exit 
  Closes the Transfer & Setting Panel screen. 

(2) Edit 

 

Figure 4.6.3-2  Edit Selection Screen 
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 <1> Delete 
  Deletes a file/folder selected in the PC-side file 

display area or a file selected in the SG-side file 
display area. The Delete dialog box shown in Figure 
4.6.3-3 below is displayed when this item is selected.  

 

Figure 4.6.3-3  Delete Dialog Box 
 

• All Deletes all the selected files. 
• OK Deletes the selected file. The dialog box 

appears for each file for confirmation.  
• Cancel Cancels the deletion of the selected 

combination file and the corresponding 
files.  
 

When a combination file is selected for deletion, the 
Delete dialog box shown in Figure 4.6.3-4 below is 
displayed.  

 

Figure 4.6.3-4  Delete Dialog Box 
 

• Apply to all check box: 
  The deleting operation will apply to all the 

selected combination files when this check 
box is selected.  

• Yes Also deletes the files that are selected by 
the selected combination file.  

• Combination file only 
  Deletes only the selected combination file.  
• Cancel Cancels the deletion of the selected 

combination file and the corresponding 
files.  
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 <2> Rename 

  Change the name of a file/folder in the PC. The name 
change dialog box is displayed when this item is 
selected.  

 <3> Create New Folder 

  Creates a new folder in the folder currently displayed 
in the PC-side file display area. The folder name 
input dialog box is displayed when this item is 
selected.  

 <4> Combination File Edit 
  Opens the Combination File Edit screen. Refer to 

Section 4.8 “Combining Waveform Patterns by 
Combination File Edit Function” for details on this 
function.  

(3) View 

 

Figure 4.6.3-5  View Selection Screen 
 

<1> Refresh 

 Updates the contents currently displayed in the PC-side file 
display area and SG-side file display area to the latest 
information.  

<2> Toolbar 

Toggles tool bar display/non-display. The tool bar is displayed in 
the Transfer & Setting Panel screen when a checkmark ( ) is 
added on the left. 

<3> Status bar 

Toggles status bar display/non-display. The status bar is 
displayed in the Transfer & Setting Panel screen when a 
checkmark ( ) is added on the left. 
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(4) Transfer 

 

Figure 4.6.3-6  Transfer Tabbed Dialog Box 
 

 <1> PC to SG 

  Transfers files such as waveform pattern selected in 
the PC-side file display area to the internal hard disk 
of the MG3700A/MG3710A/MG3710E/MG3740A 
selected in the SG-side file display area. The transfer 
destination folder is determined depending on the file 
type and the package name specified in the waveform 
pattern.  
When multiple folders are selected in the PC-side file 
display area, clicking this button transfers all 
waveform patterns and combination files in the 
selected folders.  
During combination file transfer, all waveform 
patterns in the folder (excluding subfolders) selected 
in the combination file are transferred at the same 
time.  

 <2> SG to PC 

  Transfers files selected in the SG-side file display 
area to the folder selected in the PC-side file display 
area.  

 <3> PC to All SG 

  Transfers files such as waveform pattern selected in 
the PC-side file display area to the internal hard 
disks of all the connected mainframe units in the 
SG-side file display area. The transfer destination 
folder is determined depending on the file type and 
the package name specified in the waveform pattern.  

 <4> Key Install 

  Transfers the license file to install it. When license 
file installation is completed, the license file in the 
internal hard disk of the 
MG3700A/MG3710A/MG3710E/MG3740A is deleted. 
This function is enabled when an authentication file 
(extension: .key) is selected in the PC-side file display 
area after specifying “Waveform Package License 
File” in the transfer file type selection box.  
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(5) SG 

 
Figure 4.6.3-7  SG Selection Screen 

 

 <1> SG1 

  Selects SG1 as the operation target.  
Note: 

This function is available only when 
MG3710A/MG3710E/MG3740A is connected.  

 <2> SG2 

  Selects SG2 as the operation target.  
Note: 

This function is available only when 
MG3710A/MG3710E/MG3740A is connected.  

 <3> Load Pattern to Memory A 

  In the SG-side file display area, loads the selected 
waveform pattern into the waveform memory A of the 
specified SG.  

 <4> Load Pattern to Memory B 

  In the SG-side file display area, loads the selected 
waveform pattern into the wave memory A of the 
specified SG.  

 <5> Remove Pattern from Memory A 

  In the SG-side file display area, removes the selected 
waveform pattern from the wave memory A of the 
specified SG.  

 <6> Remove Pattern from Memory B 

  In the SG-side file display area, removes the selected 
waveform pattern from the wave memory B of the 
specified SG.  

 <7> Pattern Select, Pattern Combination Select 
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  In the SG-side file display area, selects a waveform 
pattern or combination files loaded into the waveform 
memory A or B as an output waveform pattern. A 
combination file can only be selected in the Defined 
mode.  

  The selected waveform pattern or combination file is 
output from the MG3700A/MG3710A/MG3710E/ 
MG3740A when either of the following conditions is 
met:  
• When IQ Source is Int and both RF Output and 

MOD On/Off are On 
→The waveform pattern is output from the RF 
output. 

• When IQ Source is Int and I/Q Output are On 

→The waveform pattern is output from the IQ 
output. 

 <8> Defrag 

  Executes defrag for the waveform memories A and B 
of the selected MG3700A (re-allocation of files in each 
memory). Note, however, that defrag is not operated 
when there is no need to execute defrag or when 
several MG3700A units are selected.  
Note: 

This function is available only when MG3700A is 
connected.  

 

 <9> Edit Mode/Defined Mode 

  Changes the waveform pattern output mode of the 
selected SG. In the Defined Mode, one of the patterns 
or combination files loaded in the waveform memory 
A or B is selected as an output waveform pattern.  
In the Edit Mode, one output waveform pattern is 
selected from each waveform memory, and the 
selected two output waveform patterns are added to 
be output.  

 <10> Load Pattern Combination to Memory 

  Loads the waveform patterns selected in the 
combination file that is selected in the SG-side file 
display area to the waveform memory A or B of the 
MG3700A/MG3710A/MG3710E/MG3740A.  

 <11> Remove Pattern Combination from Memory 

  Removes the waveform patterns selected in the 
combination file that is selected in the SG-side file 
display area from the waveform memory A or B of the 
MG3700A/MG3710A/MG3710E/MG3740A.  
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 <12> Clear Memory 
  Removes all the waveform patterns loaded into the 

selected SG’s waveform memories A and B.  
 
If the waveform pattern having the same name already exists in the 
memory when loading a waveform pattern, the overwrite confirmation 
dialog box is displayed. The meaning of each selection item in this dialog 
box is as follows:  

• Yes  
 The waveform pattern is loaded in the target memory overwriting the 

existing waveform pattern in the memory.  
• No   
 The waveform pattern is not loaded, and the subsequent memory load 

processing is executed as required.   
• Cancel Or   
 The waveform pattern is not loaded, and the subsequent memory load 

processing is cancelled.  
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4.6.4 Selecting folder 
Select a folder to be displayed in the PC-side file display area.  

 

Figure 4.6.4-1  Selecting Folder 
 

This screen contains the folder selection button, folder move button, and 
the current folder pass display/input box from the left.  

(1) Folder selection button 

 When this button is clicked, the folder selection dialog box displayed, 
in which a folder can be selected.  

 
Figure 4.6.4-2  Folder Selection Dialog Box 

 

(2) Folder move button 

 When this button is clicked, the contents of the previous directory 
are displayed. When this button is clicked in the root directory, the 
drives connected to the PC are displayed in a list.  

(3) Current folder path display/input box 

 The path of the currently selected folder is displayed. Also, the 
display path can be changed by entering the folder path from the 
keyboard directly.  
Click the  button on the right to display a pull-down list, where 
up to 9 latest folders are displayed. If the entered folder does not 
exist, an error message appears and the contents of the folder before 
change are restored.  
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4.6.5 Selecting transfer file type 

 

Figure 4.6.5-1  Selecting Transfer File Type 
 

Select the type of the files to be transferred via FTP from the drop-down 
list. 
Can be selected in the drop-down combo box.  

The following file types are listed in the drop-down menu.  

• Waveform Pattern & Combination File 
• Waveform Package License File 
• All File 
When Waveform Pattern File or Waveform Package License File is 
selected, only the corresponding files that can be transferred are 
displayed in the PC-/SG-side file display areas.  
When All File is selected, all the files are displayed.  
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4.6.6 SG-side file display area 
The MG3700A/MG3710A/MG3710E/MG3740A units currently connected 
and the files corresponding to the file type selected in the transfer file 
type selection box are displayed in the SG-side file display area, on the 
right field of the Transfer & Setting Panel main screen.  

 
Figure 4.6.6-1  SG-side File Display Area 

 

The following contents are displayed in the SG-side file display area: 

<1> MG3700A/MG3710A/MG3710E/MG3740A units currently connected 

<2> The host names or IP addresses of the 
MG3700A/MG3710A/MG3710E/MG3740A units currently connected 
are displayed. 

<3> The folders and files stored in the hard disk of each mainframe can 
be displayed by double-clicking the mainframe icon.  
Only the files that have the extension of the specified file type are 
displayed.  

<4> Information specific to each file type 

<5> Right-clicking in the SG-side file display area opens the pop-up 
menu. 
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Details of the contents in the SG-side file display area are described 
below for each transfer file type. 

(1) For waveform pattern and combination file 

(when Waveform Pattern & Combination File is selected for transfer 
file type) 

 

Figure 4.6.6-2  SG-Side File Display Area When Waveform Pattern & 
Combination File Is Selected 

 

* Information of displayed files 

• Name .......... Indicates the file name of the waveform pattern  
Only the information files are indicated.  

• State ........... Displays the waveform pattern or pattern 
combination file loading status to an arbitrary 
waveform memory.  
“A” indicates that the waveform 
pattern/combination file is loaded to the arbitrary 
waveform memory A, and “B” indicates loading to 
the arbitrary waveform memory B. “A/B” indicates 
that the waveform pattern/combination file is loaded 
to both the arbitrary waveform memories A and B. 
“Mem loaded” indicates that the waveform 
pattern/combination file is loaded to the waveform 
memory A or B, and “Selected” indicates that it is 
selected for output.  

• Size ............. Displays the total size of the waveform information 
file and waveform data file in bytes.  

• Element ...... Displays the number of waveform patterns selected 
in the combination file stored on the hard disk.  
For example, when four of the five waveform 
patterns used in a combination file are stored in the 
hard disk, “4/5” is displayed.  
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• Date ............ Displays the latest file creation date between the 
waveform information file and waveform data file of 
the waveform pattern. For a combination file, its file 
creation date is displayed (no comparison is made).  

When a waveform pattern is loaded to both the waveform memories 
A and B and that waveform pattern is selected as an output 
waveform pattern, it is output according to the waveform pattern 
output mode as follows:  

• Defined Mode: The waveform pattern is output from the  
  memory B. 

• Edit Mode: The waveform pattern is output from both the 
  memories A and B.  

 (2) For license file transfer 

(when Waveform Package License File is selected for transfer file 
type) 

 

 
Figure 4.6.6-3  SG-Side File Display Area When Waveform Package 

License File Is Selected 
 

* Information of displayed files 

• Name .......... Displays the names of licenses installed in the 
MG3700A/MG3710A/MG3710E/MG3740A. 

• Version ........ Displays the versions of licenses installed in the 
MG3700A/MG3710A/MG3710E/MG3740A.  

(3) For other file transfer types 

(when All File is selected for transfer file type) 

When the MG3700A is connected.  
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Figure 4.6.6-4   SG-side File Display Area View When MG3700A All File 

is selected <1> 
 

The following files are stored in each folder: 

• ALARMLOG ................... Alarm indication log file 

• APM ................................ Saved parameter file 

• APP_LICENSE .............. Not used 

• APPLICATION .............. Not used 

• BERTLOG ...................... BERT log file 

• CHANNEL ..................... Channel table file 

• COMPLEMENT ............. Correction value 

• FIRMWARE ................... MG3700A/MG3710A/MG3710E/ 
MG3740A firmware file 

• IPL .................................. MG3700A/MG3710A/MG3710E/ 
MG3740A IPL (Initial Program Loader) 
file 

• PACKAGE ...................... Waveform pattern 

• REALTIME .................... Not used 

• RT_LICENSE ................ Not used 

• SCENARIO .................... Scenario file 

• SCREEN_IMAGE .......... Bitmap image file of screen copy 

• SGLOG ........................... MG3700A/MG3710A/MG3710E/ 
MG3740A log file 

• WAVE_LICENSE ........... Waveform pattern license file 
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When the MG3710A/MG3710E/MG3740A A is connected.  
The following files are stored in each folder: 

 

 

Figure 4.6.6-5  SG-side File Display Area View When 
MG3710A/MG3710E/MG3740A All File Is Selected <1> 

 

• Alarm History ................ Alarm indication log file 

• BERT BitPattern ........... User defined pattern of BERT 

• BERT Log ....................... BERT log file 

• ChannelTable ................. Channel table file 

• Copy Files ....................... Image file of screen copy 

• Corrections ..................... Correction file 

• ListTable ........................ List Table file 

• Parameter Setting ......... Saved parameter file 

• Waveform ....................... Waveform pattern 
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* Information of displayed files 

 

Figure 4.6.6-6  SG-side File Display Area View When 
MG3710A/MG3710E/MG3740A All File Is Selected <2> 

 

• Name .......... Displays the file names. 

• Size ............. Displays the file sizes. 

• Date ............ Displays the file creation dates. 

 

4.6.7 Selection in SG-side file display area 
Each file in the SG-side file display area can be selected by a click. Two 
or more files can be selected by Ctrl  + click (additional selection) and 

Shift  + click (range selection).  

When downloading files to the MG3700A/MG3710A/MG3710E/MG3740A, 
select a file in the PC-side file display area and select an 
MG3700A/MG3710A/MG3710E/MG3740A unit as the transfer 
destination in the SG-side file display area. 

File uploading to the PC is possible when an 
MG3700A/MG3710A/MG3710E/ 
MG3740A unit or a file in it is selected.  
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4.6.8 PC-side file display area 
The contents of the folder currently selected are listed in the PC-side file 
display area, on the left field of the Transfer & Setting Panel main 
screen. 

The files and their information are displayed corresponding to the file 
type selected in the transfer file type selection box.  

The contents in the PC-side file display area are displayed as follows:  

 

Figure 4.6.8-1  PC-side File Display Area 
 

• Only the files that have the extension of the specified file type are 
displayed.  

• The information according to each transfer file type is displayed in 
the list column units.  

• A folder is displayed with its name and created date, and <dir> is 
displayed for the Size column. The other columns are left blank.  

• Right-clicking in the SG-side file display area opens the pop-up 
menu. 

• If incomplete transfer is made with the file (such as waveform 
pattern) that consists of several files without having the data file set 
as an information file, that file is not displayed. When “All File” is 
selected in the transfer file type selection box, however, all the files 
are displayed.  
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Details of the contents in the PC-side file display area are described 
below for each transfer file type.  

(1) For waveform pattern 

 (when Waveform Pattern & Combination File is selected for transfer 
file type) 

 

Figure 4.6.8-2  PC-Side File Display Area When Waveform Pattern & Combination 
File Is Selected 

 

* Information of displayed files 

• Name .......... Indicates the file name of the waveform. Only the 
information files are indicated.  

• Package ...... Displays the names of the packages described in the 
information files.  

• Version ........ Displays the versions of waveform patterns.  

• License........The “O” sign is indicated on the waveform pattern 
of which license is installed in the mainframe 
selected in the SG-side file display area. A waveform 
pattern for which “O” is not displayed cannot be 
used even if it is transferred to the mainframe.  

• Size ............. Displays the total size of the information file and 
files specified by the information file.  

• Date ............ Displays the latest file creation date between the 
waveform information file and waveform data file of 
the waveform pattern. Transfer date/time to the 
MG3700A/MG3710A/MG3710E/MG3740A is used as 
file creation date.  
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(2) For license file transfer 

 (when Waveform Package License File is selected for transfer file 
type) 

 

Figure 4.6.8-3  PC-Side File Display Area When Waveform Package 
License File Is Selected 

 

* Information of displayed files 

• Name .............................. Displays the file names. 

• Package/License Name .. Displays the license names of the files. 
For waveform pattern authentication 
files, the package names are displayed 
and the column character strings are 
changed.  

• Version ............................ Displays the versions of licenses.  

• SG ................................... Indicates the name of the mainframe for 
which the license is authenticated. 
Indicates the IP address or host name 
used when the mainframe is connected.  

• Size ................................. Displays the license file sizes.  

• Date ................................ Displays the file creation dates. 
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(3) For other file transfer types 

 

Figure 4.6.8-4  PC-side File Display Area View When All File Is 
Selected 

 

* Information of displayed files 

• Name .......... Displays the file names. 

• Size ............. Displays the file sizes. 

• Date ............ Displays the file creation dates. 

4.6.9 Selection in PC-side file display area 
Each file in the PC-side file display area can be selected by a click. Two 
or more files can be selected by Ctrl  + click (additional selection) and 

Shift  + click (range selection).  

Files that can be downloaded are those actually selected in the PC-side 
file display area only. The MG3700A/MG3710A/MG3710E/MG3740A 
specified as the transfer destination must be selected at this time.  

4.6.10 Status display 
 

Figure 4.6.10-1  Status Display 
 

The status bar displays the following information of the 
MG3700A/MG3710A/MG3710E/MG3740A currently selected:  

• Free space and total space of the internal hard disk 
• Free space and total space of the waveform memories A and B 
Note, however, that nothing is displayed when several mainframe units 
are selected.  

Indicates the information of the target SG to be controlled when 
MG3710A/MG3710E/MG3740A is connected 
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4.6.11 Disconnection screen 

 
Figure 4.6.11-1  Disconnection Dialog Box 

 

■Description of items 
(1) IP address/host name selection box 

 The IP addresses and host names of the 
MG3700A/MG3710A/MG3710E/MG3740A units currently connected 
are displayed in the pull-down list. Select the 
MG3700A/MG3710A/MG3710E/MG3740A unit to be disconnected 
from this list.  

(2) Disconnect button 

 Click this button to disconnect the selected 
MG3700A/MG3710A/MG3710E/MG3740A. The Disconnection screen 
remains displayed even after disconnection.  

(3) Close button 

 Click this button to close the Disconnection screen.  
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4.6.12 Rename screen (for changing file name) 

 

Figure 4.6.12-1  Rename Dialog Box 
 

■Description of items 
(1) File name display/input text box 

 Displays the file name to be renamed. Enter a new file name.  

(2) OK button 

 Click this button to finalize the entered file name. When the entered 
file name contains an illegal character (restricted for file name by 
Windows), an error message is displayed. After the error message is 
closed, the new file name input edit is selected, prompting to retry.  

(3) Cancel button 

 Click this button to cancel renaming and close the Rename screen.  
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4.6.13 Create new folder screen (for inputting folder name) 

 

Figure 4.6.13-1  Create New Folder Dialog Box 
 

■Description of items 
(1) Folder name input text box 

 Enter the name of the folder to be created. 

(2) OK button 

 Click this button to finalize the entered folder name. When the 
entered folder name contains an illegal character (restricted for 
folder name by Windows), an error message is displayed. After the 
error message is closed, the new folder name input edit is selected, 
prompting to retry.  

(3) Cancel button 

 Click this button to cancel folder creation and close the screen.  
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4.7 File Transfer and Loading to Memory Using 
Transfer & Setting Wizard 

4.7.1 Activation 
Select Transfer & Setting Wizard from the Simulation & Utility tab on 
the common platform screen.  
The wizard dialog box is displayed in the newly opened window.  

4.7.2 Transfer & Setting Wizard (Step 1/2) (Connection screen) 

 
Figure 4.7.2-1  Connection Screen 
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The screen shown in Figure 4.7.2-1 below is displayed when the Transfer 
& Setting Wizard is activated.  

■Description of items 
(1) Target instrument button 

 Selects the target instrument to be connected from MG3700 or 
MG3710/40. 

(2) Connection destination input box 

 Enter the host name or IP address of the 
MG3700A/MG3710A/MG3710E/MG3740A to be connected (connection 
destination). When it is entered, the user ID, password, and port 
number necessary for connection are set with the default values. Up to 
30 host names/IP addresses lately entered or updated are recorded and 
listed in the pull-down menu for selection. The host name/IP address of 
the MG3700A/MG3710A/MG3710E/MG3740A updated or connected 
lately is listed to the top of the pull-down menu. When a host name/IP 
address is selected from the pull-down list, connection is made in the 
network at that time.  

(3) Advanced button 

 Click this button to display the Advanced screen.  

(4) <Back button 

 This button is used to return to the previous screen. This button is 
disabled in this screen. 

(5) Next> button 

 Click this button to start connection. When the connection is completed 
normally, the package selection screen is displayed. When the 
connection is failed, an error message is displayed and the screen 
remains displayed. If the MG3700A firmware version is 1.xx, the 
warning message “The MG3700A firmware version is 1.xx. Your version 
of IQproducer cannot connect with the version 1.xx of MG3700A 
normally. Please check Anritsu Download Support Site to upgrade 
MG3700A firmware.” will be displayed. In this event, this software 
cannot be connected normally to the MG3700A. Upgrade the MG3700A 
firmware before starting connection (the latest firmware can be 
obtained from the download page linked to the MG3700A page on the 
Anritsu Web site).  

(6) Cancel button 

 Click this button to cancel the wizard and closes the screen. 
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■Description of items on Advanced screen 
Clicking the Advanced button displays the Advanced screen, in which the 
connection destination can be set in detail.  

 

Figure 4.7.2-2  Advanced Dialog Box 
 

(1) Host name or IP address 

 Enter the host name or IP address of the mainframe to be connected  

(2) FTP user ID 

 Enter the user name used in FTP login. 

(3) FTP password 

 Enter the password used in FTP login. 

(4) FTP port 

 Enter the port number used by FTP. 

(5) Remote port 

 Enter the port number of the remote used for authentication and 
memory loading.  

(6) Remote wait 

 Set the period between commands. 

(7) Default 

 Restores all the parameter settings to the default values when 
clicked.  
The default values for each parameter are as follows: 
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Table 4.7.2-1  Default Values 

Settings MG3700A MG3710A/MG3710E/MG3740A 
User ID MG3700 ANRITSU 
Password password anritsu 
FTP port 21 21 
Remote port 49153 49158 
Remote wait 10 msec 10 msec 

 

(8) OK 

 Finalizes the settings and closes the screen when clicked.  

(9) Cancel 

 Cancels the settings and closes the screen when clicked. 

 
Note: 

Connection with the MG3700A/MG3710A/MG3710E/MG3740A is 
possible when the parameters are set to the default values. Do not 
change the parameters in the Advanced screen unless otherwise 
required.  
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4.7.3 Transfer & Setting Wizard (Step 2/2)  
(File selection&transfer screen) 

When the Next> button on the Package selection screen is clicked, the 
screen shown in Figure 4.7.3-1 below is displayed.  

 
Figure 4.7.3-1  File Selection & Transfer Screen 

 

■Description of items 
(1) Browse button for specifying reference folder 

 Click this button to open a dialog box used for selecting the path of a 
reference folder. When the Transfer & Setting Wizard is activated, 
the folder in which the last waveform pattern was generated by an 
IQproducer waveform generation application is selected as the 
default reference folder. 

(2) File list for selection 

 A list of waveform patterns and combination files that can be 
transferred is displayed. The displayed waveform patterns are 
stored in the data folder of the waveform generation application 
corresponding to the package selected in the Package selection 
screen.  

 The name, package, version, license, size, and created date of each 
file are displayed in the list. Click a file to select it. Since multiple 
selection is not supported, file transfer is operated for each file.  
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(3) Selects SG only when MG3710A/MG3710E/MG3740 is connected  

 Selects the SG to which the waveform pattern is loaded or selected 
SG2 will be indicated only when the 2nd SG is installed on 
MG3710A/MG3710E/MG3740A.  

(4) Memory Load indication 

 Sets whether to load the transferred waveform pattern to the 
memory in the MG3700A/MG3710A/MG3710E/MG3740A. To load 
the waveform pattern to the memory at the same time with the 
transfer to the internal hard disk of the target MG3700A, check the 
Load Memory check box to leave a checkmark ( ), and then select 
the transfer destination from waveform memory A or B by clicking 
the corresponding radio button.  

 When a waveform pattern that is not supported by the license is 
selected, this function is disabled.  

(5) Pattern Select indication 

 When the transferred waveform pattern is set to be loaded to the 
memory, check this check box to select that file as an output 
waveform pattern.  
The selected waveform pattern is output from the 
MG3700A/MG3710A/MG3710E/MG3740A when either of the 
following condition is met:  

• The waveform pattern is output from RF output when IQ Source 
is set to Int and both RF Output and MOD On/Off are set to On. 

• The waveform pattern is output from IQ output when IQ Source 
is set to Int and I/Q Output is set to On. 

(6) <Back button 

 Click this button to return to the previous screen (Package selection 
screen). 

(7) Transfer button 

 Click this button to transfer the selected waveform pattern to the 
internal hard disk of the MG3700A/MG3710A/MG3710E/MG3740A.  
If the file to be transferred is not supported by the license of the 
MG3700A, the message “At least, “SG1” doesn’t have a license of 
“MG3700A_No1”. Please use after having installed the key file on 
“SG1”.” is displayed.  

* SG1 indicates the host name or IP address of the transfer 
destination mainframe and MG3700A_No1 indicates the name 
of the file to be transferred.  

(8) Close button 

 Click this button to cancel the wizard and closes the screen. 
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4.8 Combining Waveform Patterns by Combination File 
Edit Function 

Select waveform patterns stored on the PC or the hard disk inside the 
MG3700A/MG3710A/MG3710E/MG3740A to set the waveform pattern 
combination to be loaded to the two arbitrary waveform memories.  
Moreover, a sequence operation can be set by setting repeat count, and so 
on, for each of up to 200 waveform patterns loaded to memory A.  
A combination file (.wvc) that defines the pattern combination created by 
this function enables waveform pattern transfer or pattern combination 
selection just by selecting a pattern.  
 

4.8.1 Activation 
Select Combination File Edit from the Edit menu on the Transfer & 
Setting Panel screen.  

 

Figure 4.8.1-1  Screen When Combination File Edit Is Selected 
 

The Combination File Edit screen is displayed separately.  
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4.8.2 Combination File Edit screen 

 

Figure 4.8.2-1  Combination File Edit Screen 
 

■Description of items 
(1) Source 

Displays whether the selected pattern belongs to the PC or SG.   

(2) Package/Pattern Name 

 Up to 200 waveform patterns to be used in memory A are selected.  
Note that a waveform pattern whose size exceeds the capacity of 
memory A cannot be selected.  
The following two waveform pattern selection methods are available:  

• Double-click a wvi file on the PC- or SG-side in the Transfer & 
Setting Panel screen. 

• Right-click on the selected element to open the pop-up menu. 
Select “Open wvi File” to select a file.  However, wvi files on the 
SG-side cannot be selected.  
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(3) Level [dB] 

When Add Pattern is not selected: 

Set the relative level ratio of each element to the set RF level value 
of the MG3700A/MG3710A/MG3710E/MG3740A in dB units. For 
example, when a combination file including an element for which 
the level is set to –3 dB is selected, while the RF output power of 
the MG3700A/MG3710A/MG3710E/MG3740A is set to 0 dBm, then 
the RF output power of the 
MG3700A/MG3710A/MG3710E/MG3740A when outputting the 
element becomes –3 dBm. The setting range is from –80 to 0 dB, 
with a resolution of 0.01 dB.  
 
When Add Pattern is selected: 

Set the level ratio for Add Pattern. The total power, of the Add 
Pattern and the Element with the maximum level ratio set, is the 
RF output power of the MG3700A/MG3710A/MG3710E/MG3740A. 
For example, if a combination file is selected when the RF output 
power of the MG3700A/MG3710A/MG3710E/MG3740A is set to 0 
dBm, and the maximum set level ratio among the elements in the 
combination file is +3 dB, then the total output power when 
outputting this element becomes 0 dBm (Element power/Add 
Pattern power = +3 dB)Although the setting range when Add 
Pattern is selected is from –80 dB to +80 dB, the set values for all 
elements must be within 80 dB. The setting resolution is 0.01 dB.  
When AWGN is selected for Add Pattern, set the level by a power 
ratio within the system bandwidth that is determined depending 
on the communication system. In this event, it is required to set 
necessary parameters such as the AWGN sampling rate for the 
desired signal used by the element, in order to obtain correct 
outputs. Refer to Section 4.9 “Generating AWGN Waveform 
Pattern” for details.  

(4) Repeat Count 

Set the repetition count for each waveform pattern. The setting 
range is from 0 to 65535. When 0 is input, this sets infinity. When 
infinity is set, the same waveform pattern is repeatedly output until 
any screen/remote operation is performed or Pattern Trigger is 
input.  

(5) Add Pattern (memory B pattern) selection 
Select the waveform pattern to be used in memory B.  
Note that a waveform pattern whose size exceeds the capacity of 
memory B cannot be selected.  
The waveform pattern selection method is the same as that shown in 
“(2) Pattern” above.  
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Note:  
 The baseband signal synthesizer option is required to use Add 

Pattern.  

(6) Frequency Offset 

Set the output frequency offset for the waveform pattern selected as 
an element.  
The setting range is as follows:  

Fs: Sampling Rate 

BW: The maximum modulation bandwidth of the selected element 
(defined in the wvi file of each pattern.)  

n: The maximum integer within the range such that Fs*2n does 
not exceed 160 MHz. 

When Fs ≤ 20 MHz: 

                               (0.8*Fs*2n－BW) 
The maximum frequency offset ＝ 
        2  

 When Fs > 20 MHz: 

  (0.8*Fs－BW) 
The maximum frequency offset＝ 
       2  

(7) Timing Offset 

Set the differential delay from the top of the Element1 pattern to the 
start of the Add pattern output. The setting unit is one waveform 
pattern sample.  
Setting range: 0 to “Element1 sample count – 1”  

(8) Package 

Set the package name to be stored during transfer to the 
MG3700A/MG3710A/MG3710E/MG3740A.  

(9) Sequence Repeat Mode 

When the waveform pattern of the last element registered in the list 
is output for the number of times set in Repeat Count, the sequence 
processing returns to the waveform pattern of the first element and 
is executed repeatedly. End of Sequence (signal with RF output OFF) 
is automatically added to the last element registered in the list. 
When the waveform pattern of the last element is output for the 
number of times set in Repeat Count, an End of Sequence (signal 
with RF output OFF) waveform pattern is selected, and the 
sequence processing ends without outputting any RF signals. Up to 
199 elements can be set, excluding End of Sequence.  
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(10) Comment 

Input comments that are displayed when selecting the combination 
file on the MG3700A/MG3710A/MG3710E/MG3740A. The input 
range is up to 7 lines × 82 rows.  

(11) Open File 

Open an existing combination file. Editing of a combination file 
opened by this function is possible, including the replacement of a 
waveform pattern of an element, and so on. Note that, for the 
waveform pattern selected when a combination file is opened by this 
function, the store destination folder name at transfer to the 
MG3700A/MG3710A/MG3710E/MG3740A is displayed in 
“Source/Package” on the Combination File Edit screen because its 
store source is unknown.  

(12) OK 

Start combination file creation. 

(13) Exit 

Cancels the settings and closes the Combination File Edit screen.  
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4.8.3 Waveform pattern operation 
Details on waveform pattern operations in the Combination File Edit 
screen are explained below.  

<Waveform pattern selection - 1> 
1. Select an element for which a waveform pattern is to be selected. 

Elements after the last line where Pattern is selected cannot be 
selected. Multiple elements can be selected while pressing the Shift 
key.  

2. Double-click the wvi file at the PC- or SG-side on the Transfer & 
Setting Panel screen. When multiple elements were selected in Step 
1, the same waveform pattern is selected for each of the selected 
elements.  
When selecting a wvi file at the SG-side, connect the 
MG3700A/MG3710A/MG3710E/MG3740A on which the waveform 
pattern to be selected is stored to the PC in advance, on the Transfer 
& Setting Panel screen. 

3. After selecting the waveform pattern, the element selected on the 
Combination File Edit screen moves to the next line.  

<Waveform pattern selection - 2> 
1. Select an element for which a waveform pattern is to be selected.  

2. Select Open wvi File from the menu opened by right-clicking on the 
element. Waveform files stored on the 
MG3700A/MG3710A/MG3710E/MG3740A cannot be selected by 
using this method.  

3. Select the wvi file of the pattern to be used.  

 

Figure 4.8.3-1  Selecting Open wvi File 
 

<Element deletion> 
1. Select an element to be deleted. 

2. Select Delete Element from the menu opened by right-clicking on 
the element.  
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Figure 4.8.3-2  Selecting Delete Element 

<Element addition> 
1. Select the Element line above the line to which an element is to be 

added.  

2. Select Add Element from the menu opened by right-clicking on the 
element.  

 

Figure 4.8.3-3  Selecting Add Element 
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4.8.4 Restriction on waveform pattern selection 
Waveform patterns that can be selected within one combination file are 
restricted by their parameters (defined in the wvi file for each waveform 
pattern).  
Details on the restriction are as follows: 

<When all elements including Add have the same parameters> 
• Sampling Rate (reading rate of each waveform pattern from the 

memory) 
• Spectrum (relationship between I/Q signal and RF output phase) 
<When all elements except Add have the same parameters> 
• RMS value of waveform data 
• Frame Length (Determined by the number of samples per frame of 

each waveform pattern, the communication system used, the over 
sample ratio of the waveform pattern, or the set value for Convert for 
a waveform pattern created by the customer.)  

• Gap Length (Determined by the number of samples in the off period of 
the burst wave, or the set value for Convert for a waveform pattern 
created by the customer.) 

<Restriction on the parameters in the wvi file when two or more waveform 
patterns are selected for element> 
• An even number must be set for Frame Length and Gap Length. 
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4.8.5 Executing combination file creation 
When combination file creation is started by clicking the OK button on 
the Combination File Edit screen, the Export File screen appears.  
On this screen, set the file output path and input the filename.  

 

Figure 4.8.5-1  Export File Dialog Box 
 

When the OK button is clicked after applying settings on the Export File 
screen, the following screen appears if a folder with the Package name 
set on the Combination File Edit screen is not found. Clicking the Yes 
button creates the folder automatically.  

 

Figure 4.8.5-2  Folder Creation Requesting Dialog Box 
 

The screen shown below appears before file creation starts. Click the Yes 
button to copy all waveform pattern files selected in the combination file 
stored on the PC-side to the combination file output destination folder. 
This operation enables batch transfer of the related waveform patterns 
when transferring the pattern combination file to the 
MG3700A/MG3710A/MG3710E/MG3740A hard disk.  
For this operation, adequate free space for copying the waveform 
patterns is required on the drive where the combination file output 
destination folder exists.  

 

Figure 4.8.5-3  File Copy Confirming Dialog Box 
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4.8.6 Example of combination file creation 
An example of combination file creation on the Combination File Edit 
screen is provided below.  

 

Figure 4.8.6-1  An Example of Combination File Creation 
 

<1> Select a PC- or SG-side waveform pattern. In the above example, all 
selected waveform patterns are on the SG-side.  

<2> Set the level for each element. Since Add Pattern is selected in the 
above example, the output power of the 
MG3700A/MG3710A/MG3710E/MG3740A thus becomes equal to the 
output power value set at the time of combination file selection when 
Element1 is output, and the power ratio between Element1 and Add 
Pattern becomes 0 dB.  

<3> Set Repeat Count for each pattern. In this combination file, output is 
performed as follows:  
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<4> The setting range of the frequency offset is determined by the 
waveform pattern sampling rate and bandwidth settings.  

Element 1 
× ∞ 

Element 1 
× ∞ 

Pattern Trigger or 
Next Pattern 

 

･･･ 
Element 2 
× 1 time 

Element 3 
× 2 times 

Element 4 
× 3 times 

Element 5 
× 4 times 

Element 6 
× 5 times 

Element 7 
× 6 times 
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4.9 Generating AWGN Waveform Pattern 
Generate the AWGN (Additive White Gaussian Noise) required for the 
dynamic range test. The AWGN waveform pattern file suitable for each 
communication system is generated by setting the bandwidth of the 
target wave to be added and the AWGN bandwidth magnification for the 
wave. A waveform pattern file consists of the waveform information file 
(a text file with the extension “wvi”) that includes waveform pattern 
information and the waveform data file (a binary file with the extension 
“wvd”).  

Note:  
The AWGN waveform pattern generation function is not available 
when MG3740A is clicked in the Select Instrument window or the 
IQproducer™ is started on MG3740A. 

 

4.9.1 AWGN Generator setting screen 
Select AWGN in the File Gen. menu. The screen shown in Figure 4.9.1-1 
appears to perform settings for each parameter.  

 
Figure 4.9.1-1  AWGN Generator Setting Screen 
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■Description of items 
(1) Coupled Pattern File 

 Check this box to generate the waveform using information such as 
the target wave bandwidth.  

(2) Browse button 

 Select the wvi file of the target wave.  

(3) Wanted Signal BW (A) 

 Set the bandwidth (MHz) of the target wave.  

 Setting range: 0.001000 to 120.000000 MHz 

(4) AWGN BW (B) / Wanted Signal BW (A) 

 Select the magnification of the AWGN bandwidth for the target 
wave.  

 Setting range: 1.0, 1.5, 2.0 or 2.5 

(5) Sampling Rate 

 Set the sampling rate (MHz). Set the same sampling rate as that for 
the target wave, since the value is common to the target wave and 
AWGN.  

 Setting range: 0.020000000 to 160.000000000 MHz 

(6) AWGN BW (B) 

 The AWGN bandwidth (MHz) is calculated using the values for (3) 
and (4). This item cannot be set by entering a value directly. In 
addition, the following restrictions apply.  

 Restricted range:  

When 0.020000000 ≤ Sampling Rate ≤ 20.000000000 MHz 

   0.001000 ≤AWGN BW (B) ≤ Sampling Rate/2 

 When Sampling Rate > 20.000000000 MHz: 

   0.001000 ≤ AWGN BW (B) ≤ Sampling Rate/2 

(7) Package 

 Enter the name of the package that is to be used to store the 
generated AWGN waveform pattern files. Up to 31 characters can be 
used for a package name. Alphanumeric characters and the 
following symbols may be used: 
! % & ( ) + = ` { } _- ^ @ [ ] 

(8) Comment1 to Comment3 

 The comment entered here is displayed on the 
MG3700A/MG3710A/MG3710E screen. Up to 38 characters can be 
used for a package name. This can be left blank.  
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(9) OK 

 Click this button to finish applying the settings. If the restrictions 
described in (6) are not fulfilled, an error display appears and the 
settings cannot be completed.  

(10) Cancel 

 Click this button to cancel the settings and close the setting screen.  

 

4.9.2 Setting method 
Two setting methods are available: selecting the wvi file of the target 
wave, or setting all parameters.  

■Selecting wvi file 
<Procedure> 
1. Click the  button to select the wvi file of the waveform 

pattern that is to be used as the target waveform.  

2. The Coupled Pattern File check box is checked, and the full path of 
the selected wvi file is displayed in the Coupled Pattern File text box. 
The bandwidth and sampling rate of the target wave to be used are 
loaded into the Wanted Signal BW (A) and Sampling Rate text boxes. 
In the Package text box, the package name, in which the waveform 
pattern file of the target wave is stored, is loaded.  

3. Set values in the AWGN BW (B) / Wanted Signal BW (A), Package 
and Comment1 to Comment3 text boxes.  

4. Click the OK button to finish applying the settings.  

 
■Setting all parameters 
<Procedure> 
1. Click the Coupled Pattern File check box to uncheck it.  

2. Set each parameter. 

3. Click the OK button to finish applying the settings.  
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4.9.3 Generating waveform pattern 
When the OK button is clicked on the setting screen to finish applying 
the parameter settings, the Export File screen shown in Figure 4.9.3-1 
appears. Set the output destination and name of the waveform pattern 
file, and then execute waveform pattern generation.  

 

Figure 4.9.3-1  Export File Dialog Box 
 

■Description of items 
(1) Export Path 

 Set the AWGN waveform pattern file output destination. 
Table 4.9.3-1  Waveform Pattern Output Destination 

Host equipment of 
this software Output destination 

MG3710 C:\Anritsu\MG3710A\User 
Data\Waveform\”Package name” 
An output destination file other than the above can be 
assigned.  

Hosted by PC in the 
MG3710 mode 

Corresponding to the Export Path setting on the 
Export File dialog box  

Other than the 
above 

Corresponding to the Export Path setting on the 
Export File dialog box  

 
(2) Browse button 

 Click this button to select the AWGN waveform pattern file output 
destination.  

(3) Export File Name 

 Enter the name of the AWGN waveform pattern file to be generated 
(common to wvi and wvd files). Up to 20 characters can be used for a 
package name. Alphanumeric characters and the following symbols 
may be used: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
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(4) OK 

 Click this button to start waveform pattern generation.  

(5) Cancel 

 Click this button to close the Export File screen and return to the 
setting screen.  

<Procedure> 
1. Set the AWGN waveform pattern file output destination. Click the 

 button to select the output destination.  

2. The output destination of the AWGN waveform pattern file is 
displayed in the Export Path.  

3. Set the AWGN waveform pattern file name in the Export File Name 
text box.  

4. Click the OK button to start waveform pattern generation. Click the 
Cancel button to return to the setting screen.  

5. When waveform pattern generation starts, the waveform generation 
execution screen shown in Figure 4.9.3-2 appears. When the Cancel 
button at the bottom of the screen is clicked, waveform generation 
stops and the setting screen are displayed again. After the 
completion of waveform creation (“Calculation Completed” message 
is indicated), click the OK button to close the AWGN Generator 
Setting Screen to display the setting screen.  

6. The AWGN waveform pattern file is generated in the destination 
displayed in the Export Path text box, with the file name (common 
to wvi and wvd files) shown in the Export File Name text box.  

 

Figure 4.9.3-2  Waveform Generation Dialog Box 
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4.9.4 AWGN waveform pattern – simulation results 
The spectrum of the AWGN waveform pattern generated with the 
following settings and CCDF simulation results are as follows. 
Wanted Signal BW (A): 1.23 MHz, AWGN BW (B) / Wanted Signal BW 
(A): 1.5 

 
Figure 4.9.4-1  Spectrum 

 

 
Figure 4.9.4-2  CCDF 
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4.10 W-CDMA Downlink Waveform Pattern Generation 
Function 

This function enables the generation of a waveform pattern to be used in 
cases such a W-CDMA reception sensitivity test, by changing some 
W-CDMA-related parameters of the MX370101A HSDPA IQproducer.  
It is possible to change the scrambling code number and channelization 
code number for a waveform pattern that is provided as a standard 
waveform pattern.  

Note:  
The W-CDMA Downlink waveform pattern generation function is 
not available when MG3740A is clicked in the Select Instrument 
window or the IQproducer™ is started on MG3740A. 

4.10.1 Activation 
Select W-CDMA Downlink (Standard) from the System (Cellular) tab on 
the common platform screen.  

The W-CDMA Downlink setting screen is displayed separately.  

4.10.2 W-CDMA Downlink setting screen 

 
Figure 4.10.2-1  W-CDMA Downlink Setting Screen 
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■The File menu contains the following items. 
 

 
Figure 4.10.2-2  File Selection Screen 

 

• Select Option 

 When this software is activated in the MG3700 mode; 

 Select whether to enable/disable the ARB memory expansion option 
512Msamples for the MG3700A. When With Option21 is selected, 
the maximum size of the waveform pattern that can be generated is 
expanded. But if the ARB memory expansion option 512Msamples is 
not installed in this event, the generated waveform pattern may not 
be able to be used. Select either With Option21 or Without Option21 
according to whether the ARB memory expansion option 512M 
samples is installed in the MG3700A to be used or not.  

 With Option21 (Memory 512Msamples): 1 GB × 2 memories 
Without Option21 (Memory 512Msamples): 512 MB × 2 memories 

 When this software is activated in the MG3710 mode; 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the Select Option according to the combination of the installed 
options on the MG3710A/MG3710E.  



 

Chapter 4  Operations for Each Function 

4-124 

Table 4.10.2-1  Available Options for MG3710A/MG3710E 

Select Option setting 
Maximum Size 
of Waveform 

Patterns 

Options implemented on 
the MG3710A/MG3710E 

1st SG 2nd SG 

Memory 64M samples 64Msample None None 

Memory 64M samples × 2 
(With Option 48, 78) 

128Msample 048/148 078/178 

Memory 256M samples 256Msample 045/145 075/175 

Memory 256M samples × 2 
(With Option 48, 78) 

512Msample 045/145 
048/148 

075/175 
078/178 

Memory 1024M samples 512Msample 046/146 076/176 

Memory 1024M samples × 
2 (With Option 48, 78) 

512Msample 046/146 
048/148 

076/176 
078/178 

 
• Recall Parameter File 

 Sets the W-CDMA Downlink parameters according to the setting of 
the parameter files saved by Save Parameter File.  
 

• Save Parameter File 

 Saves the W-CDMA Downlink setting parameters to a file. 
 

• Exit 

 Exits the W-CDMA Downlink IQproducer. 
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■The Edit menu contains the following items.  
 

 

Figure 4.10.2-3  Edit Selection Screen 
 

• Channel Edit 

 Displays the Channel Edit screen in which the P-CCPCH and DPCH 
parameters are set. This is the same operation with clicking the 
Channel Edit button on the screen.  

 

• Calculate Waveform Pattern 

 Starts waveform pattern generation based on the settings on the 
screen.  
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly. The number 
of frames to be generated is displayed on the calculation progress 
screen.  
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX370101A HSDPA IQproducer Operation Manual for details on 
the number of frames to be generated in accordance with the 
downlink setting conditions.  
 
The configuration of the waveform pattern to be generated also 
varies; whether the waveform pattern uses only one memory or 
whether it uses two memories.  
When a normal waveform pattern is generated, two files with the 
extensions “.wvi” and “.wvd” are created. When transferring a 
waveform pattern or loading a waveform pattern to a memory, select 
the *.wvi file for the target waveform pattern.  
When a waveform pattern that uses the FIR filter of the mainframe 
is created, a file with the extension “.wvc” is created in addition to 
the *.wvi and *.wvd files. When transferring a waveform pattern or 
loading a waveform pattern to a memory, select the *.wvc file for the 
target waveform pattern. The settings for two memories are 
executed at once by this operation.  
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX370101A HSDPA IQproducer Operation Manual for details about 
the classification of waveform patterns.  
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• Calculation & Load (Effective only when this software is hosted by 
the MG3710A/MG3710E) 

 Creates the waveform to load it into the memory  

 

• Calculation & Play (Effective only when this software is hosted by 
the MG3710A/MG3710E) 

 Creates the waveform, load it into the memory and select it.  

 
 

■The Easy Setup menu contains the following item. 
 

 
Figure 4.10.2-4  W-CDMA Dialog IN Easy Setup Tabbed Box 

 

 Selects the bit rate setting for Reference Measurement Channels 
(RMC) specified in 3GPP TS25.101, TS25.104.  
 
RMC 12.2kbps (for RX test) 

 RMC 12.2kbps (for Performance test) 
 RMC 64kbps (for Performance test) 
 RMC 144kbps (for Performance test) 
 RMC 384kbps (for Performance test) 

  
Table 4.10.2-2  Physical Channel Powers for RMC 12.2kbps  

(for RX test) 

Physical Channel Power ratio 
P-CPICH P-CPICH_Ec/DPCH_Ec = 7 dB 
P-CCPCH  P-CCPCH_Ec/DPCH_Ec = 5 dB 

SCH SCH_Ec/DPCH_Ec = 5 dB 
PICH PICH_Ec/DPCH_Ec = 2 dB 
DPCH DPCH_Ec/Ior = –10.32 dB 
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Table 4.10.2-3  Physical Channel Powers for Channels Other Than 
RMC 12.2 kbps (for RX test) 

Physical Channel Power ratio 
P-CPICH P-CPICH_Ec/Ior = –10 dB 
P-CCPCH P-CCPCH_Ec/Ior = –12 dB 

SCH SCH_Ec/Ior = –12 dB 
PICH PICH_Ec/Ior = –15 dB 

DPCH 

12.2 kbps DPCH_Ec/Ior = –16.6 dB 
64 kbps DPCH_Ec/Ior = –12.8 dB 
144 kbps DPCH_Ec/Ior = –9.8 dB 
384 kbps DPCH_Ec/Ior = –5.5 dB 

OCNS The power where the total of all the channels 
including OCNS is 0 dB. 

 
■The Transfer Setting menu contains the following item. 
 

 

Figure 4.10.2-5  Transfer Setting Dialog Box 
 

• Transfer Setting Wizard 
Transfer Setting Wizard window is displayed. Generated waveform 
patterns can be transferred to the MG3700A/MG3710A/MG3710E 
easily by performing operations on this screen.  
 

■The following tool buttons are provided: 
 
 

 Recall Parameter File 

 Save Parameter File 

 Calculation 

 Calculation & Load 

 Calculation & Play 

 Transfer & Setting Wizard 

 Exit 

 The function of each button is the same with the corresponding item in 
the File or Edit menu.  
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■Total Power display 
 

 

Figure 4.10.2-6  Total Power Display 
 

 The total power of the channels that are set to ON (excluding OCNS) 
is displayed in this field. If the total power displayed here is out of 
±0.01 dB when OCNS is OFF, the warning message shown below is 
displayed during total power calculation, prompting to normalize the 
total power.  

 

 

Figure 4.10.2-7  Warning Display 
 

■Normalize Power button 
 

 

Figure 4.10.2-8  Normalize Power Button 
 

 This button is enabled when OCNS is OFF. When this button is 
clicked, the value displayed in Total Power is subtracted from the 
power of each channel that is set to ON. As a result, the total power is 
normalized to 0 dB while retaining the power ratio between channels.  

 
■Status display 
 The status display on the bottom of the screen displays operation 

statuses such as a warning occurred during setting.  
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4.10.3 Details of setting parameters on W-CDMA Downlink setting 
screen 

This section describes the details of the setting items on the W-CDMA 
Downlink setting screen.  

Setting Item Scrambling Code 

Functional 
Outline 

Sets the downlink scrambling code number.  

Setting 
Parameters 

Setting range 
0 to 8191 

Details The scrambling code set here is applied to the scramble of all the channels 
including CPICH, P-CCPCH, and PICH. Therefore, the primary scrambling code 
number should be set normally for this setting.  
The primary scrambling code number is expressed as follows:  
Primary scrambling code number = 16*i (i = 0 to 511) 

 
Setting Item Number of Frame 

Functional 
Outline 

Sets the number of frames to be created 

Setting 
Parameters 

Setting range 
Number of Frames 1 to the number of sufficient frames for the waveform 

memory 
Auto Selected or cleared the check box 

Details Refer to Appendix B “Number of Frames to Be Generated” in the MX370101A 
HSDPA IQproducer Operation Manual for the number of sufficient frames for the 
waveform memory. 
When the Auto checkbox is selected, the number of sufficient frames is 
automatically calculated to create the waveform pattern.  

 
Setting Item CPICH 

Functional 
Outline 

Performs settings related to CPICH. 

Setting 
Parameters 

Setting range 
ON/OFF ON or OFF 
Power –40.00 to 0.00 (dB), setting resolution: 0.01 dB 

Details The channelization code of the CPICH is fixed to 0.  
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Setting Item P-CCPCH 

Functional 
Outline 

Performs settings related to P-CCPCH.  

Setting 
Parameters 

Setting range 
ON/OFF ON or OFF 
Power –40.00 to 0.00 (dB), setting resolution: 0.01 dB 
P-SCH & S-SCH 
Power 

–40.00 to 0.00 (dB), setting resolution: 0.01 dB 

Details The channelization code of the P-CCPCH is fixed to 1.  
BCH is mapped for P-CCPCH.  

 
Setting Item PICH 

Functional 
Outline 

Performs settings related to PICH. 

Setting 
Parameters 

Setting range 
ON/OFF ON or OFF 
Power –40.00 to 0.00 (dB), setting resolution: 0.01 dB 
Channelization Code 0 to 255 
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Setting Item DPCH 

Functional 
Outline 

Performs settings related to Downlink DPCH. 

Setting 
Parameters 

Setting range 
ON/OFF ON or OFF 
Power –40.00 to 0.00 (dB), setting resolution: 0.01 dB 
Channelization Code 0 to SF – 1 

SF (spreading factor) varies depending on the setting of 
Data as follows: 
RMC 12.2 kbps = 128 
RMC 64 kbps = 32 
RMC 144 kbps = 16 
RMC 384 kbps = 8 
AMR1/AMR2/AMR3 = 128 
ISDN = 32 
384 kbps Packet = 8 

Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 
kbps/AMR1/AMR2/AMR3/ISDN/384 kbps Packet 

Details The channel coding parameter of the DCH is set according to the standard format 
selected by Data.  
RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 
Refer to 3GPP TS25.101 Annex A.3 DL reference measurement channel for details 
of these channels. See the next and subsequent pages for details of each parameter.  
AMR1/AMR2/AMR3/ISDN 
Refer to 3GPP TR25.944 4.1.1.3 Example for DCH for details of these channels. See 
the sections below for details of DTCH, DCCH, and Multiplexing.  
DTCH 
AMR1: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.1.3.1.6 Example for 64 kbps data 
DCCH 
AMR1/AMR2/AMR3/ISDN: 4.1.1.3.1.1 Example for 3.4 kbps data 
Multiplexing 
AMR1/AMR2/AMR3: 4.1.1.3.2.2 Example for multiplexing of 12.2 kbps data and 3.4 
kbps data 
ISDN: 4.1.1.3.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data 
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◆DL_RMC_12_2kbps channel coding parameters 
 

Table 4.10.3-1  DL Reference Measurement Channel 12.2 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 12.2 

DPCH ksps 30 
Slot Format #i – 11 

TFCI – On 
Power offsets PO1, PO2 and PO3 dB 0 

Puncturing % 14.7 
 

Table 4.10.3-2  DL Reference Measurement Channel 12.2 kbps Transport Channel 
Parameters 

Parameter DTCH  DCCH  
Transport Channel Number 1 2 

Transport Block Size 244 100 
Transport Block Set Size 244 100 

Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Convolution Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12 
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Figure 4.10.3-1  Channel Coding for DL Reference Measurement Channel 12.2 kbps 
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◆DL_RMC_64kbps channel coding parameters 
 

Table 4.10.3-3  DL Reference Measurement Channel 64 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 64 

DPCH ksps 120 
Slot Format #i – 13 

TFCI – On 
Power offsets PO1, PO2 and PO3 dB 0 

Repetition % 2.9 
 

Table 4.10.3-4  DL Reference Measurement Channel 64 kbps Transport Channel 
Parameters 

Parameter DTCH  DCCH  
Transport Channel Number  1 2 

Transport Block Size 1280 100 
Transport Block Set Size 1280 100 

Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 4.10.3-2  Channel Coding for DL Reference Measurement Channel 64 kbps 
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◆DL_RMC_144kbps channel coding parameters 
 

Table 4.10.3-5  DL Reference Measurement Channel 144 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 144 

DPCH ksps 240 
Slot Format #i – 14 

TFCI – On 
Power offsets PO1, PO2 and PO3 dB 0 

Puncturing % 2.7 
 

Table 4.10.3-6  DL Reference Measurement Channel 144 kbps Transport Channel 
Parameters 

Parameter DTCH  DCCH  
Transport Channel Number 1 2 

Transport Block Size 2880 100 
Transport Block Set Size 2880 100 

Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 4.10.3-3  Channel Coding for DL Reference Measurement Channel 144 kbps 
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◆DL_RMC_384kbps channel coding parameters 
 

Table 4.10.3-7  DL Reference Measurement Channel 384 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 384 

DPCH ksps 480 
Slot Format # i – 15 

TFCI – On 
Power offsets PO1, PO2 and PO3 dB 0 

Puncturing % 22 
 

Table 4.10.3-8  DL Reference Measurement Channel 384 kbps Transport Channel 
Parameters 

Parameter DTCH DCCH 
Transport Channel Number 1 2 

Transport Block Size 3840 100 
Transport Block Set Size 3840 100 

Transmission Time Interval 10 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12 
Position of TrCH in radio frame fixed Fixed 
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Figure 4.10.3-4  Channel Coding for DL Reference Measurement Channel 384 kbps 
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Setting Item OCNS 

Functional 
Outline 

Sets OCNS ON/OFF.  

Setting 
Parameters 

Setting range 
ON/OFF ON or OFF 
Type 16 Codes 

Details When OCNS is set to ON, the power of OCNS (Orthogonal Channel Noise 
Simulator) is adjusted so that the total power of all the channels that are set to ON 
becomes 0 dB.  
When the total power of all the channels that are set to ON (excluding OCNS) 
exceeds 0 dB while OCNS is set to ON, an error occurs and data generation is 
cancelled. The total power of all the channels that are set to ON (excluding OCNS) 
is displayed in Total Power on the screen.  
To clear this error, set OCNS to OFF or attenuate the power of each channel. For 
example, when P-CCPCH, CPICH, and DPCH are set as follows, the total power of 
the channels except OCNS exceeds 0 dB. OCNS cannot be set to ON in this event, 
and it is regarded as an error.  
An error may occur when the actual total power exceeds 0 dB at the thousandth or 
later places that are not displayed, even if 0.00 dB is displayed in Total Power on 
the screen.  
 

Total＞0.0 dB
P-CCPCH＝－3.00 dB

CPICH＝－3.00 dB
DPCH＝－3.00 dB

OCNS＝?
 

 

When OCNS is set to OFF, click the Normalize Power button to adjust the power of 
each channel so that the total power of all the channels becomes 0 dB while 
retaining the power ratio between channels.  
 

P-CCPCH＝－3.00 dB
CPICH＝－3.00 dB

Normalize

DPCH＝－3.00 dB

P-CCPCH＝－4.80 dB
CPICH＝－4.80 dB
DPCH＝－4.80 dB  
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Details OCNS consists of 16-channel (for Performance requirement) DPCH. The table 
below shows the parameters. Refer to 3GPP TS25.101 (Release 5) Table C.12 for 
details.  
 

OCNS (16 channels) 

Channelization
Code at SF＝128

Relative Level
Setting（dB）

2 －1

11 －3

17 －3

23 －5

31 －2

38 －4

47 －8

55 －7

62 －4

69 －6

78 －5

85 －9

94 －10

125 －8

113 －6

119 0
 

 

Displayed contents 
An OCNS item Power displays the power of OCNS only. The total of the values of 
Total Power and Power of this OCNS is always 0 dB.  
The Channelization Code and SF (spreading factor) used by OCNS are also 
displayed.  
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4.10.4 Details of setting parameters on Channel Edit screen 
When the Channel Edit button is clicked, the Channel Edit screen shown 
below is displayed. This section describes the details of the setting items 
on this screen.  

 

Figure 4.10.4-1  Channel Edit Screen 
 

■The OK and Cancel buttons are provided to close the Channel Edit 
screen after performing setting.  

 
• When OK button is clicked: 

The Channel Edit screen is closed applying the settings.  
 
• When Cancel button is clicked: 

The Channel Edit screen is closed ignoring the settings.  
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Setting Item P-CCPCH Edit 

Functional 
Outline 

Performs settings related to P-CCPCH.  

Setting 
Parameters 

Setting range 
SFN Cycle Short or 4096 

Details Sets the cycle of SFN (System Frame Number) that is transmitted by BCH mapped 
to P-CCPCH.  
When Short is set, the cycle of SFN becomes a common multiple of the maximum 
TTI cycle. Also, the calculation time is reduced and the amount of data to be 
generated becomes smaller. Set this to 4096 to set the normal 4096-frame cycle.  

 
Setting Item DPCH Edit (PhyCH) 

Functional 
Outline 

Performs settings for DL-DPCH physical channels. 

Setting 
Parameters 

Setting range 
Timing Offset 0 to 149 
TFCI 0 to 1023 

 
Setting Item DPCH Edit (TrCH Edit) 

Functional 
Outline 

Performs settings related to TrCH.  

Setting 
Parameters 

Setting range 
Data PN9/PN9fix/PN15fix/16bitRepeat/User File 

Details Data 
Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last data of 
a signal and the first data of the next signal are not continuous.  
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4.10.5 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using this software.  

Saving parameter file 

 
Figure 4.10.5-1  Parameter File Saving Dialog Box 

 

(1) Select Save Parameter File from the File menu or click the  
tool button to display the parameter file saving screen shown in 
Figure 4.10.5-1 above.  

(2) Enter a file name in the File name text box and click the Save 
button to save the parameter file.  
When Input Folder (I) is not changed, the input folder and the name 
of the file are as follows; 
X:\IQproducer\W_CDMA\ (Entered file name) .prm.  
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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Reading parameter file 

 
Figure 4.10.5-2  Parameter File Reading Dialog Box 

 

(1) Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen shown in 
Figure 4.10.5-2 above.  

(2) Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file.  
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4.10.6 Generating waveform pattern file 
A waveform pattern file to be used in the MG3700A/MG3710A/MG3710E 
can be generated based on the setting values. In the screen shown in 
Figure 4.10.6-2, the waveform pattern name and comments can be 
entered and whether to enable or disable the RRC filter can be set.  
The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. The configuration of the 
waveform pattern to be generated also varies; whether the waveform 
pattern uses only one memory or whether it uses two memories. The 
baseband signal synthesizer option is required to use two memories.  

(1) Select Calculate Waveform Pattern from the Edit menu or click the 
 tool button. 

 At this time, the Warning dialog box shown below appears when 
OCNS is set to OFF and the value of Total Power is out of ±0.01 dB. 

 

Figure 4.10.6-1  Warning Dialog Box 
 

 Click the OK button to normalize the Total Power and proceed with 
the next step. 
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(2) The File Name Input screen is displayed.  

 
Figure 4.10.6-2  File Name Input Screen 

 

 Enter a package name in the package name input box within 31 
characters. 
Up to 31 characters can be used for a package name. 
Enter a file name in the file name input box within 18 characters. 
Up to 18 characters can be used for a file name. 
1-byte alphanumeric characters and the following symbols can be used 
for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 When a file name is entered, the file to be generated is displayed in 
the file name display area in the following format: 

 File name format: 

 test_A.wvi 
Extension: wvi… Information file (text format) 

wvd… Data file (binary format) 
Target memory: A… Read from waveform memory A 

B… Read from waveform memory B 
Entered file name  

Enter a comment for the waveform pattern in a comment input box.  
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters.  
1-byte alphanumeric characters and symbols can be used for 
comments.  
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The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the 
MG3700A/MG3710A/MG3710E. Leave the comment boxes blank if 
not necessary.  

When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. This check box needs not be selected under normal 
conditions.  

(3) Click the OK button to start waveform pattern file generation.  
The calculation progress screen is displayed during the file 
generation progressing.  

 
Figure 4.10.6-3  Calculation Progress Screen 

 
The file generation processing statuses are displayed in the dialog 
box.  
The file generation progress status is indicated by the progress bar.  
Clicking the output destination selection button displays the Browse 
for Folder screen shown in Figure 4.10.6-4. The output destination 
folder can be selected from this screen. 
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Figure 4.10.6-4  Browse for Folder Screen 
 

When the output destination folder is not specified, waveform 
pattern files are saved in the following directory:  
X:\IQproducer\W_CDMA\Data 
(X:\IQproducer is the folder in which the IQproducerTM is installed.) 
When this software is hosted by the MG3710A/MG3710E, the 
waveform will be stored in the following folder.  
C:\Anritsu\MG3710A\User Data\Waveform\“Package name” 
The output destination file can be changed from other than above.  

 Note: 
The waveform pattern generation of W-CDMA Downlink 
IQproducer and W-CDMA Uplink IQproducer can be 
exclusively executed. During the one is under execution, 
starting the other execution causes an error dialog indication. 
When you start a file generation, be sure to cancel the other 
file generation or to wait for its completion.  
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4.10.7 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

 

Figure 4.10.7-1  Load Setting Screen 
 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 4.10.7-2  Select Memory Screen 
 

After selecting the load destination of generated waveform in the Select 
Memory screen and pressing OK, the Load Setting screen will be shown 
again. Press OK in the Load Setting screen, and then the loading of 
waveform starts.  
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Notes: 
• To exit this screen without loading the waveform pattern, click 

Cancel in the Load Setting screen.  

• If the configuration of generated waveform pattern uses two 
memories, the Select SG screen is displayed as well as 
Calculation & Play. 

4.10.8 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 4.10.8-1  Select SG Screen 
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4.10.9 Auxiliary signal output 
When the waveform pattern generated by the W-CDMA Downlink 
IQproducer is selected on the mainframe, a marker signal synchronized 
with the RF signal is also generated from the mainframe output 
connector.  
MG3700A 

The TTI Pulse is generated from AUX Input/Output Connector1 on 
the rear panel.  

• TTI Pulse 
TTI interval pulse synchronized to the TTI header symbol is generated. 
Change Polarity for Marker 1 to change the signal polarity.  

MG3710A/MG3710E 
The marker signal is output from Marker 1 and AUX connector on the 
rear panel.  
The output signal is specified depending on the MG3710A/MG3710E 
settings as shown in the Table 4.10.9-1.  
 

Table 4.10.9-1  MG3710A/MG3710E Marker Signal 

Generating 
SG 

Waveform 
memory Signal name 

SG1 Memory A SG1 Marker1 A 
SG1 Memory B SG1 Marker1 B 
SG2 Memory A SG2 Marker1 A 
SG2 Memory B SG2 Marker1 B 

 
For how to configure marker signal and connector setting, refer to 7.4.2 
“Route Output Connectors” in MG3710A/MG3710E/MG3740A Operation 
Manual (Mainframe).   
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4.11 W-CDMA Uplink Waveform Pattern Generation 
Function 

This function enables the generation of a waveform pattern to be used in 
cases such a W-CDMA reception sensitivity test, by changing some 
W-CDMA-related parameters of the MX370101A HSDPA IQproducer.  
It is possible to change the scrambling code number and channelization 
code number for a waveform pattern that is provided as a standard 
waveform pattern.  

Note:  
The W-CDMA Uplink waveform pattern generation function is not 
available when MG3740A is clicked in the Select Instrument 
window or the IQproducer™ is started on MG3740A. 

4.11.1 Activation 
Select W-CDMA Uplink (Standard) from the System (Cellular) tab on the 
common platform screen.  

The W-CDMA Uplink setting screen is displayed separately.  

 

4.11.2 W-CDMA Uplink setting screen 

 

Figure 4.11.2-1  W-CDMA Uplink Setting Screen 
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■The File menu contains the following items. 
 

 

Figure 4.11.2-2  File Selection Screen 

• Select Option 

When this software is activated in the MG3700 mode; 

Select whether to enable/disable the ARB memory expansion 
option 512Msamples for the MG3700A. When With Option21 is 
selected, the maximum size of the waveform pattern that can be 
generated is expanded. But if the ARB memory expansion option 
512Msamples is not installed in this event, the generated waveform 
pattern may not be able to be used. Select either With Option21 or 
Without Option21 according to whether the ARB memory 
expansion option 512Msamples is installed in the MG3700A to be 
used or not.  

With Option21 (Memory 512Msamples): 1 GB × 2 memory 
Without Option21 (Memory 512Msamples): 512 MB × 2 memory 

When this software is activated in the MG3710 mode; 
The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

Set the Select Option according to the combination of the installed 
options on the MG3710A/MG3710E.  
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Table 4.11.2-1  Available Options for MG3710A/MG3710E 

Select Option setting 
Maximum Size 
of Waveform 

Patterns 

Options implemented on 
the MG3710A/MG3710E 

1st SG 2nd SG 

Memory 64M samples 64Msample None None 

Memory 64M samples × 2 
(With Option 48, 78) 

128Msample 048/148 078/178 

Memory 256M samples 256Msample 045/145 075/175 

Memory 256M samples × 2 
(With Option 48, 78) 

512Msample 045/145 
048/148 

075/175 
078/178 

Memory 1024M samples 512Msample 046/146 076/176 

Memory 1024M samples × 
2 (With Option 48, 78) 

512Msample 046/146 
048/148 

076/176 
078/178 

 
• Recall Parameter File 

Sets the W-CDMA Uplink parameters according to the setting of 
the parameter files saved by Save Parameter File.  

 
• Save Parameter File 

Saves the W-CDMA Uplink setting parameters to a file.  
 
• Exit 

Exits the W-CDMA Uplink IQproducer. 
 
■The Edit menu contains the following items.  
 

 

Figure 4.11.2-3  Edit Selection Screen 
 

• Channel Edit 
Displays the Channel Edit screen in which the DPCH parameters 
are set. This is the same operation with clicking the Channel Edit 
button on the screen.  
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• Channel Gain Setup 
Displays the Channel Gain Setup screen in which the power of each 
channel can be set using βc and βd parameters. The setting of 
Power in the main screen is changed in accordance with the 
channel power set in this screen.  

 
• Calculation & Load (Effective only when this software is hosted by 

the MG3710A/MG3710E) 
Creates the waveform to load it into the memory  
 

• Calculation & Play (Effective only when this software is hosted by 
the MG3710A/MG3710E) 
Creates the waveform, load it into the memory and select it.  

 
• Calculate Waveform Pattern 

Starts waveform pattern generation based on the settings on the 
screen.  
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly.  
The number of frames to be generated is displayed on the 
calculation progress screen.  

 
■The Transfer Setting menu contains the following item. 
 

 

Figure 4.11.2-4  Transfer Setting Dialog Box 
 

• Transfer Setting Wizard 
Displays the Transfer Setting Wizard screen. Generated waveform 
patterns can be transferred to the MG3700A/MG3710A/MG3710E 
easily by performing operations on this screen.  
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■The following tool buttons are provided: 
 

 Recall Parameter File 

 Save Parameter File 

 Calculation 

 Calculation & Load 

 Calculation & Play 

 Transfer & Setting Wizard 

 Exit 

 
The function of each button is the same with the corresponding item in 
the File or Edit menu.  

 
■Normalize Power button 
 

 

Figure 4.11.2-5  Normalize Power Button 
 

 When this button is clicked, the value displayed in Total Power is 
subtracted from the power of each channel that is set to ON. As a 
result, the total power is normalized to 0 dB while retaining the power 
ratio between channels. The total power value displayed in Total 
Power is calculated from the total power of all the channels that are 
set to ON.  
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Setting Item Scrambling Code 

Functional 
Outline 

Sets the scrambling code. 

Setting 
Parameters 

Setting range 
0 to 16777215 

 
Setting Item Number of Frame 

Functional 
Outline 

Sets the number of frames to be created 

Setting 
Parameters 

Setting range 
Number of Frames 1 to the number of sufficient frames for waveform memory 
Auto Selected or cleared the check box 

Details Refer to Appendix B “Number of Frames to Be Generated” in the MX370101A 
HSDPA IQproducer Operation Manual for the number of sufficient frames for the 
waveform memory. 
When the Auto checkbox is selected, the number of sufficient frames is 
automatically calculated to create the waveform pattern.  

 
Setting Item UL-DPCCH, UL-DPDCH 

Functional 
Outline 

Performs settings for DPCCH and DPDCH. 

Setting 
Parameters 

Setting range 
Power –40.00 dB to 0 dB 
Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/ 

RMC 384 kbps/AMR1/AMR2/AMR3/ISDN/64 kbps Packet/  
Details RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 

The channel coding parameter of the DCH is set according to the standard format 
selected by Data.  
Refer to 3GPP TS25.104 Annex A UL reference measurement channel for details of 
these channels. See the next and subsequent pages for details of each parameter.  
AMR1/AMR2/AMR3/ISDN 
Refer to 3GPP TR25.944 4.1.2.2 Example for DCH for details of these channels. See 
the sections below for details of DTCH, DCCH, and Multiplexing.  
DTCH 
AMR1: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.2.2.1.6 Example for 64 kbps data 
DCCH 
AMR1/AMR2/AMR3/ISDN: 4.1.2.2.1.1 Example for 3.4 kbps data 
Multiplexing 
AMR1/AMR2/AMR3: 4.1.2.2.2.2 Example for multiplexing of 12.2 kbps data and 3.4 
kbps data 
ISDN: 4.1.2.2.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data 
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◆UL_RMC_12_2kbps channel coding parameters 
 

Table 4.11.2-2  UL Reference Measurement Channel 12.2 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 12.2 

DPDCH kbps 60 
DPCCH kbps 15 

DPCCH Slot Format #i – 0 
DPCCH/DPDCH power ratio dB –2.69  

TFCI – On 
Repetition % 22 

 
Table 4.11.2-3  UL Reference Measurement Channel 12.2 kbps Transport Channel 

Parameters 

Parameters DTCH DCCH 
Transport Channel Number  1  2  

Transport Block Size 244  100  
Transport Block Set Size 244  100  

Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Convolution Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12  
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Figure 4.11.2-6  Channel Coding for UL Reference Measurement Channel 12.2 kbps 
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◆UL_RMC_64kbps channel coding parameters 
 

Table 4.11.2-4  UL Reference Measurement Channel 64 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 64 

DPDCH kbps 240 
DPCCH kbps 15 

DPCCH Slot Format #i – 0 
DPCCH/DPDCH power ratio dB –5.46 

TFCI – On 
Repetition % 19 

 
Table 4.11.2-5  UL Reference Measurement Channel 64 kbps Transport Channel 

Parameters 

Parameter DTCH  DCCH  
Transport Channel Number  1  2  

Transport Block Size 2560  100 
Transport Block Set Size 2560 100  

Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12  
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Figure 4.11.2-7  Channel Coding for UL Reference Measurement Channel 64 kbps 
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◆UL_RMC_144kbps channel coding parameters 
 

Table 4.11.2-6  UL Reference Measurement Channel 144 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 144 

DPDCH kbps 480 
DPCCH kbps 15 

DPCCH Slot Format #i – 0 
DPCCH/DPDCH power ratio dB –9.54 

TFCI – On 
Repetition % 8 

 
Table 4.11.2-7  UL Reference Measurement Channel 144 kbps Transport Channel 

Parameters 

Parameters DTCH  DCCH  
Transport Channel Number 1  2  

Transport Block Size 2880  100  
Transport Block Set Size 5760 100  

Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12  
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Figure 4.11.2-8  Channel Coding for UL Reference Measurement Channel 144 kbps 
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◆UL_RMC_384kbps channel coding parameters 
 

Table 4.11.2-8  UL Reference Measurement Channel 384 kbps Physical Channel 
Parameters 

Parameter Unit Level 
Information bit rate kbps 384 

DPDCH kbps 960 
DPCCH kbps 15 

DPCCH Slot Format #i – 0 
DPCCH/DPDCH power ratio dB –9.54 

TFCI – On 
Puncturing % 18 
 

Table 4.11.2-9  UL Reference Measurement Channel 384 kbps Transport Channel 
Parameters 

Parameter DTCH DCCH 
Transport Channel Number 1 2 

Transport Block Size 3840 100 
Transport Block Set Size 15360 100 

Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 

Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 

Size of CRC 16 12 
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Figure 4.11.2-9  Channel Coding for UL Reference Measurement Channel 384 kbps 



 

 4.11 W-CDMA Uplink Waveform Pattern Generation Function 

4-167 

4.11.3 Channel Edit screen 
When the Channel Edit button is clicked, the Channel Edit screen shown 
below is displayed. This section describes the details of the setting items 
on this screen.  

 

Figure 4.11.3-1  Channel Edit Screen 
 

■The following buttons are provided to close the Channel Edit screen 
after configuring setting.  

 
• When OK button is clicked: 

The Channel Edit screen is closed applying the settings.  
 
• When Cancel button is clicked: 

The Channel Edit screen is closed ignoring the settings.  
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Setting Item DPCH Edit (PhCH) 

Functional 
Outline 

Performs settings related to UL-DPCH.  

Setting 
Parameters 

Setting range 
Timing Offset 0 to 149 
TFCI 0 to 1023 

 
 

Setting Item DPCH Edit (TrCH Edit) 

Functional 
Outline 

Performs settings for TrCH of UL-DPCH.  

Setting 
Parameters 

Setting range 
Data PN9/PN9fix/PN15fix/16bitRepeat/User File 

Details Data 
Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last data of 
a signal and the first data of the next signal are not continuous.  
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4.11.4 Channel Gain Setup screen 
When the Channel Gain Setup is selected from the Edit menu, the 
Channel Gain Setup screen shown below is displayed. This section 
describes the details of the setting items on this screen.  

 

Figure 4.11.4-1  Channel Gain Setup Screen 
 

Setting Item Channel Gain 

Functional 
Outline 

Performs settings for each channel gain.  

Setting 
Parameters 

Setting range 
Beta c 0 to 15 
Beta d 0 to 15 

Details When the OK button is clicked after applying settings to close the Channel Gain 
Setup screen, the settings for each item are converted to (dB) units and displayed 
in the Channel Edit screen.  
When the Cancel button is clicked, the screen is closed without reflecting the 
settings for each item on the Channel Edit screen. However, the settings applied on 
this screen are maintained.  
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4.11.5 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using this software.  

Saving parameter file 

 

Figure 4.11.5-1  Parameter File Saving Dialog Box  
 

(1) Select Save Parameter File from the File menu or click the  
tool button to display the parameter file saving screen shown in 
Figure 4.11.5-1 above.  

(2) Enter a file name in the File name text box and click the Save 
button to save the parameter file.  
When Input Folder (I) is not changed, the input folder and the name 
of the file are as follows; 
X:\IQproducer\W_CDMA\ (Entered file name) .prm.  
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.)  
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Reading parameter file 

 

Figure 4.11.5-2  Parameter File Reading Dialog Box  
 

(1) Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen shown in 
Figure 4.11.5-2 above.  

(2) Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file.  

 

4.11.6 Generating waveform pattern file 
A waveform pattern file to be used in the MG3700A/MG3710A/MG3710E 
can be generated based on the setting values. In the screen shown in 
Figure 4.11.6-2, the waveform pattern name and comments can be 
entered and whether to enable or disable the RRC filter can be set.  
The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. The baseband signal 
synthesizer option is required to use two memories.  

(1) Select Calculate Waveform Parameter from the Edit menu or click 
the  tool button. 
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 At this time, the Warning message shown below appears when the 
total power is not normalized by clicking the Normalize Power 
button. 

 

Figure 4.11.6-1  Warning message 
 

 Click the OK button to normalize the total power and proceed with 
the next step. 

(2) The file name input screen is displayed. 

 

Figure 4.11.6-2  File Name Input Screen 
 

 Enter a package name in the package name input box within 31 
characters. 
Up to 31 characters can be used for a package name. 
Enter a file name in the file name input box within 18 characters. 
Up to 18 characters can be used for a file name. 
1-byte alphanumeric characters and the following symbols can be used 
for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
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 When a file name is entered, the file to be generated is displayed in 
the file name display area in the following format: 

 File name format: 

 test_A.wvi 
Extension: wvi… Information file (text format) 

wvd… Data file (binary format) 
Target memory: A… Read from waveform memory A 

B… Read from waveform memory B 
Entered file name  

 Enter a comment for the waveform pattern in a comment input box.  
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters.  
1-byte alphanumeric characters and symbols can be used for 
comments.  
The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the 
MG3700A/MG3710A/MG3710E. Leave the comment boxes blank if 
not necessary.  

When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. This check box needs not be selected under normal 
conditions.  

(3) Click the OK button to start waveform pattern file generation.  
 The calculation progress screen is displayed during the file 
generation progressing.  

 
Figure 4.11.6-3  Calculation Progress Screen 
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 The file generation processing statuses are displayed in the dialog 
box.  
The file generation progress status is indicated by the progress bar.  
When the file is generated completely, the information about the 
generated waveform pattern file is displayed in the dialog box.  

Clicking the output destination selection button displays the Browse 
for Folder screen shown in Figure 4.11.6-4. The output destination 
folder can be selected from this screen. 

 
Figure 4.11.6-4  Browse for Folder Screen 

 
When the output destination folder is not specified, waveform 
pattern files are saved in the following directory:  

 X:\IQproducer\W_CDMA\Data 
(X:\IQproducer is the folder in which the IQproducerTM is installed.) 

When this software is hosted by the MG3710A/MG3710E, the 
waveform will be stored in the following folder.  

C:\Anritsu\MG3710A\User Data\Waveform\“Package name” 

The output destination file can be changed from the above folder to 
another one.  
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 Note: 
The waveform pattern generation of W-CDMA Downlink 
IQproducer and W-CDMA Uplink IQproducer can be 
exclusively executed. During the one is under execution, 
starting the other execution causes an error dialog indication. 
When you start a file generation, be sure to cancel the other 
file generation or to wait for its completion.  
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4.11.7 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation. 

 

Figure 4.11.7-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 4.11.7-2  Select Memory Screen 
 

After selecting the load destination of generated waveform in the Select 
Memory screen and pressing OK, the Load Setting screen will be shown 
again. Press OK in the Load Setting screen, and then the loading of 
waveform starts.  
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Notes: 
• To exit this screen without loading the waveform pattern, click 

Cancel in the Load Setting screen.  

• If the configuration of generated waveform pattern uses two 
memories, the Select SG screen is displayed as well as 
Calculation & Play. 

4.11.8 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 4.11.8-1  Select SG Screen 
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4.11.9 Auxiliary signal output 
When the waveform pattern generated by the W-CDMA Uplink 
IQproducer is selected on the mainframe, a marker signal synchronized 
with the RF signal is also generated from the mainframe output 
connector.  
MG3700A 

The Frame Trigger signal is generated from the AUX Input/Output 
Connector1 on the rear panel.  

• Frame Trigger 
The 10 ms interval pulse synchronized to the Frame header symbol is 
generated. Change Polarity for Marker 1 to change the signal polarity.  

MG3710A/MG3710E 
The marker signal is output from Marker 1 and AUX connector on the 
rear panel.   
The output signal is specified depending on the MG3710A/MG3710E 
settings as shown in the Table 4.10.9-1.  
 

Table 4.11.9-1 MG3710A/MG3710E Marker Signal 

Generating 
SG 

Waveform 
memory Signal name 

SG1 Memory A SG1 Marker1 A 
SG1 Memory B SG1 Marker1 B 
SG2 Memory A SG2 Marker1 A 
SG2 Memory B SG2 Marker1 B 

 
For how to configure marker signal and connector setting, refer to 7.4.2 
“Route Output Connectors” in MG3710A/MG3710E/MG3740A Operation 
Manual (Mainframe).  
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4.12 Help Screen 
Click Help on the common platform screen described in section 4.2.  
The version information of the IQproducerTM is displayed.  
The following shows an example. 

 

Figure 4.12-1  Version Display Screen 
 

■Description of items 
(1) OK button 

Click this button to close the Version display screen.  
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4.13 Time Domain Graph Display 
The waveform pattern generated in each signal generation application is 
indicated as a time domain waveform in the graphic display.  
 

4.13.1 Activation 
Select Time Domain from the Simulation & Utility tab on the common 
platform screen.  
The time domain graph display screen is displayed separately.  
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4.13.2 Time domain graph display screen 
 

 
Figure 4.13.2-1  Time Domain Graph Display Screen 

 

■Description of items 
(1) Menu bar 

 Trace addition, trace deletion, Marker Edit dialog box open, and 
time domain graph display close can be executed.  

(2) Graph type 

 The graph type can be selected from the drop-down list. Two graph 
types can be selected: “I, Q, Marker” and “Power, Marker”.  

(3) Legend 

 File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed.  

(4) Graph display area 

 A time domain graph is displayed in this area. Graph cursor move 
and graph zoom-in display can be executed.  

(5) Add/Delete (trace addition/deletion) 

 A trace can be added/deleted. 
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(6) Cursor Position 

 The graph cursor position in the time domain graph display area can 
be specified by entering a value in the Time text box.  

(7) Mouse Interaction 

 The mouse operation in the time domain graph display area can be 
set to either the graph cursor move function or the zoom-in function.  

(8) Quick Add Mode (interaction with signal generation application) 

 Settings for displaying a trace of a waveform pattern generated by a 
signal generation application to the time domain display in 
conjunction with the signal generation application are configured.  

(9) Marker Edit (Marker Edit dialog box open) 

 Clicking this button opens the Marker Edit dialog box. 

(10) Marker display area 

 The value of each marker is displayed in this area. 

(11) Set RMS Range button 

 When the Time Domain screen is displayed from the Convert screen, 
this button is used to set the RMS-calculation range.  
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4.13.3 Displaying time domain graph by reading file 
A waveform pattern generated by a signal generation application of the 
IQproducerTM can be read and displayed in a Time Domain graph.  

■Time domain graph display using Add button 
<Procedure> 
1. Click one of the option buttons in the Legend dialog box to select the 

trace color of the waveform pattern in the CCDF graphical area.  

 
Figure 4.13.3-1  Legend Dialog Box 

 

2. Click the Add button to display the Add Trace dialog box.  

The Add button is disabled when any other waveform pattern is 
already specified on the selected option button. In such a case, delete 
the waveform pattern by clicking the Delete button, or click one of 
other option button.  

 

Figure 4.13.3-2  Add Button 
 

 Otherwise, select Add Trace from the File menu. 

 

Figure 4.13.3-3  Add Trace Button on The File Menu 
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3. Click the  button in the Add Trace screen, and select a 
waveform pattern for which a time domain graph is displayed. 

 
Figure 4.13.3-4  Add Trace Dialog Box 

 

 Waveform pattern files that have the formats below can be read. 
For details about the ASCII1, ASCII2, ASCII3, and 
MS269x/MS2830A/MS2840A Digitizer formats, see Section 4.5.6 
“Input file format”.  
•ASCII1 

•ASCII2 

•ASCII3 

•MS269x/MS2830A/MS2840A Digitizer 
•wvi 

Also, a maximum of 1 Msample (= 1,048,576 samples) can be read.  
When a waveform pattern is selected, either the data of the 
selected waveform pattern or “1 Msample” is displayed in the 
Sampling Points text box. The number of reading data can be 
changed by editing the value in the Sampling Points text box. Also, 
the waveform pattern reading start position can be specified by 
changing the value in the Sampling Range text box.  
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Click the OK button on the Add Trace screen to read the waveform 
pattern.  
When the waveform pattern has been read completely, the time 
domain graph display screen is displayed again with a trace in the 
color selected in Legend. If the ASCII1, ASCII2, or ASCII3 format 
was selected for waveform pattern display, enter a value for 
Sampling Rate.  

 

4.13.4 Deleting time domain graph 
The time domain graph displayed in the screen can be deleted.  

■Deleting time domain graph using Delete button 
<Procedure> 
1. Click the option button in the Legend dialog box to select the trace to 

be deleted.  

 
Figure 4.13.4-1  Legend Dialog Box 

 

2. Click the Delete button.  
Click the Delete button to delete the graph corresponding to the 
selection in the Legend field.  

 
Figure 4.13.4-2  Delete Button 

 

 Otherwise, select Delete Trace from the File menu.  

 

Figure 4.13.4-3  Delete Trace Button on the File Menu 
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4.13.5 Graph type 
When “I, Q, Marker” is selected from the Graph Type drop-down list, the 
time domain waveform of the I-phase, Q-phase, and marker data of the 
selected waveform pattern is displayed. When “Power, Marker” is 
selected, the time domain waveform of the marker data and the power 
based on the rms value (written in the wvi file) of the selected waveform 
pattern is displayed.  

 

 
Figure 4.13.5-1  Graph Type 
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4.13.6 Sampling information display 
The reading start sample and the reading end sample are displayed for 
Sampling Range (the first sample is “0”). The sampling rate of the 
waveform pattern to be read is displayed for Sampling Rate. The number 
of read samples is displayed for Sampling Points. The data point of the 
reading target waveform pattern is displayed for Data Points. The 
sampling information on the trace selected by a radio button in the 
Legend field is displayed in the lower area of the Legend field.  

 
Figure 4.13.6-1  Sampling Information Display 

 

4.13.7 Mouse interaction selection in the CCDF graph display area 
(Mouse Interaction) 

Graph cursor move or graph zoom-in can be selected for a mouse 
dragging operation in the time domain graph display area. Click the 
Mouse Interaction button to display the Mouse Interaction dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom  The mouse is used to set the zooming area.  

 
Figure 4.13.7-1  Mouse Interaction Dialog Box 

 



 

Chapter 4  Operations for Each Function 

4-188 

4.13.8 Moving graph cursor 
The graph cursor displayed in the time domain graph display area can be 
moved.  

■Moving graph cursor using mouse 
When the black-line or yellow-line cursor in the Time Domain graph 
display area is dragged, the cursor is moved.  

 
Figure 4.13.8-1  Time Domain Graph Display Area 

 

The contents displayed in Cursor in the time domain graph display 
screen are updated as the graph cursor is moved.  
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■Moving graph cursor changing Cursor value 
When the Time 1 value in the Cursor area of the Time Domain graph 
display screen is updated, the black-line cursor moves and the 
Magnitude 1 value is updated.  
Similarly, when the Time 2 value is updated, the yellow-line cursor 
moves and the Magnitude 2 value is updated.  
When the black-line or yellow-line cursor is moved by changing the Time 
1 or Time 2 value, respectively, the Time delta and 1/delta values are 
updated. Time delta displays the result of subtracting the Time 1 value 
from the Time 2 value, and 1/delta displays the reciprocal of the Time 
delta value.  

 
Figure 4.13.8-2  Cursor Dialog Box 

 

 

4.13.9 Changing graph scale 
The scale of the graph currently displayed can be changed.  

■Changing graph display area scale 
The scales for the time (X axis) and amplitude (Y axis) of the time 
domain graph display area are updated by changing the value(s) in the 
Scale field on the time domain graph display screen. The values set in 
the Time text boxes (X axis) indicate the range of the sampled data 
displayed in a graph, and 0.0 ms represents the start of that data.  

 
Figure 4.13.9-1  Scale Dialog Box 
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<Procedure> 
1. Click the Time text box and enter values to specify the time display 

range.  

2. Click the Magnitude text box and enter values to specify the 
amplitude display range.  

When the focus is moved to another control after changing the value in 
the PAR text box as shown in Step 1 above, the scale for the X axis in the 
CCDF graph display area is updated.  

Similarly, when the focus is moved after changing the value in the 
Magnitude text box as shown in Step 2 above, the scale for the Y axis in 
the time domain graph display area is updated.  

In addition, the scale of both axes can be adjusted to display the entire 
Time Domain graph by clicking the Full Scale button.  

 
Figure 4.13.9-2  Graphic Range Control By Zooming Operation 

 

■Specifying display area by mouse operation 
When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the graph enlarges the selected area (within the dotted 
rectangle).  
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4.13.10 Values displayed on graph 
This section describes how a trace on the I, Q, Power, and Marker graphs 
displays the data or marker of the waveform pattern, separately for each 
graph type.  

■I and Q graphs 
On the I and Q graphs (displayed when “I, Q, Marker” is selected from 
the Graph Type drop-down list), the sample values of the read waveform 
pattern are plotted and adjacent samples are connected by linear 
interpolation. Note that the sample-unit time scale above the I graph 
applies only to the trace selected by Legend, while the ms-unit time scale 
below the Q graph applies to any displayed traces.  

 
Figure 4.13.10-1  I, Q Graph 

 

■Power graph 
On the Power graph (displayed when “Power, Marker” is selected from 
the Graph Type drop-down list), the sample values of the read waveform 
pattern are plotted as power and adjacent samples are connected by 
linear interpolation.  
If ASCII1, ASCII2, ASCII3, or wvi is selected as the file format for 
waveform pattern display，The X axis of the Power graph is displayed 
with the RMS value of the waveform pattern as 0 dB. When the 
MG3700A, MG3710A, ME3710E, or MG3740A actually outputs a 
modulation signal, therefore, the output modulation signal is based on 0 
dB of the Power graph.  
 

MG3700A/MG3710A/MG3710E/MG3740A output level  
= MG3700A/MG3710A/MG3710E/MG3740A display level + Level on Power 
graph 
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If MS269x/MS2830A/MS2840A Digitizer is selected as the file format for 
waveform pattern display, the level recorded in the digitized file is 
displayed as is. Therefore, when the MS269xA/MS2830A/MS2840A is 
actually used to output a modulated signal, the output signal does not 
necessarily use the 0 dB in the Power graph as a reference.  
Note that the sample-unit time scale above the I graph applies only to the 
trace selected by Legend, while the ms-unit time scale below the Q graph 
applies to any displayed traces.  

 
Figure 4.13.10-2  Power Graph 

■Marker graph 
On the Marker graph, Markers 1, 2, 3, and RF Gate of the samples of the 
trace selected by Legend are displayed. Marker graphs are traced in a 
staircase pattern, where a line is drawn from a plotted point to the right. 
At Sample 115200 in Figure 4.13.10-3, for example, Marker 1 is 0 (LO), 
Markers 2 and 3 are 1 (HI), and RF Gate is 1 (RF On). Note that the 
sample-unit time scale above the I graph applies only to the trace 
selected by Legend, while the ms-unit time scale below the Q graph 
applies to any displayed traces.  

 

Figure 4.13.10-3  Marker Graph 
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4.13.11 Interaction with signal generation application (Quick Add 
Mode) 

The method for updating the time domain graph display in conjunction 
with waveform pattern generation by a signal generation application can 
be set and changed. This function is enabled only when the time domain 
graph display function is activated. Click the Quick Add Mode button to 
display the Quick Add Mode dialog box.  

 
Figure 4.13.11-1  Quick Add Mode Dialog Box 

 

■When Add is selected: 
A trace is added to the time domain graph when Time Domain is selected 
from the Simulation menu or the Time Domain tool button is clicked 
after data generation by the signal generation application. Note that the 
FFT graph display will not be updated when the four traces are all used.  

■When Clear is selected: 
A trace is deleted from the time domain graph and the time domain 
graph of the generated data is displayed when Time Domain is selected 
from the Simulation menu or the Time Domain tool button is clicked 
after data generation by the signal generation application.  

■When Off is selected: 
The time domain graph display will not be updated even when Time 
Domain is selected from the Simulation menu or the Time Domain tool 
button is clicked after data generation by the signal generation 
application.  
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4.13.12 Marker edit function 
A new waveform pattern can be created by reading an existing waveform 
pattern and editing the marker data and name with the marker edit 
function.  
The marker edit function cannot be used if ASCII1, ASCII2, ASCII3, or 
MS269x/MS2830A/MS2840A Digitizer was selected as the file format for 
waveform pattern display.  

Note:  
When the waveform pattern bit width is 16 bits, the marker edit 
function is not available.  

 

Figure 4.13.12-1  Marker Edit Dialog Box 
 

■Description of items 
(1) Information 

 Information about the read waveform pattern is displayed. 

(2) Browse button for waveform pattern selection 

 Clicking this button displays the dialog box for selecting a waveform 
pattern to be read.  

(3) Marker name setting 

 The name of each marker can be specified. 
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(4) Marker data setting 

 Select or clear the Data Edit check box to specify whether to edit the 
data of the corresponding marker. When it is cleared, marker data 
edit is disabled and the marker data of the read waveform pattern is 
used as is. When it is selected, marker data edit is enabled, and the 
marker data with the values set in the Start Point, Width, and 
Period text boxes are added to the new waveform pattern to be 
created.  
Set the number of samples prior to the first marker signal output 
starting point to Start Point, the number of samples to output 
marker signals to Width, and the number of samples between the 
marker signal output starting points to Period.  

 
 

Start Point Width 

Waveform pattern 

Marker (RF Gate) 

Width Width 

Period Period Period 

 

Figure 4.13.12-2  Setting Parameters of Marker and RF Gate Data 
 

(5) RF Gate setting 

 Select or clear the Data Edit check box to specify whether to edit the 
data of the corresponding marker. When it is cleared, RF Gate data 
edit is disabled and the RF Gate data of the read waveform pattern 
is used as is. When it is selected, RF Gate data edit is enabled, and 
the RF Gate data with the values set in the Start Point, Width, and 
Period text boxes are added to the new waveform pattern to be 
created.  
Set the number of samples prior to the first marker signal output 
starting point to Start Point, the number of samples to output 
marker signals to Width, and the number of samples between the 
marker signal output starting points to Period.  
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(6) Create button (for waveform pattern generation) 

 This button is used to create a new waveform pattern according to 
the parameters set in the Marker Edit dialog box. Click the Create 
button to display the Export File dialog box, and then specify the 
output folder, output waveform pattern name, and package name in 
this dialog box.  

(7) Close button (for closing Marker Edit dialog box) 

 Click this button to close the Marker Edit dialog box.  

 
Refer to Section 4.5.6 “Input file format” for details on marker data and 
RF Gate data.  
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4.13.13 Displaying the Time Domain screen from the Convert screen 
By displaying the Time Domain screen from the Convert screen, the 
pre-conversion waveform pattern can be checked and the range for RMS 
calculation during conversion can be specified.  
However, when the Time Domain screen is displayed from the Convert 
screen, traces cannot be added or deleted.  

On the Time Domain screen, to specify the RMS-calculation range used 
for waveform conversion on the Convert screen, use the black-line and 
yellow-line cursors.  

 

Calculate the RMS using this 
range.  

Figure 4.13.13-1  RMS Value Calculation Range 
 

After specifying the RMS-calculation range by using the black-line and 
yellow-line cursors, click the Set RMS Range button to specify the 
RMS-calculation range used when converting the waveform pattern on 
the Convert screen and close the Time Domain screen.  

 

Figure 4.13.13-2  Set RMS Range Button 
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4.14 Clipping Function 
This function performs clipping processing for a waveform pattern 
generated by each signal generation application. Filter, bandwidth, and 
number of repetition times must be set to generate a clipping-processed 
waveform pattern. The generated waveform pattern consists of a 
waveform information file (text format file with the extension “.wvi”) that 
stores the information related to the waveform pattern and a waveform 
data file (binary format file with the extension “.wvd”).  

4.14.1 Activation 
Select the Clipping Panel from the General Purpose tab on the common 
platform screen. The parameters related to clipping processing can be set 
in the Clipping setting screen.  

4.14.2 Clipping setting screen 
Sets each parameter of the clipping operation.  

 

Figure 4.14.2-1  Clipping Dialog Box 
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■Menu bar 
The following menus are provided on the menu bar. 

• The File menu contains the following item. 
•Exit 

Exits from this software.  

• The Transfer & Setting menu contains the following item. 
•Transfer Setting Wizard 

Displays the Transfer Setting Wizard screen. Connection between a 
PC and the mainframe, transfer of waveform patterns to the 
mainframe, and loading of waveform patterns to an arbitrary 
waveform memory of the mainframe can be performed on this 
screen.  

• The Simulation menu contains the following items.  
•CCDF 

Displays the CCDF Graph Monitor screen. The CCDF of a 
generated waveform pattern is displayed in a graph.  
 
•FFT 

Displays the FFT Graph Monitor screen. The spectrum where FFT 
processing is performed for a generated waveform pattern is 
displayed in a graph.  
 
•Time Domain 

Displays the time domain graph display screen. The time domain 
waveform of a generated waveform pattern can be displayed in a 
graph.  

• The Edit menu contains the following item. 
•Calculation 

Performs waveform pattern generation.  

•Calculation & Load (Effective only when this software is 
hosted by the MG3710A/MG3710E/MG3740A) 
Creates the waveform to load it into the memory  
 
•Calculation & Play (Effective only when this software is hosted 
by the MG3710A/MG3710E/MG3740A) 
Creates the waveform, load it into the memory and select it.  
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■Tool bar 
The following tool buttons are provided on the tool bar. The function of 
each button is the same as the corresponding item in the menus.  

 Calculation 

 Calculation & Load 

 Calculation & Play 

 Transfer & Setting Wizard 

 CCDF 

 FFT 

 Time Domain 

 Exit 
 
■Description of items 

(1) Browse button 

 Select the wvi file of the target waveform pattern.  

(2) Filter Type 

 Set the filter type. Selects the filter type from the Filter Type 
drop-down combo box.  
Selectable items: Ideal, None, Nyquist, Root Nyquist, Gaussian 
Default value: Ideal 
Ideal is a low pass filter which ripple is less than 0.01 dB in the 
range from Bandwidth475.0 ×−  to Bandwidth475.0 ×  when 
the Sampling Rate/Bandwidth is not larger than 50.  

(3) Roll Off/BT 

 Set the roll off ratio. This is enabled when Filter Type is set to 
Nyquist, Root Nyquist, or Gaussian.  
Setting range: 0.10 to 1.00 
Setting resolution: 0.01 
Default value: 0.50 

(4) Bandwidth 

 Set the bandwidth.  
Setting range: From the smaller value among Sampling Rate / 
1000 and 0.00100000 to Sampling Rate 
Setting resolution: 0.00000001 
Default value: The Bandwidth of the waveform pattern specified 
in the Input File 
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(5) Threshold Level 

 Set the threshold level for clipping.  
Setting range: 0.0 to 20.0 
Setting resolution: 0.1 
Default value: 10.0 

(6) Repetition 

 Set the number of times to repeat clipping and filtering. 
Setting range: 1 to 20 
Setting resolution: 1 
Default value: 10 
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4.14.3 Setting method 
<Procedure> 
1. Click the  button to select the wvi file of the waveform 

pattern to be used. The full path of the selected wvi file is displayed 
in the Input File text box.  

2. Set values in the Filter Type, Roll Off/BT, Bandwidth, Threshold 
Level, and Repetition text boxes.  

3. Select Calculation from the Edit menu or click the  button to 
complete setting.  
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4.14.4 Generating waveform pattern 
When the parameter setting has been completed in the Clipping setting 
screen, select Calculation from the Edit menu or click the  button to 
display the Export File screen shown in Figure 4.14.4-1. In this screen, 
set the waveform pattern export destination, package name, and file 
name, and then enter a comment (if necessary) to generate a 
clipping-processed waveform pattern. The Comment text box can be left 
blank for waveform pattern generation.  

 

Figure 4.14.4-1  Export File Dialog Box 
 

■Description of items 
(1) Browse button 

 Click this button to select the waveform pattern file output 
destination.  
The waveform pattern file output destination folder is indicated 
in the Export Path text box.  

(2) Package Name 

 Enter the name of the package of the clipping-processed 
waveform pattern to be generated. Up to 31 characters can be 
used for a package name. Alphanumeric characters and the 
following symbols may be used: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
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(3) Export File Name 

 Enter the name of the clipping-processed waveform pattern file 
to be generated (common to wvi and wvd files). Up to 20 
characters can be used for a package name. The usable 
characters are the same as those for the package name.  

(4) Comment 

The comment entered here is displayed in the Comment area on 
the MG3700A/MG3710A/MG3710E/MG3740A screen when the 
clipping-processed waveform pattern to be generated is output 
from the MG3700A/MG3710A/MG3710E/MG3740A. Up to 38 
characters can be used for a package name.  
When the Export File screen is displayed for the first time, the 
settings of Filter Type and Threshold Level are initially 
displayed in the upper and middle lines, respectively. Edit them, 
if necessary. 

(5) OK 

Click this button to start waveform pattern generation.  

(6) Cancel 

Click this button to close the Export File screen and return to the 
setting screen.  

<Procedure> 
1. Set the clipping-processed waveform pattern output destination. 

Click  to select the output destination.  

2. The output destination of the clipping-processed waveform pattern 
file is displayed in the Export Path text box.  

3. Set the name of the package of the clipping-processed waveform 
pattern in the Package text box.  

4. Set the waveform pattern file name in the Export File Name text 
box.  

5. In the Comment text boxes, enter information on the 
clipping-processed waveform pattern to be displayed (if necessary).  

6. Click the OK button to start waveform pattern generation. Click the 
Cancel button to return to the setting screen.  

7. When waveform pattern generation starts, the waveform generation 
execution screen shown in Figure 4.14.4-2 appears. When the Cancel 
button at the bottom of the screen is clicked, waveform generation 
stops and the setting screen is displayed again. When waveform 
generation completes (when “Calculation Completed” is displayed), 
click the OK button to close the waveform generation screen and 
return to the setting screen.  
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Figure 4.14.4-2  Waveform Generation Executing Dialog Box 
 

8. The clipping-processed waveform pattern file is generated in the 
destination specified in the Export Path text box, with the file name 
(common to wvi and wvd files) specified in the Export File Name 
text box.  
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4.14.5 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E/MG3740A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation. 

 

Figure 4.14.5-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 4.14.5-2  Select Memory Screen 
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After selecting the load destination of generated waveform in the Select 
Memory screen and pressing OK, the Load Setting screen will be shown 
again. Press OK in the Load Setting screen, and then the loading of 
waveform starts.  

Note: 
To exit this screen without loading the waveform pattern, click 
Cancel in the Load Setting screen.  

4.14.6 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A/MG3710E/MG3740A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output. 

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 4.14.6-1  Select SG Screen 
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4.14.7 Clipping-processed waveform pattern simulation examples 
This section provides a simulation example of the spectrum and CCDF 
graphs of the clipping-processed waveform pattern in Figures 4.14.7-1 
and 4.14.7-2, respectively. The red line on Figure 4.14.7-2 indicates the 
CCDF graph before clipping.  
Filter Type = Ideal 
Bandwidth = 10.00000000 [MHz] 
Threshold Level = 8.0 
Repetition = 20 

 

Figure 4.14.7-1  Clipping Processed Spectrum 
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Figure 4.14.7-2  Clipping Processed CCDF Graph 
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4.14.8 Details of clipping processing 
During clipping processing, clipping and filtering are performed 
repeatedly, as shown in Figure 4.14.8-1. The clipping processing clips the 
peaks that exceed Threshold Level, referencing on RMSIQ as the basis (0 
dB). Figure 4.14.8-2 shows a schematic diagram of the clipping 
processing at this time.  
RMSIQ that is used as the basis of the clipping processing is calculated 
from the following expression. When clipping and filtering are performed, 
RMSIQ is calculated again, and the next clipping processing is performed 
based on the recalculated RMSIQ. 

( )∑ +=
n

nn QI
N

22
IQ

1RMS  

wherein, Σ is the sum of the target waveform patterns (excluding 
samples for which RF output is set to Off by the RF Gate setting) 

 

Clipping Filter 

Repeat this procedure according to the set Repetition number 

 

Figure 4.14.8-1  Clipping Process 
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Figure 4.14.8-2  Schematic Diagram of Clipping Process 
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When filtering is performed after clipping, the peak becomes larger than 
that when only clipping is performed (see Figure 4.14.8-3), and the crest 
factor of the generated waveform pattern may exceed the level set by 
Threshold Level.  Figure 4.14.8-3 shows a simulation example of the 
CCDF graph where a waveform pattern is generated with Repetition = 1 
and the other parameters are set the same as in Section 4.14.7 
“Clipping-processed waveform pattern simulation examples.”  
For the sake of comparison, Figure 4.14.8-4 shows a CCDF simulation 
example where Repetition is changed to 1, 2, and 20. In this example, it 
can be seen that the crest factor comes closer to the level set by 
Threshold Level as the number of repetition times of clipping and 
filtering increases.  

 

Figure 4.14.8-3  Clipping Method Result Comparison (when Repetition = 1) 
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Figure 4.14.8-4  CCDF Graph When Changing Repetition 
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This chapter describes in particular the operating procedures for 
important functions that pertain to the functions that can be operated by 
the IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A. 
 

5.1 Installing License File ................................................ 5-2 
5.2 Transferring Waveform Pattern ................................. 5-4 
5.3 Transferring File from  

MG3700A/MG3710A/MG3710E/MG3740A to PC ..... 5-6 
5.4 Generating Waveform Pattern ................................... 5-9 
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5.1 Installing License File 
It is necessary to purchase the license of the signal generation 
applications according to the serial number of the 
MG3700A/MG3710A/MG3710E/MG3740A, and install the applications 
into the MG3700A/MG3710A/MG3710E/MG3740A to be used in advance 
so that the MG3700A/MG3710A/MG3710E/MG3740A can actually use 
the waveform patterns generated by the signal generation applications 
supported by the IQproducerTM for 
MG3700A/MG3710A/MG3710E/MG3740A. 

The following show the license file installation method: 

<Procedure> 
1. Start IQproducerTM, select the Simulation & Utility tab and click 

Transfer & Setting Panel.  

 When the MG3700A/MG3710A/MG3710E/MG3740A and the PC are 
connected to the network, select Connect from the Connection 
menu or click the  icon on the tool bar to open the Connection 
dialog box and connect the 
MG3700A/MG3710A/MG3710E/MG3740A and PC. 

2. Click  on the right of the transfer file type box to open the 
pull-down menu to select a file type. Select Waveform Package 
License File for license file transfer in this event. Then a list of the 
license files currently installed is displayed in the SG-side file 
display area. 

3. Select a license file to be transferred to the 
MG3700A/MG3710A/MG3710E/MG3740A from the PC-side file 
display area. 
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Figure 5.1-1  Selecting license file 
 

4. Select Key Install from the Transfer menu or click the  icon on 
the tool bar to start license file installation. 
The installed license files are displayed in the SG-side file display 
area after installation is completed. 
 

Up to 100 license files can be installed into the 
MG3700A/MG3710A/MG3710E/MG3740A. 
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5.2 Transferring Waveform Pattern 
This section describes the procedure for transferring the waveform 
patterns generated by a signal generation application to the 
MG3700A/MG3710A/MG3710E/MG3740A on the Transfer & Setting 
Panel screen. 

<Procedure> 
1. Start IQproducerTM, select the Simulation & Utility tab and click 

Transfer & Setting Panel. Select Connect from the Connection 
menu or click the  icon on the tool bar to open the Connection 
dialog box and connect the 
MG3700A/MG3710A/MG3710E/MG3740A and PC. 

2. Click  on the right of the transfer file type box to open the 
pull-down menu to select a file type. Select Waveform Pattern File 
for waveform pattern transfer in this event. 

 

Figure 5.2-1  Selecting waveform pattern file 
 

3. Select a waveform pattern file to be transferred to the 
MG3700A/MG3710A/MG3710E/MG3740A from the PC-side file 
display area. Two or more files can be selected by Ctrl  + click 
(additional selection) and Shift  + click (range selection). 

4. Specify the MG3700A/MG3710A/MG3710E/MG3740A to which the 
waveform pattern file is transferred (transfer destination) from the 
SG-side file display area. 
When the MG3700A/MG3710A/MG3710E/MG3740A is specified, the 
capacity of its internal hard disk is displayed in the status bar on 
the bottom of the Transfer & Setting Panel screen. 
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5. Select PC to SG from the Transfer menu or click the  icon on 
the tool bar to start waveform pattern file transfer. In this event, 
selecting PC to All SG from the Transfer menu or clicking the  
icon on the tool bar transfers the waveform pattern file to all the 
MG3700A/MG3710A/MG3710E/MG3740A connected to the PC. 
The transferred waveform pattern file is stored in the folder 
(package) with the name specified in the Package box of the Convert 
screen. 
Although a waveform pattern file that does not have a license can be 
transferred to the MG3700A/MG3710A/MG3710E/MG3740A, it is 
not allowed to load that file to the memory for use. 
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5.3 Transferring File from 
MG3700A/MG3710A/MG3710E/MG3740A to PC 

This section describes the procedure for transferring screen copy images, 
log files, etc., created by the MG3700A/MG3710A/MG3710E/MG3740A to 
the PC on the Transfer & Setting Panel screen. 

<Procedure> 
1. Start IQproducerTM, select the Simulation & Utility tab and click 

Transfer & Setting Panel. Select Connect from the Connection 
menu or click the  icon on the tool bar to open the Connection 
dialog box and connect the 
MG3700A/MG3710A/MG3710E/MG3740A and PC. 

2. Click  on the right of the transfer file type box to open the 
pull-down menu to select a file type. Select All File in this event. 

3. Double-click the icon of the 
MG3700A/MG3710A/MG3710E/MG3740A specified as the transfer 
destination in the SG-side file display area. The following folders are 
displayed. 
If using MG3700A: 
• ALARMLOG Stores alarm display log files 
• APM Stores parameter saving files 
• BERTLOG Stores BER measured result log files 
• CHANNEL Stores channel table files 
• PACKAGE Stores packages and waveform pattern files 
• SCREEN_IMAGE Stores bitmap image files of screen copy 
• WAVE_LICENSE Stores waveform pattern license files 

 

Figure 5.3-1  Selecting a file in SG-side file display area 
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If using MG3710A/MG3710E/MG3740A: 
• Alarm History ................ Alarm indication log file 

• BERT BitPattern ........... User defined pattern of BERT 

• BERT Log ....................... BERT log file 

• ChannelTable ................. Channel table file 

• Copy Files ....................... Image file of screen copy 

• Corrections ..................... Correction file 

• ListTable ........................ List Table file 

• Parameter Setting ......... Saved parameter file 

• Waveform Waveform pattern 

 

4. Double-click the folder that contains the file to be copied in the 
SG-side file display area to display the contents, and select the 
target file. Two or more files can be selected by Ctrl  + click 
(additional selection) and Shift  + click (range selection). 
To return to the previous folder (upper directory), click the  icon 
on the top of the SG-side file display area. 

5. Specify the folder to which the selected file is transferred (transfer 
destination) from the PC-side file display area. 

6. Select SG to PC from the Transfer menu or click the  icon on 
the tool bar to start file transfer. The selected file is transferred to 
the folder opened in the PC-side file display area. 
In this event, the following overwrite confirmation dialog box is 
displayed if a file having the same name with that of the file to be 
transferred already exists in the transfer destination folder: 

 

Figure 5.3-2  Overwrite confirmation dialog box 
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The meaning of each selection item in this dialog box is as follows: 

• All: All the selected files are transferred overwriting the 
existing files having the same name. 

• OK: The selected file is transferred overwriting the existing 
file having the same name. The overwrite confirmation 
dialog box is displayed each time when a file having the 
same name with that of the file to be transferred is found. 

• Cancel: The selected file is not transferred, and the subsequent 
file transfer is cancelled. 
 

The IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A does not 
support folder transfer. The data transfer is executed in file units. 
Transfer date/time is used for the time stamp of the file transferred from 
the MG3700A/MG3710A/MG3710E/MG3740A to the PC. 
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5.4 Generating Waveform Pattern 
This section describes a series of operations for converting an 
ASCII-format waveform pattern generated by external simulation 
software to a waveform pattern that can be used by the 
MG3700A/MG3710A/MG3710E/MG3740A using the Convert function of 
the IQproducerTM for MG3700A/MG3710A/MG3710E/MG3740A. 

Refer to Section 4.5 “File Conversion on Convert Screen” for details of 
setting parameters. 

<Procedure> 
1. Click the Reference button and read the file to be converted. 

2. The parameters related to the waveform pattern are enabled to be 
input after reading the waveform pattern file. Input these 
parameters as required according to the type and applications of the 
waveform pattern. 

3. Set the sampling rate. 
The sampling rate indicates the speed of reading the waveform 
pattern from an arbitrary waveform memory in the 
MG3700A/MG3710A/MG3710E/MG3740A. Note that it is not the 
speed after processing the interpolator within the 
MG3700A/MG3710A/MG3710E/MG3740A. 
When reading a W-CDMA waveform pattern having the over 
sampling of ×4, for example, set the sampling rate as follows: 
3.84 Mcps × 4 = 15.36 MHz 

4. Select the cut off frequency for the low-pass filter. 

This is available only for MG3700A.   

The low-pass filter, which is inserted in the analog baseband route, 
is used to remove an image component generated in the D/A 
converter output. When AUTO is set, the cut off frequency is 
automatically changed depending on the Sampling Rate setting as 
shown in Table 5.4-1 below. 
In Table 5.4-1, Interpolation indicates the scaling factor of the 
interpolator of the arbitrary waveform generator. Since the image 
components of the waveform pattern are raised to N-times frequency 
based on the interpolation factor (N), the sufficient attenuation of 
the image components can be assured by the low-pass filter. Also, 
employing the interpolator improves the frequency characteristics 
within the modulation band due to the 0 order hold of the D/A 
converter output. 
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Table 5.4-1  Low-pass filter settings 

Sampling Rate (MHz) 

Low pass Filter (MHz) 
(when Auto is set) 

Interpolation 
Pattern 

Add 
Pattern 
single 

150 <, ≤ 160 100 100 2 
100 <, ≤ 150 70 70 2 
50 <, ≤ 100 70 70 4 
20 <, ≤ 50 70 70 8 

12.5 <, ≤ 20 
10 70 

16 
10 <, ≤ 12.5 32 
6.25 <, ≤ 10 

10 70 
32 

5 <, ≤ 6.25 64 
3.125 <, ≤ 5 

3 70 
64 

2.5 <, ≤ 3.125 128 
1.5625 <, ≤ 2.5 

1 70 
128 

1.25 <, ≤ 1.5625 256 
0.78125 <, ≤ 1.25 

0.3 70 
256 

0.625 <, ≤ 0.78125 512 
0.390625 <, ≤ 0.625 

0.3 70 
512 

0.3125 <, ≤ 0.390625 1024 
0.1953125 <, ≤ 0.3125 

0.1 70 
1024 

0.15625 <, ≤ 0.1953125 2048 
0.09765625 <, ≤ 0.15625 

0.1 70 
2048 

0.078125 <, ≤ 0.09765625 4096 
0.04882813 <, ≤ 0.078125 

0.1 70 
4096 

0.0390625 <, ≤ 0.04882813 8192 
0.02441406 <, ≤ 0.0390625 

0.1 70 
8192 

0.02 ≤, ≤ 0.02441406 16384 
 
5. Set the RMS value after waveform pattern is converted. 

When started with MG3700 mode, or when started with MG3710/ 
MG3740 mode and 14 bit width is selected:  

Set a value from 651 to 1634 for the RMS value. Note, however, that 
the dynamic range of the output signal is deteriorated due to a 
quantization noise from the D/A converter or an analog noise added 
after D/A converter output when a smaller RMS value is set.  
When the peak amplitude of the converted waveform pattern 
becomes 8191 or higher, the peak of the waveform amplitude is held 
at 8191. The following condition should be met so as to output all the 
waveform information without cutting the peak signal: 
8191 / RMS value > “Input waveform peak value / Input waveform 
RMS value” 
When using a waveform pattern that has a lager “peak value / RMS 
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value”, it is necessary to set a lower RMS value because a distortion 
is subject to occur in the base band and RF circuit in the 
MG3700A/MG3710A/MG3710E/MG3740A in this case. But if the 
RMS value is set too low, the floor noise characteristics are 
deteriorated as described below, though the distortion trouble is 
improved. 
The accuracy of the RF output level of the 
MG3700A/MG3710A/MG3710E/MG3740A is assured under the 
following condition. Set the RMS value within the following range 
when taking the RF output level accuracy into consideration. 
1157 ≤ RMS value ≤ 1634 

6. Set Memory Option. 

 When started with MG3700A: 

 Set Memory Option according to whether the ARB memory 
expansion option 512M samples is installed in the used MG3700A. 
The maximum number of waveform patterns that can be generated 
is determined depending on this setting. 
When With Option21 is set: Up to 512 Msamples 
When Without Option21 is set: Up to 256 Msamples 
When started with MG3710A/MG3710E: 
The menu will display as follows: 
Memory 64M samples 
Memory 64M samples × 2 (With Option48, 78) 
Memory 256M samples 
Memory 256M samples × 2 (With Option48, 78) 
Memory 1024M samples 
Memory 1024M samples × 2 (With Option48, 78) 
When started with MG3740A: 
The menu will display as follows: 
Memory 64M samples 
Memory 64M samples × 2 (With Option48, 78) 
Memory 256M samples 
Memory 256M samples × 2 (With Option48, 78) 

7. Set Unit Symbol. 
Set the set unit for Trigger Delay and other parameters of the 
MG3700A/MG3710A/MG3710E/MG3740A. The set unit display for 
Trigger Delay is changed depending on this setting. 
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8. Set Over Sampling. 
Set the over sampling rate for the waveform pattern to be input. The 
over sampling rate should be set to the value shown in Table 5.4-2 or 
higher, according to the symbol rate (or chip rate) of the waveform to 
be generated. When a value lower than that shown in the table 
below is used, the image signal element may become –60 dB or more. 
The symbol rate is the output rate for the data that has been 
mapped in the physical channel of each communication system 
before the Route Nyquist processing is performed. The sampling rate 
is calculated by multiplying the symbol rate by the over sampling 
rate. 

9. Set Bandwidth (For MG3710A/MG3710E/MG3740A) 
Set the bandwidth of waveform data.  

Table 5.4-2  Over sampling rate setting 

Symbol rate 
(symbol/sec) 

Over 
sampling rate 

Sampling rate 
(sample/sec) LPF 

10 k≤, ≤9.09 M 2.2 20 k≤, ≤20 M AUTO 
9.09 M<, ≤40 M 4 36.36 M<, ≤160 M AUTO 

 
10. Set Spectrum. 

The spectrum relationship between the IQ signal and RF signal may 
be reversed according to the modulator configuration of each 
communication system. Set Reverse for IS-95 and cdma2000. 

11. Enter a comment. 
Enter a comment into the Comment Lines 1/2/3 if necessary. The 
character string entered here is displayed on the screen when the 
corresponding waveform is selected. 

12. Specify Detail File. (Available only for MG3700A) 

Specify a detail file (text-format file) to be read if necessary. The 
selected detail file is stored into the MG3700A along with the 
waveform pattern, and its contents are displayed in Detail 
Information of the MG3700A screen when the corresponding 
waveform pattern is selected. 
The contents of a detail file must be described within 56 characters × 
6 lines. 

13. Set Marker Name. 
Set a name for Makers 1, 2, and/or 3 to be used if necessary. The 
marker output is displayed in the 
MG3700A/MG3710A/MG3710E/MG3740A screen with the name 
specified here when the corresponding waveform pattern is selected. 
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14. Set Burst Setting. 

The Burst Setting includes two settings: Frame Length and Gap 
Length. The input waveform pattern is divided into frames of the 
number of data set by Frame Length, and a gap (burst off period in 
which the burst wave is not output) of the number of data set by Gap 
Length is inserted between frames (see Figure 5.4-1). 

It is not necessary any longer to output the burst off period as a 
waveform pattern when using this setting. For example, when 
outputting only the first slot in the system where one frame consists 
of five slots, the memory length required for the waveform pattern is 
reduced to 1/5 of that when the Gap Frame setting is not used. 
When an external trigger signal is used, the Frame Length setting is 
also used to synchronize the external trigger and the signal output 
timing in the Vector Signal Generator option. For details on external 
trigger, refer to 3.5.4 “Outputting signal in sync with external 
trigger signal” in MG3700A Vector Signal Generator Operation 
Manual (Mainframe), or 7.4.1 “Route Input Connectors” in 
MG3710A/MG3710E/MG3740A Operation Manual (Mainframe). Set 
Gap Length to 0 for continuous waves. 

 

Figure 5.4-1  Frame Length and Gap Length Settings 
 

15. Click the Convert button to start data conversion. 
The converted data output destination and file name are set, and 
waveform pattern generation is started. 
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A list of error messages is shown below. 

Error Message Description 

Platform 
Application is not found from APPINFO 
Manager. 

The application was not found from the application 
information. 

Application is not found. (“Activated 
application name”) — 

Application starting timeout. (“Activated 
application name”) — 

Application termination timeout. 
(“Application name”) Shutdown application? — 

IQproducer is already running. — 
(“Application name”) is already running. — 
Request shutdown was not completed.  
(“Application name”) — 

Transfer & Setting 
The platform has been unusually ended. — 
The filename, directory name, or volume label 
syntax is incorrect. — 

Cannot create a file when that file already 
exists. — 

The MG3700A firmware version is 1.xx. Your 
version of IQproducer cannot connect with the 
version 1.xx of MG3700A normally. Please 
check Anritsu Download Support Site to 
upgrade MG3700A firmware. 

The MG3700A firmware version is 1.xx, and your 
version of the IQproducer cannot properly connect 
to the MG3700A. Update the MG3700A firmware to 
enable the connection (download the latest 
firmware from the download page linked from the 
MG3700A page on the Anritsu Web site). 

FTP connection error. — 

FTP connection lost. 

The FTP communication has been shut down.  
This error message is also displayed when 
waveform files cannot be transferred from PC to SG 
because of insufficient disk space of the HDD on the 
SG. 

FTP connection timeout. — 
FTP connection error. — 
FTP USER command error. — 
FTP User ID or FTP password is not 
corresponding between IQproducer and 
MG3700A. 

— 

FTP CWD command error. — 
FTP DELE command error. — 
FTP LIST command error. — 
FTP TYPE command error. — 
FTP RETR command error. — 
FTP STOR command error. — 
Can not open file. — 
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Error Message Description 

Can not write file. — 
Can not read file. — 
Can’t get a file list. — 
File not found. — 
Remote connect error. — 
Remote connection lost. — 
Remote connection timeout. — 
Remote connection error. — 
Remote *ESR? query error. — 
Remote ESR2? query error. — 
Remote ESR3? query error. — 
Remote *IDN? query error. — 
Remote HEAD? query error. — 
Remote ERRMSG? query error. — 
Remote WMSPC? query error. — 
Remote HDDSPC? query error. — 
Remote WVINSTMEDIA? query error. — 
Remote PATADD? query error. — 
Remote WVKEYNUM? query error. — 
Remote WVKEYNAME? query error. — 
Remote WVKEYVER? query error. — 
Remote PATNUM? query error. — 
Remote PATNAME? query error. — 
Remote LDPAT? query error. — 
Remote PAT? query error. — 
Remote WMOPT? query error. — 
Remote SCNNUM? query error. — 
Remote timeout. — 

These Waveform Files cannot be transferred 
because Waveform files in HDD exceed 100. 

Waveform files cannot be transferred because there 
are more than 100 wvi/wvc files per package (folder) 
in the HDD on MG3700A. 

These Waveform Files cannot be transferred 
because Waveform files in HDD exceed 4096. 

Waveform files cannot be transferred because there 
are more than 4096 wvi/wvc files per package (folder) 
in the HDD on MG3710A/MG3710E/MG3740A. 

Cannot load this file because of the shortage 
of memory space. Please delete some loaded 
files from memory to load this file. 

— 

It is the Combination file which cannot be 
used. “File name” — 

The total size of Element A/Element B/Add 
Pattern is over “Size.” — 

Data width of the Waveform pattern which 
can be set as Add pattern is (“File name”). 

The data width of the element file to be added is not 
16 bits. 



 

Appendix A  Error Messages 

A-3 

 
Error Message Description 

Pattern “Pattern name” is used for the 
element more than 99 times. — 

The license is necessary. — 
The total size of the pattern used has 
exceeded the capacity of memory. — 

The Setting value is out of range. (“Parameter 
name = Current value Min to Max)”) — 

The file that tries to be copied is an illegal 
format. (“File name”) — 

Invalid file format. (“File name”) — 
Can not read file.(“File name”) — 
Can not write file.(“File name”) — 
Invalid Waveform information file format. 
(“File name”) — 

This file cannot be registered because of 
discrepancy with the parameter of the 
registered file. (“File name”) 

— 

The Setting value invalid. (“File name”) — 
Fail to copy file. (“File name”) — 
Combination file cannot be made because the 
setting of the element is not correct. — 

CCDF 
Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
A “IQProducer” is down.   
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

There is a request from the other IQproducer 
application for drawing a trace. 
Delete the displayed trace and draw a new 
trace? 

— 
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Error Message Description 

You have filled up all the trace available. 
Delete some traces, or set Quick Add Mode to 
clear before adding a trace. 

— 

There is no trace to output. CSV output is impossible since no graph is 
displayed. 
FFT 

Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
A “IQProducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

The length of “FFT Points” is longer than that 
of the waveform data. 
Trace data couldn't be read. 
(“File name”) 

— 

The length of “FFT Points” is longer than that 
of the waveform data. 
“FFT Points” was set as suitable value. 
(“File name”) 

— 

Invalid parameter value. — 
There is a request from the other IQproducer 
application for drawing a trace. 
Delete the displayed trace and draw a new 
trace? 

— 

You have filled up all the trace available. 
Delete some traces, or set “Quick Add Mode” 
to “clear” before adding a trace.” 

— 

There is no trace to output. CSV output is impossible since no graph is 
displayed. 

If the “FFT Points” is changed, all the trace 
displayed will be recalculated. 
Are you sure to change the “FFT Points”? 

— 
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Error Message Description 

Sampling Rate is different. 
Do you clear the graph already displayed and 
display new graph? 

— 

If the “Sampling Range” is changed, all the 
trace displayed will be recalculated. Are you 
sure to change the “Sampling Range”? 

— 

Convert 
Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
A “IQProducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

Can not create the output file. (“File name”) — 
File not found. (“File name”) — 
The detail area is maximum of 6 lines, 56 
characters per line. (“File name”) — 

Fail to copy the detail file. (“File name”) — 
The read data is shorter than Data Points. 
(“File name”) 

Data conversion is impossible since the input file is 
smaller than the number of data points (Data 
Points). 

The Data Points is too large. The Maximum 
Data Points is either 268435456 samples 
(without Option 11/31) or 536870912 samples 
(with Option 11/31). 

— 

When the Burst Setting checkbox is checked, 
The value of Frame Length must be equal or 
less than the value of Data Points. 

— 

The waveform pattern to be generated will be 
above 8191 and be clipped. — 

RMS value of waveform data is not in range 
1.0 to 8191.0.  RMS value will be changed. — 

The dgz file size are too large. The Maximum 
Data Points are 536870912 samples. — 
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Error Message Description 

AWGN 
Out of range :  “Parameter name” (“Setting 
range”) — 

Can not open file. — 
Can not write file. (“File name”) — 

W-CDMA Downlink/Uplink 
Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
Can not open the parameter file. (“File name”) — 
The Setting value is invalid “Parameter name” — 
The Setting value is out of range 
“(Parameter name (Min – Max.))” — 

Total channel power except OCNS is over 0 
dB. — 

An initial parameter file was not able to be 
read. — 

All Channels are OFF. — 
Input File Name. — 
Value is set up at 800 steps. — 
DTCH information data is changed to the data 
truncated every one frame (PN9fix). — 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power 
when OCNS is OFF. 

— 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power 
when Simulation is UpLink. 

— 
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Error Message Description 

Time Domain 
Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
A “IQProducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

Invalid parameter value. — 
There is a request from the other IQproducer 
application for drawing a trace. 
Delete the displayed trace and draw a new 
trace? 

— 

You have filled up all the trace available. 
Delete some traces, or set “Quick Add Mode” to 
“clear” before adding a trace.” 

— 

If the “Graph Type” is changed, all the trace 
displayed will be recalculated. Are you sure to 
change the “Graph Type”? 

— 

Marker edit function cannot be used because 
the selected file does not include marker 
signal. 

If a 16-bit file is selected:  
The marker editing function cannot be used because 
the file does not include a marker signal.  
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Error Message Description 

Clipping 
Can not open file. — 
Can not write file. — 
Can not read file. — 
Input File is not selected. — 
The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

The Waveform data file is not generated. — 
Wrong pattern license. — 
This pattern cannot use.  Because, “Internal 
FIR” is used. — 

The number of samples is over 512M samples. — 
Input Package Name. — 
Input Export File Name. — 
The data of ware-form file is unusual. — 
Exception error. — 
Waveform is not correct. — 
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